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1 Présentation du Makoto® Système d’imagerie 
intravasculaire  

1.1 Indications d’utilisation  
Le système d'imagerie intravasculaire Makoto® est destiné à l'examen dans le proche 
infrarouge des artères coronaires chez les patients subissant une coronarographie 
invasive.  

a) Le système est destiné à la détection de plaques d'intérêt contenant un noyau 
lipidique.  

b) Le système est destiné à l'évaluation de la charge des noyaux lipidiques des 
artères coronaires. 

c) Le système est destiné à l'identification des patients et des plaques présentant 
un risque accru d'événements cardiaques indésirables majeurs. 

Le système est destiné à l'examen par ultrasons de la pathologie intravasculaire 
coronaire.  

a) L'imagerie par ultrasons intravasculaire est indiquée chez les patients candidats 
à des procédures interventionnelles coronariennes transluminales. 

 

1.2 Autres indications d'utilisation – États-Unis uniquement 

Le système d'imagerie intravasculaire Makoto® est destiné à l'examen par ultrasons de 
la pathologie intravasculaire périphérique.  

a) L'imagerie par ultrasons intravasculaire est indiquée chez les patients candidats 
à des procédures interventionnelles périphériques transluminales. L’utilisation du 
système n’est pas indiquée pour les vaisseaux cérébraux. 
 

AVERTISSEMENT 

L’efficacité de la NIRS dans les vaisseaux périphériques 
n'a pas été établie. 

 

1.3 Bénéfice clinique 
Le bénéfice clinique apporté par le système d'imagerie intravasculaire Makoto® réside 
dans l'identification des plaques à noyau lipidique. En identifiant les plaques à noyau 
lipidique, le système d'imagerie intravasculaire Makoto® fournit des informations qui ne 
sont pas aussi facilement disponibles avec d'autres technologies. Les avantages 
potentiels de la prise en charge guidée par spectroscopie à rayonnement infrarouge et 
ultrasons intravasculaires (NIRS-IVUS) sont les suivants : 1) la détermination de la 
longueur de l'artère à l’endoprothèse, 2) le choix de l'intensité de la prise en charge 
médicale, 3) l'identification et l'atténuation du risque d'infarctus embolique autour de 
l’endoprothèse, et 4) l'identification des patients et des plaques présentant un risque 
accru d’événements cardiaques indésirables majeurs.  
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1.4 Formation 
Le système d'imagerie intravasculaire Makoto® doit être utilisé exclusivement par des 
médecins et du personnel de laboratoire de cathétérisme qualifiés. 
Une formation sur site par le personnel d’Infraredx® ou des formateurs certifiés sur 
l’utilisation du Makoto® Système d’imagerie intravasculaire est disponible au moment de 
l’installation et sur demande. Veuillez contacter le service clientèle d’Infraredx® ou votre 
fournisseur de services local pour planifier des formations sur site et des évaluations 
périodiques des compétences de la formation. 

 

1.5 Coordonnées d’Infraredx 
Infraredx® peut être contacté à l'adresse suivante : 
  
 Infraredx®, Inc. 
 28 Crosby Drive, Suite 100 
 Bedford, MA 01730 
 États-Unis 
  
 http://www.infraredx.com 
 Téléphone (international) : +1-800-596-3104 
 
Les consignes d'utilisation sont accessibles sous forme électronique sur le site Web ci-
dessus. 

 

1.6 Brevets  
Le Makoto® Système d’imagerie intravasculaire, les cathéters et les accessoires 
associés sont protégés par un ou plusieurs brevets. Pour obtenir une liste exhaustive 
des brevets publiés, veuillez consulter : 

http://www.infraredx.com/infraredx-intellectual-property/ 

1.7 Marques de commerce déposées 
Infraredx®, Makoto®, Dualpro®, DualproPlus®, Infraredx Clarispro®, HD IVUS®, TVC® et 
Extended Bandwidth® sont des marques de commerce déposées d'Infraredx, Inc. Le 
nom « Infraredx Dualpro » est une marque de commerce déposée en Chine. Le nom 
« Infraredx » est une marque de commerce déposée d'Infraredx, Inc. aux États-Unis, 
dans l'Union européenne, en Australie, en Chine, en Corée du Sud et au Japon. 
 

1.8 Marques de commerce 
SmartImaging™ et DualproNIRS™ sont des marques de commerce d'Infraredx, Inc. 
Tous les autres noms de marque et noms de produits utilisés et référencés dans ce 
document sont des marques de commerce, des marques déposées ou des noms de 
marque de leurs détenteurs respectifs. 

 

http://www.infraredx.com/
http://www.infraredx.com/infraredx-intellectual-property/
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2 Manière d’interpréter ce manuel 
Ce manuel contient des informations importantes pour l’utilisation du Makoto® Système 
d’imagerie intravasculaire. Lisez et passez attentivement en revue le manuel avant 
d’essayer d’utiliser le produit.  
 

2.1 Symboles et icônes 
Des alertes sont présentes partout dans ce manuel. Ces alertes sont appelées 
Avertissements, Mises en garde et Remarques. 

AVERTISSEMENT 

Des situations dangereuses, y compris des blessures au patient 
ou à l'opérateur, peuvent se produire si les avertissements 
affichés sont ignorés. 
 

 

ATTENTION 

Le non-respect des mises en garde écrites peut endommager le 
Makoto® Système d’imagerie intravasculaire ou entraîner une 
dégradation des performances du système. 

 

REMARQUE : Les remarques fournissent des rappels et des conseils utiles 
pour l’utilisation des fonctionnalités avancées. 

 

2.2 Abréviations 
 

CA Courant alternatif 

ANSI American National Standards Institute (Institut national de 
normalisation américain) 

ZS Zone de sténose 

AVI Audio Video Interleave (imbrication audio vidéo) 

CABG Pontage aorto-coronaire 

CUI Console User Interface (interface utilisateur de la console) 

CPU Central Processing Unit (unité centrale de traitement) 

DICOM Digital Imaging and Communications in Medicine standard 
(norme pour la gestion informatique des données issues de 
l’imagerie médicale) 

DVD Digital Video Disc (disque vidéo numérique) 

MEE Membrane élastique externe 
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CEM Compabilité électromagnétique 

IEM Interférence électromagnétique 

OE Oxyde d’éthylène 

EtO Oxyde d’éthylène 

FDA Food and Drug Administration 

FHD Full High Definition display (écran haute définition intégrale), 
1920x1080 pixels 

HD High Definition display (écran haute définition) 

CEI Commission électrotechnique internationale 

IP Internet Protocol (protocole Internet) 

ISO International Organization for Standardization 

IVUS Intravascular Ultrasound (échographie intravasculaire) 

JPEG Joint Photographic Experts Group (Groupe mixte d’experts 
en photographie) 

LCBI Lipid Core Burden Index (indice de masse du cœur lipidique) 

PCL Plaque d’intérêt contenant un cœur lipidique  

LCBImx LCBI max. d’une largeur de fenêtre spécifiée 

PIR Proche infrarouge  

SPIR Spectroscopie par proche infrarouge 

ZP Zone de plaque 

PP Progression de plaque 

PACS Picture Archiving and Communication System (système 
d’archivage et de transmission d’images) 

ACTP Angioplastie coronarienne transluminale percutanée 

ATP Angioplastie transluminale percutanée 

 Radiofréquence 

RFID Identification par radiofréquence 
UL Underwriters Laboratories 

USB Universal Serial Bus (bus universel en série) 

 

2.3 Actions 
Le Makoto® Système d’imagerie intravasculaire est principalement conçu pour une 
interaction par écran tactile. En plus de l’écran tactile, le système est équipé d’une 
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souris. Souvenez-vous des actions et des gestes suivants pour vous aider à interagir 
avec le Makoto® Système d’imagerie intravasculaire : 

 

Toucher Un contact momentané avec l’écran tactile ou le fait 
d’enfoncer et de relâcher un bouton physique 

Appuyer Appuyer et relâcher un bouton physique 

Cliquer avec le bouton Un seul clic sur le bouton droit de la souris 
droit de la souris 

Cliquer avec le bouton Un seul clic sur le bouton gauche de la souris 
gauche de la souris  
ou Cliquer 

Double-cliquer Deux clics successifs rapides sur le bouton gauche de la souris 

Faire défiler vers Tourner la roulette de défilement sur la souris vers l’utilisateur 
le haut / le bas pour descendre ou dans l’autre sens pour monter 

Faire glisser Quand le doigt est en contact avec une icône mobile, 
déplacer le doigt vers un autre emplacement. Retirer le doigt 
de l’écran pour relâcher l’icône.  
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3 Mises en garde, sécurité et précautions 
 

3.1 Contre-indications 
L’utilisation du cathéter Makoto® Système d’imagerie intravasculaire est contre-indiquée 
quand l’introduction d’un cathéter constitue une menace pour la sécurité du patient. Les 
contre-indications incluent : 
 

• une bactériémie ou septicémie ; 

• des anomalies majeures du système de coagulation ; 

• une instabilité hémodynamique grave ou un choc ; 

• les patients qui sont diagnostiqués avec un spasme de l’artère coronaire ; 

• les patients qui ne peuvent pas subir de PAC (pontage aortocoronarien) ; 

• une occlusion totale ; 

• les patients qui ne peuvent pas subir d’ACTP ; 

• les patients chez qui une ATP est exclue ; 

• les patients qui ne conviennent pas aux procédures IVUS. 
 

3.2 Complications 
Les complications suivantes peuvent survenir à la suite d’un examen intravasculaire : 
 

• réaction allergique ; 

• angor ; 

• un arrêt cardiaque ; 

• des arythmies cardiaques y compris, mais sans s’y limiter, une tachycardie 
ventriculaire, une fibrillation auriculaire / ventriculaire et un bloc cardiaque complet ; 

• une tamponnade cardiaque / un épanchement péricardique ; 

• la mort ; 

• un dispositif coincé nécessitant une intervention chirurgicale ; 

• un embolisme (air, corps étranger, tissus ou thrombus) ; 

• une hémorragie / un hématome ; 

• hypotension ; 

• infection ; 

• infarctus du myocarde ; 

• ischémie myocardique ; 

• un AVC et un accident ischémique transitoire ; 

• thrombose non expliquée ; 

• une occlusion vasculaire et une fermeture soudaine ; 

• un traumatisme vasculaire y compris, mais sans s’y limiter, une dissection et 
une perforation. 
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3.3 Sécurité 
Le Makoto® Système d’imagerie intravasculaire ou Makoto® a été conçu pour être utilisé 
et entretenu de la façon la plus sûre possible. Cependant, tout instrument médical peut 
causer des blessures s’il n’est pas correctement installé, utilisé, déplacé ou entretenu ; 
et ce système n’échappe pas à cette règle.  

Les risques potentiels sont : 

• des lésions oculaires (vision) provoquées par une exposition à un rayonnement 
laser direct ou réfléchi ; 

• une décharge électrique provoquée par l’entrée en contact avec des 
composants électriques à l’intérieur du système ; 

• un préjudice physique provoqué par l’utilisation ou le déplacement du système. 

 

Les incidents graves impliquant le système d'imagerie intravasculaire Makoto® doivent 
être immédiatement signalés à Infraredx et à l'autorité compétente de l'État membre 
dans lequel l'utilisateur et/ou le patient est établi. Les coordonnées d'Infraredx ou de 
votre prestataire de services local figurent dans les sections 1.5 Coordonnées 
d’Infraredx ou 14.1 About (À propos de) . 

 

REMARQUE : Les informations relatives à la sécurité et aux performances 
cliniques du système d'imagerie intravasculaire Makoto® sont 
disponibles à l’adresse suivante: https://infraredx.com/SSCP. 
 
Après le lancement de la base de données européenne sur 
les dispositifs médicaux (EUDAMED), rendez-vous sur 
https://ec.europa.edu/tools/eudamed pour consulter ces 
informations pour ce dispositif medical. Elles y sont liées à 
l’UDI-DI de base pour le système d’imagerie intravasculaire 
Makoto® : 0857595006SNUEQ 
 

 

Le Makoto® est doté de fonctionnalités conçues spécifiquement pour assurer un 
fonctionnement en toute sécurité aux utilisateurs. Tout le personnel du laboratoire de 
cathétérisme doit se familiariser avec l’emplacement et le fonctionnement des 
caractéristiques de sécurité mentionnées ci-dessous. Pendant l’imagerie, les 
composants mobiles sont totalement enfermés. Ainsi, l’utilisateur ne s’expose pas à des 
risques mécaniques. 

Toute personne utilisant le Makoto® pour effectuer une procédure sur un humain de 
quelque nature que ce soit doit comprendre parfaitement les conséquences d’une telle 
utilisation. L’AIUM (American Institute of Ultrasound in Medicine, Institut américain des 
ultrasons en médecine) a publié un document intitulé « Medical Ultrasound Safety » 
(Sécurité des ultrasons en médecine) (AIUM 2009). ALARA est un acronyme désignant 

https://infraredx.com/SSCP
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le principe d’utilisation prudente du diagnostic par ultrasons en obtenant les 
informations diagnostiques à une puissance de sortie As Low As Reasonably 
Achievable (aussi faible que raisonnablement possible). Pour obtenir une copie de ce 
document, veuillez contacter l’AIUM. 

AVERTISSEMENT 

Les précautions décrites dans cette section doivent être prises 
lors de l’installation, du fonctionnement, du déplacement ou de 
l’entretien du système afin d’éviter des situations potentiellement 
dangereuses. 
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SYMBOLE SIGNIFICATION 

 

Avertissement 

 

Attention 

 

Consulter la notice d’utilisation 

 

Consulter le mode d’emploi 

 

Le produit répond aux normes américaines, 
européennes et canadiennes applicables 

telles qu’évaluées par TUV Rheinland. 

100-120 V~ 50/60 Hz 5 A 
220-240 V~ 50/60 Hz 3 A 

Le produit fonctionne à partir d’une source 
d’alimentation qui fournit nominalement 

100 VCA, 120 VCA, 220 VCA ou  
240 VCA, 50/60 Hertz  

Le courant maximum est de 5 ampères à 
100-120 VCA, 3 ampères à 220-240 VCA. 

 

Fabricant  

 

Date de fabrication 

 
Numéro de catalogue 

 
Numéro de série 
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Numéro de lot 

 
Dispositif médical 

 
Date limite d’utilisation 

 

Masse 

 
Représentant autorisé dans la  

Communauté européenne 

 Représentant autorisé en Suisse 

 Importateur 

 

Mise à la terre de protection (terre) 

 

Application cardiaque directe protégée contre 
les chocs de défibrillation (pièce appliquée  

de type CF) 

 

La quantité contenue dans l’emballage. 

 
Unité d'emballage 
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Diamètre intérieur du cathéter-guide 
compatible 

 
Diamètre extérieur du fil-guide compatible 

 

Faisceau laser 

 

À conserver à l’abri de la lumière du soleil 

 

Apyrogène 

 

Garder au sec 

 

Limite de température 

 

Limite de température pendant le transport 

 

Limitation d’humidité 
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Limite d’humidité pendant le transport 

 

Ce dispositif peut uniquement être vendu ou 
utilisé sur ordonnance d’un médecin 

 

Ne pas utiliser si l’emballage est endommagé 

 

Ne pas réutiliser ce dispositif 

 

Ne pas restériliser 

 
Stérilisé à l’oxyde d’éthylène 

 

N’a pas fait l’objet d’une évaluation de 
l’innocuité lorsqu’il est utilisé avec une IRM  

 

La marque CE indique que le produit est 
conforme à la législation de l'Union 

européenne ; le numéro indique l'organisme 
notifié spécifique qui effectue l'évaluation de 

la conformité. 

 

Le symbole INMETRO indique que le produit 
répond aux exigences de sécurité pour entrer 

sur le marché brésilien ; le numéro OCP 
indique l'organisme de certification du produit. 
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Compatible avec 

 

Limite de pression atmosphérique 

 

Aucune pièce de la console du Makoto® ou du contrôleur du Makoto® ne peut être 
entretenue par l’utilisateur. Tous les réglages sont effectués en usine avant que le 
produit soit expédié aux clients ou sur site par un membre du personnel ou un 
fournisseur de services d’Infraredx qualifié.  

 

ATTENTION 

Toute modification ou toute tentative de modification du 
Makoto® Système d’imagerie intravasculaire rend la garantie du 
produit nulle et peut également entraîner un dysfonctionnement 
du système.  

Une dégradation du dispositif ou une défaillance du produit peut 
en découler. 

 

3.4 Précautions optiques 
 

 
AVERTISSEMENT 

Le produit contient un appareil à laser de classe 1M qui émet un 
rayonnement laser invisible. Ne regardez pas directement à 
l’aide d’instruments optiques. 

 

 
AVERTISSEMENT 

Ne regardez jamais directement dans le faisceau laser 
provenant du système ou réfléchi par une surface. 
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AVERTISSEMENT 

Ne regardez pas dans le faisceau laser à l’aide de lentilles, de 
jumelles, de loupes, de viseurs de caméra, de télescopes ou de 
tout autre élément ou instrument optique qui pourrait diriger la 
lumière dans l’œil. 

 

AVERTISSEMENT 

Ne permettez jamais à des objets réfléchissants tels que des 
bijoux, des montres, des instruments métalliques ou des miroirs 
d’intercepter et de réfléchir le rayon laser. 

 

Le Makoto® Système d’imagerie intravasculaire intègre un système laser et est classé 
comme un « appareil à laser de classe 1M » en vertu d’une norme sur les performances 
de rayonnement du Department of Health and Human Services (DHHS, Département de 
la Santé et des Services sociaux des États-Unis) conformément à la Radiation Control for 
Health and Safety Act of 1968 (Loi de 1968 sur le contrôle des rayonnements pour la 
santé et la sécurité) et à la CEI 60825-1, Sécurité des appareils à laser. 

L’énergie lumineuse émise par ce système se situe dans la région invisible et proche 
infrarouge du spectre électromagnétique à des longueurs d’onde comprises entre 1 et 
2 microns. Il est nécessaire de tenir compte de ce fait lorsque des précautions sont 
prises pour éviter une exposition involontaire.  

 

REMARQUE : Le port de lunettes de sécurité laser n’est PAS requis lors de 
l’utilisation du Makoto® Système d’imagerie intravasculaire. 

 

3.5 Précautions électriques 
 

AVERTISSEMENT 

Le non-respect des informations contenues dans cette 
section peut entraîner des dommages à l’équipement, des 
dommages corporels et même la mort. 

 

ATTENTION 

Il est déconseillé d’utiliser cet équipement à proximité d’autres 
équipements ou empilé sur ceux-ci, sans quoi des 
dysfonctionnements pourraient être rencontrés. Si cette 
configuration est inévitable, suveillez tous les équipements, y 
compris celui-ci, pour vous assurer qu’ils fonctionnent 
normalement. 
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ATTENTION 

Les équipements médicaux électriques nécessitent des 
précautions spéciales concernant la compatibilité 
électromagnétique, et doivent être installés suivant les 
informations relatives à la compatibilité électromagnétique 
incluses dans l’Annexe H : conformité électromagnétique. 

 

 

ATTENTION 

NE positionnez PAS le Makoto® Système d’imagerie 
intravasculaire à proximité d’autres équipements, car cela 
pourrait provoquer des interférences électriques. 

 

ATTENTION 

Une IVUS en direct ou un scan de retrait peut être 
interrompu(e) si le système est exposé à une décharge 
électrostatique (DES). Si une IVUS en direct ou un scan de 
retrait est interrompu(e), le scan peut être immédiatement 
redémarré.  

 

Le Makoto® Système d’imagerie intravasculaire utilise une tension de ligne CA à 
l’intérieur de la console. Le fait de débrancher la fiche du cordon d’alimentation du 
Makoto® de la prise coupera l’alimentation du système, provoquant ainsi un arrêt brutal 
de toutes les opérations.  

Aucune pièce du boîtier extérieur ne doit être déplacée, sauf par un technicien qualifié 
et autorisé. 

Pour réduire le risque d’électrocution, ne branchez pas le connecteur d’alimentation 
électrique du système à un équipement qui n’est pas protégé à la terre. Ne raccordez 
pas le système à un équipement de classe II. 

Les équipements de communication radiofréquence (RF) peuvent affecter les 
performances du Makoto® Système d’imagerie intravasculaire. Ce type d’équipement 
doit être situé le plus loin possible du Makoto®. Des émissions RF rayonnées ou 
conduites peuvent provoquer une distorsion de l’image ou d’autres artefacts sur l’écran 
de l’IVUS. 

 

ATTENTION 

Le système Makoto® n’est pas destiné à être utilisé avec un 
équipement chirurgical haute fréquence (HF) / radiofréquence 
(RF). 
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ATTENTION 

Les émissions RF rayonnées ou conduites peuvent provoquer 
une distorsion de l'image ou des artefacts sur l'écran du 
système d'imagerie intravasculaire Makoto®. 
 

 

Infraredx recommande d’utiliser une source d’alimentation sans coupure dans une 
installation dans laquelle des creux de tension ou des interruptions peuvent se produire. 

Le système Makoto® est conçu pour fonctionner soit en mode « hors ligne », soit 
connecté par câble réseau à un système d’information hospitalier protégé et sécurisé. 
Lorsqu’un câble réseau est branché au Makoto® Système d’imagerie intravasculaire 
pour transférer des données vers un système d’information hospitalier, le câble doit 
alors être un câble Ethernet blindé Cat 5e (consultez la section 3.9). L’utilisation d’un 
câble non conforme peut entraîner une augmentation des émissions RF ou une 
diminution de l’immunité RF.  

 

3.6 Précautions mécaniques 
 

 
AVERTISSEMENT 

Ne positionnez PAS l’opérateur de la console mobile du 
Makoto® Système d’imagerie intravasculaire entre la console du 
système Makoto® et d’autres équipements mobiles du 
laboratoire de cathétérisme en raison du risque de dommages 
corporels.  

 

 
AVERTISSEMENT 

La table d’opération doit être maintenue à niveau pendant 
l’utilisation du système Makoto® ou à tout moment lorsque le 
contrôleur du Makoto® se trouve dans le champ stérile. N’utilisez 
PAS les commandes d’inclinaison ou de déplacement de la 
table, si ces dernières sont disponibles. 

 

 
AVERTISSEMENT 

NE positionnez PAS le Makoto® Système d’imagerie 
intravasculaire dans la plage de mouvement des pièces du 
système de radiographie. 
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AVERTISSEMENT 

Assurez-vous que les câbles provenant du Makoto® Système 
d’imagerie intravasculaire ou y étant branchés sont bien à plat 
sur le sol. 

 

Dans un scénario typique d’utilisation, la console mobile du Makoto® Système 
d’imagerie intravasculaire est positionnée près du pied de la table d’examen ou à droite 
des moniteurs du système de radiographie. Un risque de basculement peut être créé si 
la console mobile du système Makoto® entre en contact avec un équipement mobile du 
laboratoire de cathétérisme (table d’examen, C-Arm, etc.). Ne verrouillez pas les 
roulettes à frein sur la console du Makoto® lorsque ce dernier est positionné dans la 
plage de mouvement de l’équipement en question.  

 

Lors de l’utilisation normale de la console mobile du Makoto® Système d’imagerie 
intravasculaire, différents câbles peuvent être branchés à la console ou en provenir. 
Assurez-vous que les câbles sont bien à plat sur le sol afin de réduire au maximum les 
risques de trébucher. Partout où cela est possible, évitez de poser des câbles dans les 
zones où beaucoup de piétons circulent dans la pièce.  

 

Le contrôleur du Makoto® doit être positionné sur une surface plane au cours de la 
procédure, en particulier pendant l’acquisition des données Le contrôleur du Makoto® 
doit être positionné dans le support de stockage de la console lorsque la console est 
déplacée ou que le contrôleur n’est pas utilisé. 

 

3.7 Précautions incendie 
 

 
AVERTISSEMENT 

Cet équipement n’est pas conçu pour être utilisé avec des 
anesthésiques ou des liquides inflammables ou dans des 
environnements riches en oxygène (>25 %). 

 

 
AVERTISSEMEN

T  

ÉTAT DE CALIFORNIE (ÉTATS-UNIS UNIQUEMENT) 
 
Ce produit contient du bisphénol A (BPA), une substance 
chimique reconnue par l’État de Californie comme pouvant 
causer des malformations congénitales ou d’autres troubles de 
la reproduction.   
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Pour plus d’informations, consultez le site 
www.P65warnings.ca.gov 

 

Il n’y a aucun risque chimique ou d’incendie connu associé au Makoto® Système 
d’imagerie intravasculaire.  

 

3.8 Précautions liées au cathéter et aux accessoires 
 

 
AVERTISSEMENT 

 
ÉTAT DE CALIFORNIE (ÉTATS-UNIS UNIQUEMENT) 
 
Les produits jetables compatibles et leur emballage ont été 
stérilisés avec de l’oxyde d’éthylène. L’emballage peut vous 
exposer à l’oxyde d’éthylène, un produit chimique reconnu par 
l’État de Californie comme cause de cancers, de malformations à 
la naissance ou d’autres problèmes de reproduction. 
 

 

 
AVERTISSEMENT 

Les cathéters et accessoires (barrière stérile du contrôleur du 
Makoto®, accessoires d’amorçage) sont fournis stériles et sont 
conçus uniquement pour un usage unique. Exclusivement à 
usage unique. Ne pas réutiliser, reconditionner ou restériliser. La 
réutilisation, le retraitement ou la restérilisation peuvent 
compromettre l’intégrité structurelle et entraîner une mauvaise 
qualité d’image ou causer une blessure, une maladie ou la mort 
du patient. La réutilisation, le retraitement ou la restérilisation 
peuvent également contaminer le dispositif et provoquer une 
infection chez le patient pouvant causer une maladie ou la mort 
du patient. Infraredx ne fait aucune déclaration quant aux 
performances d’un produit réutilisé, retraité ou restérilisé. 
 

 

 
AVERTISSEMENT 

N’utilisez PAS le cathéter si l’emballage interne est ouvert ou 
endommagé. 

 

http://www.p65warnings.ca.gov/
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AVERTISSEMENT 

Lorsque le cathéter est branché au contrôleur du Makoto®, ne 
regardez PAS l’extrémité distale du cathéter ou ne regardez 
PAS directement avec des instruments optiques. 

 

 
AVERTISSEMENT 

Les déchets médicaux peuvent causer une infection et/ou une 
maladie. Après utilisation, jeter le produit et l’emballage 
conformément à la réglementation hospitalière, administrative 
et/ou gouvernementale locale. 

 

 
AVERTISSEMENT 

Des précautions doivent être prises lorsqu’un fil-guide est 
exposé dans un vaisseau à stent. Les cathéters qui 
n’encapsulent pas le fil-guide peuvent entrer en contact avec le 
stent à la jonction du cathéter et du fil-guide. 

 

 
AVERTISSEMENT 

 
Des précautions doivent être prises lors de la progression d’un 
fil-guide après le déploiement du stent. Lors du passage d’un 
stent, le fil peut sortir entre des entretoises de stent qui ne sont 
pas complètement apposées. Une progression ultérieure du 
cathéter pourrait emmêler le cathéter et le stent déployé. 
 

 

 
AVERTISSEMENT 

En cas de résistance lors du retrait du cathéter, vérifiez la 
résistance en utilisant la fluoroscopie, puis retirez le système 
entier du cathéter, du cathéter-guide et du fil-guide en utilisant 
un guidage fluoroscopique. 

 

Le Makoto® Système d’imagerie intravasculaire émet un rayonnement laser proche 
infrarouge depuis le laser situé sur la console à travers le contrôleur du Makoto® et le 
cathéter branché. La lumière proche infrarouge est invisible pour l’œil humain. Fixer ou 
diriger la lumière proche infrarouge vers la cornée et la rétine peut causer des lésions 
oculaires. 

Le système d’imagerie intravasculaire Makoto® est uniquement conçu pour être utilisé 
avec les cathéters compatibles. Une liste des cathéters compatibles est disponible à la 
Section 17.1 Informations relatives au système.  
 Avant leur utilisation, examinez soigneusement tous les équipements à utiliser pendant 
la procédure pour vous assurer qu’ils fonctionnent correctement. Le cathéter a été 
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inspecté et stérilisé à l’oxyde d’éthylène avant d’être livré. Avant toute utilisation, 
inspectez le cathéter et son emballage pour vous assurer de l’absence de dommages 
ou de trous sur les emballages stériles. 

 
 

ATTENTION 

N’entortillez ou ne courbez pas fortement (>45°) le cathéter à 
aucun moment. Cela peut entraîner une défaillance du câble de 
lecteur.  

 

 

3.9 Respect des normes de sécurité 
 

 
AVERTISSEMENT 

L’utilisation d’accessoires non approuvés peut entraîner le non-
respect par le Makoto® Système d’imagerie intravasculaire d’une 
ou plusieurs normes répertoriées dans cette section du manuel. 

 

Le Makoto® Système d’imagerie intravasculaire a été conçu pour respecter toutes les 
normes applicables (CEI, ANSI, ISO, UL, etc.) en matière d’utilisation en toute sécurité de 
lasers, d’ultrasons et d’équipements électriques dans les établissements de santé.  

Les accessoires suivants ont été testés et sont compatibles avec le Makoto® Système 
d’imagerie intravasculaire : Câble de données et vidéo intégré (TVC-10PMC), câble 
DVI-D (PN2665) et câble Cat5e blindé (PN2690). Contactez votre représentant 
commercial pour passer commande. 

 

Les normes spécifiques incluent notamment : 

Standard Description 

  
CEI 60601-1 Appareils électromédicaux – Partie 1 : 

exigences générales pour la sécurité et les 
performances essentielles 

ANSI/AAMI ES60601-1 
Canada : CAN/CSA 22,2 N° 60601-1 
KS C CEI 60601-1 

  
CEI 60601-1-2 Appareils électromédicaux – Partie 1-2 : 

Exigences générales pour la sécurité de 
base et les performances essentielles - 
Norme collatérale : compatibilité 
électromagnétique - Exigences et tests 
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Standard Description 
  
CEI 60601-1-6 Appareils électromédicaux – Partie 1-6 : 

Exigences générales pour la sécurité de 
base et les performances essentielles –
Norme collatérale : aptitude à l’utilisation 

CAN/CSA 22,2 N° 60601-1-6 

  
CEI 60601-2-37 Appareils électromédicaux – Partie 2-37 : 

exigences particulières pour la sécurité de 
base et les performances essentielles des 
équipements de diagnostic et de 
surveillance médicaux à ultrasons 

CAN/CSA 22,2 N° 60601-2-37 
KS C CEI 60601-2-37 

  
CEI 60825-1 Sécurité des appareils à laser – Partie 1 : 

exigences et classification des 
équipements 

CFR (Code des règlementations fédérales 
américaines) titre 21 parties 1040.10 et 
1040.11 

  
CEI 62304 Logiciels de dispositifs médicaux – 

Processus de cycle de vie des logiciels CAN/CSA-CEI/IEC 62304 
  
IEC 81001-5-1 
 

Sécurité, efficacité et sûreté des logiciels 
et des systèmes informatiques utilisés 
dans le domaine de la santé – Partie 5-1 : 
Sécurité – Activités dans le cycle de vie du 
produit.  

ISO 10555-1 Cathéters intravasculaires – cathéters 
stériles et à usage unique – Partie 1 : 
exigences générales  

  
ISO 10993 Évaluation biologique des dispositifs 

médicaux 
  

ISO 11135 Stérilisation des produits médicaux – 
Oxyde d’éthylène 

  
CEI 62366 Dispositifs médicaux – Application de 

l’ingénierie de l’aptitude à l’utilisation aux 
dispositifs médicaux 

CAN/CSA-CEI 62366 

  
ISO 15223-1 Dispositifs médicaux – Symboles à utiliser 

avec les étiquettes des dispositifs 
médicaux, l’étiquetage et les informations 
à fournir – Partie 1 : Exigences générales.  
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4 Description du système 
 

 
AVERTISSEMENT 

Le système d'imagerie intravasculaire Makoto® est conçu pour 
être utilisé exclusivement par des médecins et du personnel de 
laboratoire de cathétérisme qualifiés. 

 
Le Makoto® Système d’imagerie intravasculaire fournit une imagerie intravasculaire 
basée sur un cathéter à l’aide des technologies IVUS et NIRS. Le système utilise à la 
fois le son et la lumière pour caractériser les caractéristiques intravasculaires. 
 

 
Figure 4-1: Système d’imagerie intravasculaire Makoto®, cathéter d’imagerie Dualpro® IVUS+NIRS (RÉF : TVC-C195-42) et 

cathéter Infraredx Clarispro® HD-IVUS (RÉF : TVC-E195-42).  

Contrôleur 
du 
Makoto® 

Console du 
Makoto® 
(mobile) 

Cathéter d’imagerie 
IVUS+NIRS  
Dualpro®  

(TVC-C195-42)  

Cathéter d’imagerie 

Infraredx Clarispro® HD-

IVUS  
(TVC-E195-42) 
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Le système comprend trois composants majeurs : 

• la console mobile du Makoto® Système d’imagerie intravasculaire 

• le contrôleur du Makoto® 

• Cathéter (voir mode d’emploi du cathéter) : 
Cathéter d’imagerie Dualpro® IVUS+NIRS  
Cathéter d’imagerie DualproNIRS™ (n’apparaît pas sur la Figure 4-1) 
Cathéter d’imagerie DualproPlus® IVUS+NIRS (n’apparaît pas sur la 
Figure 4-1) 
Cathéter Infraredx Clarispro® HD-IVUS  

Le système possède deux composants mineurs : 

• Barrière stérile du contrôleur du Makoto® (emballée avec le cathéter) ; 

• Accessoires d'amorçage du cathéter (comprend des seringues d’amorçage, emballées 

avec le cathéter). 

 

4.1 La console mobile du Makoto® Système d’imagerie 
intravasculaire 

 

La console mobile du Makoto® Système d’imagerie intravasculaire ou la console du 
Makoto® contient de nombreux composants majeurs du système.  

La console du Makoto® intègre un module d’alimentation qui fournit l’énergie aux 
différentes parties du système. Le module d’alimentation alimente les écrans, l’unité 
centrale de traitement (CPU), le laser et le contrôleur du Makoto®. 

Le CPU est intégré dans la console du Makoto®. Le CPU gère, stocke et restitue les 
données enregistrées avec le contrôleur et le cathéter du Makoto®. Il contrôle 
également la fonction des interfaces utilisateur graphiques fournies à l’utilisateur. Le 
système contient un lecteur de données capable de stocker environ 1 000 scans. Les 
données peuvent être exportées du système sur des disques optiques (disque DVD ou 
Blu-ray™), une clé USB ou un emplacement réseau via un câble Ethernet. 

Le système peut être configuré pour envoyer des données aux réseaux PACS. 

ATTENTION 

Il n’est PAS recommandé d’utiliser le Makoto® Système 
d’imagerie intravasculaire comme un lieu d’archivage 
permanent des données. Les données de scans doivent être 
archivées sur d’autres supports et supprimées du disque dur du 
système. 

 

La source de lumière laser pour la réalisation de NIRS est intégrée dans la console. La 
lumière est fournie par un câble à fibre optique au contrôleur Makoto® où le cathéter est 
branché pendant l’utilisation. C’est ce faisceau de lumière qui permet au système de 
générer un chemogram ou une carte de probabilité des plaques d’intérêt contenant un 
cœur lipidique. 
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Figure 4-2 : Makoto® Système d’imagerie intravasculaire (TVC-MC10). 

La console intègre deux écrans. Le premier, celui du médecin, est orienté vers 
l’opérateur stérile pendant l’utilisation. Le second écran tactile, celui du poste de travail 
du technicien, est orienté vers le technicien non stérile ou l’opérateur circulant pendant 
l’utilisation. Cette disposition permet à l’opérateur non stérile d’annoter des données 
tout en fournissant à l’opérateur stérile une vue dégagée sur l’écran. 

L’écran du médecin est un moniteur FHD 1080p de 21,5 pouces (55 cm) avec une 
résolution de 1920 × 1080p. L’inclinaison et le pivotement de l’écran peuvent être 
ajustés pour fournir un angle de vision optimal au médecin stérile. 

L’écran du poste de travail du technicien est un moniteur FHD 1080p tactile capacitif de 
15,6 pouces (40 cm) avec une résolution de 1920 × 1080p. La rotation, l’inclinaison et le 
pivotement de l’écran peuvent être ajustés pour permettre un angle de travail 
confortable. 
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Écran du 
médecin 

 Roulettes à 
frein de 

direction 

 Roulettes à 
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position 
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Figure 4-3 : panneau d’interface du côté gauche du Makoto® Système d’imagerie intravasculaire (TVC-MC10) intégrant les 

ports USB 3.0 et le lecteur de supports optiques Blu-ray™. 

 

 
Figure 4-4 : panneau d’interface du côté droit du Makoto® Système d’imagerie intravasculaire (TVC-MC10) intégrant le 
bouton d’alimentation et les ports de sortie vidéo, PACS et d’intégration de la radiographie. 

La console du Makoto® est également configurée pour exporter un signal vidéo couleur 
de 1920x1080p (au format 16:9) à l’aide d’un câble vidéo DVI-D blindé. La résolution 
vidéo exportée peut être configurée en option sur 1600x1200 (au format 4:3). 

En plus de l’écran du poste de travail du technicien, les utilisateurs peuvent interagir 
avec le système en utilisant la souris fournie. Cette souris est située sous l’écran du 
poste de travail du technicien.  

Le système est équipé de deux roulettes à frein directionnelles pour faciliter le transport 
et de deux roulettes à frein supplémentaires pour maintenir en place ou entreposer 
le système.  

 

Lecteur de supports 
optiques Blu-ray™ 

USB 3.0 

Bouton 
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PACS 
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4.2 Interface utilisateur graphique du Makoto® Système d’imagerie 
intravasculaire 

Les fonctions du Makoto® Système d’imagerie intravasculaire sont commandées grâce 
aux interfaces utilisateurs graphiques du logiciel : le mode Acquisition et le mode 
Révision. 
 
 

 
Figure 4-5 : mode Acquisition (fonctionnalités optionnelles SmartImaging™ activées).  

 
Figure 4-6 : mode Révision. 

 

4.2.1 Mode Acquisition 
Le mode Acquisition est un mode de fonctionnement dans lequel de nouvelles données 
peuvent être enregistrées par le Makoto® Système d’imagerie intravasculaire. Il se 
compose de quatre phases différentes : « Setup » (Configuration), « Prime » 
(Amorçage), « Scan » (Numérisation) et « Close » (Fermeture). En utilisant la barre de 
progression, l’opérateur peut se déplacer facilement et rapidement entre les phases 
pour s’adapter au rythme de la procédure.  

 
 
 

Basculement 
entre les modes 
du Makoto® 
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Figure 4-7 : affichage du mode Acquisition en mettant l’accent sur la commande de la barre de progression de la 
procédure pour changer de phases et la commande de basculement du mode du Makoto® pour changer de modes de 
fonctionnement. La phase « Scan » (Numérisation) du mode Acquisition est active et le basculement du mode du Makoto® 
vers le mode Révision est désactivé dans l’image. 

La barre de progression décrit les différentes étapes ou phases de l’acquisition des 
données et fournit également une commande pour changer de phases. Touchez les 
différents noms de phase pour passer à la phase désirée. 

 

REMARQUE : Les phases du mode Acquisition peuvent se dérouler dans 
n’importe quel ordre. Chaque étape peut être ignorée puis 
reprise si cela est nécessaire ou plus pratique. 

 

Touchez la commande de basculement du mode du Makoto®, l’icône « Review » 

(Révision) , pour accéder au mode de fonctionnement Révision. Cette action ne 
peut être réalisée que si aucune procédure active n’est en cours. Toute procédure 
active doit être fermée avant de changer de modes. 

 

4.2.1.1 La phase « Setup » (Configuration) 
La phase « Setup » (Configuration) permet à l’opérateur de saisir des informations sur le 
patient et la procédure pour faciliter l’archivage et la récupération ultérieure pour révision. 

 

ATTENTION 

Des précautions doivent être prises lors de la saisie des 
informations sur le patient pour en assurer l’exactitude. 

 

Barre de 
progression 

Basculement entre 
les modes du 
Makoto® 
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Figure 4-8 : phase « Setup » (Configuration) du mode Acquisition. 

 

REMARQUE : Les données de scans peuvent être enregistrées avant la fin 
de la phase « Setup » (Configuration). 

 

Les informations sur la procédure et le patient peuvent être configurées manuellement 
ou en sélectionnant les données déjà présentes dans le système ou la liste de travail 
des modalités. L’utilisation des fonctions d’achèvement semi-automatiques peut réduire 
les erreurs de transcription et améliorer l’exactitude des informations saisies. 

REMARQUE : L’utilisation des fonctions d’achèvement semi-automatiques 
peut réduire les erreurs de transcription et améliorer 
l’exactitude des informations saisies. 

 

REMARQUE : La phase « Setup » (Configuration) n’est pas accessible 
pendant la numérisation active. 

 

Consultez la section 7 pour obtenir des informations plus détaillées sur la configuration 
de la procédure. 
Consultez la section 14.5 pour plus d’informations sur la configuration des connexions 
de la Liste de travail de modalité. 
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4.2.1.2 La phase « Prime » (Amorçage) 
 

 
AVERTISSEMENT 

Le cathéter stérile doit être amorcé conformément au document 
contenant les instructions d’utilisation inclus dans l’emballage du 
cathéter. 

 

 
AVERTISSEMENT 

Le suivi des conseils d’amorçage supplémentaires à l’écran ne 
remplace pas la formation à l’utilisation du Makoto® Système 
d’imagerie intravasculaire. 

 

La phase « Prime » (Amorçage) donne des conseils à l’opérateur sur le processus 
d’amorçage d’un cathéter et le branchement du cathéter sur le contrôleur du Makoto®. 

 
Figure 4-9 : phase « Prime » (Amorçage) du mode Acquisition. 

 

REMARQUE : Appuyez sur le bouton « Mark » (Marque) sur le contrôleur du 

Makoto®, , pour passer à la prochaine phase. 
 

REMARQUE : La phase « Prime » (Amorçage) n’est pas accessible pendant 
la numérisation active.  

 

Consultez la section 8 pour obtenir plus d’informations sur le branchement du cathéter et 
les instructions d’utilisation fournies avec le cathéter pour plus de détails sur l’amorçage. 
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4.2.1.3 La phase « Scan » (Numérisation) 
La phase « Scan » (Numérisation) de la procédure permet à l’opérateur d’enregistrer 
des données de scans IVUS et NIRS pendant la procédure en cours. L’opérateur peut 
également relire, réviser, supprimer, mesurer, annoter et modifier la vitesse du prochain 
retrait pendant la procédure en cours lorsque l’imagerie active n’a pas déjà commencé.  

Cette phase inclut de nombreux affichages de données d’imagerie complexes, y 
compris le chemogram, le chemogram au niveau du bloc, le halo du chemogram, les 
images IVUS transversales et longitudinales. 

Les deux ensembles d’informations, NIRS et IVUS, enregistrés par le Makoto® Système 
d’imagerie intravasculaire sont coenregistrés et peuvent être révisés en utilisant la 
lecture synchronisée. 

 

  
Figure 4-10 : phase « Scan » (Numérisation) du mode Acquisition avec les affichages principaux des informations sur 

l’image indiqués (fonctionnalités optionnelles SmartImaging™ activées). 

REMARQUE : Aucune donnée de chemogram ou de NIRS ne sera affichée 
lors d'une utilisation avec le cathéter HD-IVUS Clarispro® 
d’Infraredx. 

 
La phase « Scan » (Numérisation) permet également d’accéder aux fonctions d’annotation 
et de mesure disponibles pendant une procédure active. Les scans peuvent être 
renommés, annotés et avoir des cadres individuels marqués pour être facilement 
récupérés en vue de leur révision. Des mesures du cadre peuvent également être prises.  
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Figure 4-11 : Phase « Scan » (Numérisation) du mode Acquisition avec les commandes de base indiquées (fonctionnalités 

optionnelles SmartImaging™ activées) . 

 

Consultez les sections 9 et 10 pour obtenir des informations plus détaillées sur 
l’acquisition, la navigation et la mesure de scans. 

 

4.2.1.4 La phase « Close » (Fermeture) 
La phase « Close » (Fermeture) de la procédure permet à l’opérateur d’examiner un 
résumé des données obtenues pendant une procédure avant l’archivage sur le système. 

Il est important de terminer la phase « Close » (Fermeture) pour chaque procédure 
avant de mettre le système hors tension. 

 
Figure 4-12 : phase « Close » (Fermeture) du mode Acquisition. 
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REMARQUE : Commencer une nouvelle acquisition à partir du contrôleur du 
Makoto® fera automatiquement retourner le mode Acquisition 
à la phase « Scan » (Numérisation). 

 

REMARQUE : Vous devez entrer les informations minimales requises du 
patient et de la procédure sur l’écran de la phase « Setup » 
(Configuration) pour terminer la phase « Close » (Fermeture). 

 

REMARQUE : Les procédures qui n’ont pas été fermées avant l'arrêt du 
système sont accessibles depuis le mode Révision. La 
procédure peut être reprise avant d’être fermée et archivée. 

 

Consultez la section 11 pour obtenir des informations plus détaillées sur la fermeture de 
la procédure. 

 

4.2.2 Mode Révision 
Le mode Révision se compose de deux phases : la phase « Select » (Sélection) et la 
phase « View » (Visualisation). Ces phases permettront à l’utilisateur de sélectionner 
une procédure, puis de la visualiser ou de l’exporter pour la visionner plus tard.  

 

 

 

 

 
Figure 4-13 : mode Révision avec la barre de progression et les commandes de basculement du mode du Makoto® 

mises en évidence. 

Touchez la commande de basculement du mode du Makoto®, l’icône Scan , pour 
accéder au mode de fonctionnement Acquisition. Cela peut être fait à n’importe quel 
moment dans la phase « Select » (Sélection) du mode Révision.  
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4.2.2.1 La phase « Select » (Sélection) 
La phase « Select » (Sélection) permet à l'opérateur de rechercher et de choisir des 
procédures précédemment enregistrées afin de les consulter, les modifier, les 
supprimer ou les archiver sur un autre support. 

  
Figure 4-14 : phase « Select » (Sélection) du mode Révision. 

Pendant cette phase, les données correctement formatées peuvent être sélectionnées 
à partir d’autres supports à importer dans le Makoto® Système d’imagerie 
intravasculaire. 

Consultez la section 12 pour obtenir des informations plus détaillées sur les fonctions 
de sélection, d’exportation et d’importation. 
 

4.2.2.2 La phase « View » (Visualisation) 
La phase « View » (Visualisation) fournit de nombreuses commandes similaires à celles 
trouvées pendant la phase « Scan » (Numérisation) du mode Acquisition. Dans cette 
phase, les données peuvent être révisées, analysées, annotées et supprimées en 
utilisant des commandes habituelles telles que décrites dans la section 10. 

 
Figure 4-15 : phase « View » (Visualisation) du mode Révision. 
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REMARQUE : Les données d’une seule procédure peuvent être consultées  
à la fois. 

 

Touchez la commande de basculement du mode du Makoto®, l’icône « Review » 

(Révision) , pour revenir à la phase « Select » (Sélection) du mode Révision.  

 

4.3 Le contrôleur du Makoto® 
Le contrôleur du Makoto® (voir ci-dessous) désigne l’interface entre le cathéter et la 
console du Makoto®. La poignée du cathéter est insérée dans une douille sur la face 
avant du contrôleur, puis tournée pour terminer les branchements physiques, optiques 
et électriques. Ces branchements permettent à l’unité d’actionner simultanément le 
noyau d’imagerie interne et de stabiliser la gaine externe du cathéter. Le mode de 
retrait du contrôleur du Makoto® permet une rotation automatique à environ 1 800 tr/min 
et un mouvement longitudinal distal à proximal à une vitesse de 0,5, 1,0, et 2,0 mm/s. 
Le noyau d’imagerie du cathéter peut effectuer un retrait automatique continu dans la 
direction distale à proximale sur une longueur totale de 150 mm. 

Le système Makoto® est équipé d'un récepteur RFID conçu pour fonctionner avec des 
émetteurs RFID dans la poignée du cathéter compatible pour l'identification du modèle 
de cathéter, le réglage de l'affichage et la facilitation d'autres flux de travail de 
l'utilisateur. 
 

4.3.1  Indicateurs 
 

  
Figure 4-16 : contrôleur du Makoto®. 

Le contrôleur du Makoto® est équipé d’un écran LCD qui fournira des messages sur le 
statut et des graphiques à l’utilisateur. 

Écran LCD  
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Figure 4-17: Indicateurs de l’écran LCD du contrôleur Makoto® lors d’une acquisition Live IVUS en position READY (PRÊT) 
avec un cathéter compatible IVUS+NIRS connecté (dessus), au repos avec un cathéter compatible HD-IVUS uniquement 
connecté en position READY (PRÊT), et lors d’une acquisition par retrait automatique avec un cathéter compatible 
IVUS+NIRS (dessous). 

Le contrôleur identifie pour l’utilisateur deux positions importantes pour l’opération : la 
position « READY » (PRÊT) et la position « 0,0 mm ». 

« READY » Cette position est la position la plus distale que la douille du  
(PRÊT) cathéter du contrôleur du Makoto® peut atteindre. Cette position 

indique l’emplacement où le contrôleur est prêt à ce que 
l’utilisateur « LOAD » (CHARGE ou branche) ou décharge 
(débranche) correctement un cathéter ou commence l’imagerie. Il 
s’agit également de la position dans laquelle la fenêtre de 
transmission du cathéter branché est la plus résistante à la torsion 
liée à la poussée et est prête à être suivie sur un fil-guide. 

Type de cathéter : 
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Figure 4-18 : quand le contrôleur du Makoto® est en position « READY » (PRÊT), l’icône « READY » (PRÊT) s’affiche à 

droite de l’écran de la console du Makoto®. 

 
« 0,0 mm » Cette position est l’emplacement de départ de l’imagerie 

ininterrompue continue pendant un scan IVUS en direct transféré. 
La position « 0,0 mm » est d’environ 5 mm proximale à la position 
« READY » (PRÊT). Les images IVUS transversales ne peuvent 
pas être visionnées ou enregistrées dans les emplacements situés 
entre « READY » (PRÊT) et « 0,0 mm ».  

Comme indiqué dans la Figure 4-17, l’écran LCD du contrôleur du Makoto® est utilisé 
pour communiquer d’importantes informations sur les capteurs, les modes de 
fonctionnement et les statuts : 

Type de cathéter Ce symbole,  , apparaîtra pour indiquer qu'un cathéter 

IVUS+NIRS a été connecté au contrôleur. Ce symbole,  , 
apparaîtra pour indiquer qu'un cathéter HD-IVUS a été 
connecté au contrôleur. Mode Acquisition Cet indicateur 
affiche « LIVE » (DIRECT), « AUTO » ou rien pour indiquer le 
mode d’acquisition d’images actuel du système. 

Vitesse de Cet indicateur communique la vitesse actuelle de transfert  
mouvement  quand l’acquisition d’images est en cours. Quand aucune 

acquisition d’images n’est en cours, la vitesse de mouvement 
communique le paramètre de commande de la vitesse du 
prochain retrait (consultez la section 9.2.1). 

« READY » Quand l’écran affiche « READY » (PRÊT), cela indique que  
(PRÊT) le système est en position « READY » (PRÊT) ou dans la 

position la plus distale que l’utilisateur peut atteindre en faisant 
fonctionner le contrôleur du Makoto®. 

Échelle relative La plage d’acquisition d’images continue, de 0,0 à 150,0 mm, 
est indiquée sur le contrôleur avec des démarcations à 
50,0 mm et à 100,0 mm.  

Position relative Quand le contrôleur du Makoto® est déplacé de manière 
proximale à partir de la position « READY » (PRÊT), 

Icône de la position 
« READY » (PRÊT). 
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l’emplacement actuel de la pointe d’imagerie est représenté 
par une ligne verticale sur l’échelle relative. 

  

 

 
Figure 4-19 : indicateur de la position relative pendant aucune imagerie (en haut), une IVUS en direct (au milieu) et un 

retrait (en bas). 

  

Position/Distance En imagerie Live IVUS ou Pullback, la distance affichée 
désigne la distance entre le début de l’imagerie et la marque 
la plus récente en millimètres. Lorsque le dispositif n’est pas 
en mode d’imagerie, la position actuelle de la pointe 
d’imagerie apparaît. 

Enregistrement L’indicateur d’enregistrement apparaît lorsque le système 
enregistre les images affichées sur l’opérateur. 

Plage enregistrée La plage d’enregistrement de l’IVUS en direct actuel ou de 
l’acquisition de retrait automatique est représentée par un 
rectangle plein. Les translations des acquisitions IVUS en 
direct apparaissent en blanc et les acquisitions de retrait 
automatiques apparaissent en vert, la partie pleine indiquant 
la plage enregistrée depuis la dernière marque. 

 

 

  

 

 

 



Makoto® Système d’imagerie intravasculaire 
Guide d’utilisation 

   
IFU0163rS.fr (2025-06-27)  4-17 

 

 

 

 

 
Figure 4-20 : Plage enregistrée pendant l’acquisition en cours : IVUS en direct avec position actuelle identique à la 

position de départ (1re ligne), IVUS en direct enregistrée avec position actuelle proximale à la dernière pression du bouton 
« Mark » (Marque) (2e ligne), retrait automatique sans marque (3e ligne), retrait automatique avec barre pleine indiquant la 

plage enregistrée depuis la dernière marque (4e ligne). 

« LOAD » Ce message indique que le contrôleur du Makoto® est en  
(CHARGER) position « READY » (PRÊT) et qu’un cathéter peut être chargé 

dans la douille. 

 
Figure 4-21 : l’écran LCD du contrôleur du Makoto® indiquant le statut « LOAD » (CHARGER). 

« TURN » Ce message indique que le contrôleur du Makoto® a détecté  
(TOURNER) un mauvais branchement de la poignée du cathéter. 

  
Figure 4-22 : l’écran LCD du contrôleur du Makoto® indiquant une instruction de tourner la poignée du cathéter. 

« WAIT » Le contrôleur du Makoto® attend que la console du Makoto®  
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(ATTENDRE) et l’interface utilisateur du logiciel soient initialisées. 

 
Figure 4-23 : l’écran LCD du contrôleur du Makoto® indiquant d’attendre que le système termine de démarrer par le statut 

« WAIT » (ATTENDRE). 

 

 
AVERTISSEMEN

T 

Des situations dangereuses, y compris des blessures au patient 
ou à l'opérateur, peuvent se produire si les avertissements 
affichés sont ignorés. 

 
« SEE DISPLAY »   
(VOIR L’ÉCRAN) Le contrôleur Makoto® a détecté une erreur ou une 

défaillance. Ce message invite l’opérateur à consulter les 
écrans du Makoto® Système d’imagerie intravasculaire pour 
obtenir des instructions plus détaillées. 

  
Figure 4-24 : Message d’erreur (gauche) et message de défaut interne (droite) du contrôleur Makoto®. Dans les deux cas, 

l'utilisateur est invité à consulter l'écran du système pour corriger l’erreur ou le défaut. 

 
 

Remarque : Si le message « See Display » (Voir l’écran) apparaît à plusieurs reprises 
après avoir suivi les indications à l’écran, contactez votre fournisseur de 
services local ou le service clientèle Infraredx pour obtenir de l’aide.  
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Le système d’imagerie Makoto® surveille les interactions du système afin de détecter 
les périodes d’inactivité. Si la limite de temps d'inactivité et les conditions sont 
respectées, le contrôleur entrera en mode économie d'énergie. Le système n'entrera 
pas en mode économie d'énergie si une procédure est en cours ou si un cathéter est 
connecté au système. La connexion de l'utilisateur fait sortir le système du mode 
économie d'énergie. 

 
REMARQUE : Les utilisateurs disposant de droits d'administrateur peuvent régler 

le temps d'inactivité, voir la section 14.10 Système.  
 
 

4.3.2 Commande du mode Acquisition 
 

 
AVERTISSEMEN

T 

Des situations dangereuses, y compris des blessures au patient 
ou à l'opérateur, peuvent se produire si les avertissements 
affichés sont ignorés. 

 

 
AVERTISSEMEN

T 

Le mouvement linéaire du contrôleur s'arrête lorsqu'une force 
excessive est rencontrée. 

Vérifiez que le cathéter ne présente pas de pliures, de coudes 
aigus ou de dommages et résolvez-les avant de continuer. 

Appuyez sur « STOP » (ARRÊT), , sur le contrôleur 
Makoto® et suivez les instructions à l'écran pour résoudre le 
problème. 
 

N’utilisez PAS les fonctions de translation à une étape pour 
régler le problème d’entortillement ou de déformation. La gaine 
du cathéter pourrait être endommagée ou le patient blessé. 

 

 
AVERTISSEMEN

T 

Si une pression du bouton « STOP » (ARRÊT), , sur la 
commande Makoto® n’interrompt pas le mouvement du cathéter, 
débranchez immédiatement le Makoto® Système d’imagerie 
intravasculaire. 
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Figure 4-25 : boutons des fonctions du contrôleur du Makoto®, deux modèles disponibles (ci-dessus et ci-dessous)). 

 

Le contrôleur du Makoto® est équipé de boutons simples permettant à l’utilisateur de 
commander le mouvement du système et l’acquisition de données. 
 

Retour en position 
« READY » (PRÊT) Ce bouton déplacera automatiquement le noyau d’imagerie 

du cathéter depuis son emplacement actuel vers la position 
« READY » (PRÊT) la plus distale. Cette position du noyau 
est nécessaire avant de déplacer le cathéter dans le patient 
ou de le brancher ou débrancher. 

« STOP » (ARRÊT) Ce bouton arrête le mouvement du contrôleur du Makoto® et 
toute collecte de données en cours. 

Retrait Ce bouton déclenche la rotation automatique et le retrait 
automatique d’un cathéter branché. La vitesse de rotation 

STOP (ARRÊT) 

Retrait 

« Mark » (Marque) 

Enregistrement / IVUS en direct 

Distal rapide 

Retour en 
position 
« READY » 
(PRÊT) 
 

Proximal rapide Proximal lent Distal lent 

STOP (ARRÊT) 

Retrait 

« Mark » (Marque) 

Enregistrement / IVUS en direct Distal  
rapide 

Retour en 
position 
« READY » 
(PRÊT) 

Proximal rapide Proximal lent 
Distal 
lent 
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est réglée à environ 1 800 tr/min, mais la vitesse de retrait 
correspond à la vitesse sélectionnée sur la console du 
Makoto® (0,5, 1,0, ou 2,0 mm/sec).  

 À partir de « READY » (PRÊT) : une pression et un 
relâchement du bouton de retrait déplacent le noyau d’imagerie 
à la position « 0,0 mm » et démarrent l’IVUS en direct pour 
pouvoir visionner un aperçu de l’emplacement d’imagerie de 
départ du scan. Appuyez à nouveau sur le bouton de retrait 
pour lancer le scan. Maintenir enfoncé le bouton de retrait en 
position « READY » (PRÊT) permet d’ignorer l’aperçu et de 
commencer le mouvement et l’enregistrement automatiques. 
Le bouton peut être relâché lorsque l’écran indique que 
l’imagerie « AUTO » a commencé. 

 À partir de la position ≥0,0 mm : une pression et un 
relâchement du bouton de retrait déclenchent un 
mouvement immédiat et l’enregistrement du scan.  

Vous pouvez appuyer sur le bouton de retrait, , 
pendant que le contrôleur du Makoto® est immobile ou qu’il 
tourne pendant une acquisition d’IVUS en direct. 

 

Enregistrement / Enfoncer une fois ce bouton permet de déclencher la  
IVUS en direct  rotation automatique du noyau d’imagerie du cathéter (sans 

retrait). Une image IVUS transversale en direct apparaît sur 
l’écran de la console du Makoto®. 

Enfoncer plusieurs fois le bouton d’IVUS en direct, , 
permet d’activer ou de désactiver un enregistrement de 
l’acquisition IVUS en direct en cours. Cette action n’arrête 
pas la rotation du noyau d’imagerie du cathéter.  

 

« Mark » (Marque) Ce bouton met en signet un cadre ou une position dans un 
scan pour une référence ou une révision ultérieures.  

 Pendant l’acquisition d’images, ce bouton remet l’affichage 
du contrôleur à zéro. La distance affichée par la commande 
sera mesurée à partir de l’endroit de la dernière pression sur 
le bouton « Mark » (Marque). 

 Pendant l’IVUS en direct non enregistrée, ce bouton 
enregistre un seul cadre IVUS. 
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 Pendant la phase « Prime » (Amorçage) du mode 
Acquisition, ce bouton fait passer le système à la phase 
« Scan » (Numérisation). 

Distal rapide Maintenir enfoncé ce bouton déplace le noyau d’imagerie du 
cathéter de manière distale à une vitesse de 10 mm/s. 

Appuyer sur ce bouton et le relâcher déplace le noyau 
d’imagerie du cathéter de manière distale d’une distance 
fixe de 0,5 mm.  

Distal lent Maintenir enfoncé ce bouton déplace le noyau d’imagerie du 
cathéter de manière distale à une vitesse de 2 mm/s. 

Appuyer sur ce bouton et le relâcher déplace le noyau 
d’imagerie du cathéter de manière distale d’une distance 
fixe de 0,1 mm. 

Proximal lent Maintenir enfoncé ce bouton déplace le noyau d’imagerie du 
cathéter de manière proximale à une vitesse de 2 mm/s. 

Appuyer sur ce bouton et le relâcher déplace le noyau 
d’imagerie du cathéter de manière distale d’une distance fixe 
de 0,1 mm. 

Proximal rapide Maintenir enfoncé ce bouton déplace le noyau d’imagerie du 
cathéter de manière proximale à une vitesse de 10 mm/s. 

Appuyer sur ce bouton et le relâcher déplace le noyau 
d’imagerie du cathéter de manière distale d’une distance fixe 
de 0,5 mm. 

REMARQUE : Les fonctions du contrôleur « Return to READY » (Retour à PRÊT), 
« Live IVUS » (IVUS en direct) et « Pullback » (Retrait) sont accessibles 
à partir de la console Makoto® en activant les fonctions de commande à 
distance, voir la section 14.10.6 Activer le contrôle à distance.  

 

4.4 Cathéters d’imagerie compatibles 
Les cathéters d’imagerie compatibles sont emballés séparément et sont stérilisés pour un 
usage unique. Veuillez consulter les instructions d’utilisation fournies avec le cathéter 
pour obtenir plus d’informations sur le cathéter ainsi que sa préparation et son utilisation. 

 

4.5 Spectroscopie par proche infrarouge (NIRS) 
Le système d'imagerie intravasculaire Makoto® est conçu pour identifier les plaques 
d'intérêt contenant un noyau lipidique, à travers le sang, dans les artères coronaires 
d'un cœur battant via les cathéters d'imagerie Dualpro® IVUS+NIRS, DualproNIRS™ et 
DualproPlus® IVUS+NIRS. Le système utilise la spectroscopie par proche infrarouge 
(NIRS) pour identifier la composition chimique de la paroi artérielle comme aide au 
cardiologue interventionnel dans l’évaluation des plaques coronaires. La base 
fondamentale de cette capacité d’imagerie est le principe de la spectroscopie de 
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réflectance diffuse, qui est bien établi et utilisé dans de nombreuses disciplines 
scientifiques.  

En résumé, la lumière NIR incidente est diffusée et absorbée par le tissu et la lumière 
réfléchie contient des informations sur la composition du tissu en fonction de ses 
propriétés d’absorption et de diffusion. Ces propriétés d’absorption et de diffusion sont 
régies par la composition chimique et la morphologie du tissu. 

 

4.5.1 Chemogram 
Après le retrait du noyau d'imagerie du cathéter Dualpro® IVUS+NIRS, DualproNIRS™ 
et DualproPlus® IVUS+NIRS par l'artère, le logiciel du système affiche une 
représentation graphique, sous forme de carte, indiquant la probabilité de présence 
d’une plaque d’intérêt contenant un noyau lipidique. Cette carte est appelée 
chemogram. Il fournit une image de l’artère qui indique la probabilité de trouver une 
plaque d’intérêt contenant un cœur lipidique à un endroit particulier du scan. Une forte 
probabilité est affichée en jaune et la probabilité décroissante passe progressivement 
au rouge. 
 

4.5.2 Lecture de l’écran du chemogram 
Pendant l’acquisition de données en temps réel, la carte de détection du fil-guide 
identifie l’emplacement de l’artefact produit par un fil-guide numérisé et aide le médecin 
à identifier les artefacts d’images dans les données spectroscopiques. À la fin d’un scan 
de retrait, le moniteur du Makoto® Système d’imagerie intravasculaire affiche 
deux cartes de pseudo-couleur de la paroi artérielle. Ces cartes sont le chemogram et 
le chemogram au niveau du bloc. Le chemogram et le chemogram au niveau du bloc 
indiquent les zones de l’artère coronaire étant susceptibles de contenir des plaques 
d’intérêt contenant un cœur lipidique.  

Les vues longitudinales de l’écran représentent le scan de droite à gauche (distal à 
proximal). L’axe x indique que la distance de retrait en millimètres de l’extrémité distale 
de la fenêtre de transmission du cathéter. L’axe y dans le chemogram et la carte de 
détection du fil-guide correspondent à la position angulaire relative des caractéristiques 
de la paroi vasculaire en degrés (la position angulaire de départ par rapport à la paroi 
est arbitraire). La partie du scan située à l’intérieur du cathéter-guide peut être indiquée 
en gris uni sur les extrémités proximales du chemogram et du chemogram au niveau du 
bloc, si le système détecte que le scan a été inséré dans le cathéter-guide.  

Le chemogram est coloré dans une échelle de couleur allant de rouge à jaune, d’une 
faible probabilité à une forte probabilité de présence de lipides. La couleur jaune 
apparaît à l’utilisateur lorsque la probabilité de présence de lipides dépasse 0,6 
n’importe où sur l’écran. Un masque semi-transparent noir apparaît sur le chemogram 
dans les zones où l’algorithme de détection de PCL a déterminé l’existence d’un faible 
signal ou d’une autre interférence. 

Le moniteur du système affiche les résultats de l’indice de masse du cœur lipidique 
(LCBI) à gauche du chemogram. Le LCBI est un rapport entre les scores de probabilité 
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des lipides positifs (>0,6) et les scores de probabilité de lipides valides totaux dans la 
plage sélectionnée du chemogram, sur une échelle de 0 à 1 000 (masse du cœur 
lipidique faible à élevée) dans un segment défini. Dans des études (consultez la 
section 18.2 de l’annexe B) portant sur des échantillons d’autopsie déterminés 
histologiquement, il a été démontré qu’il existait une corrélation entre le LCBI et la 
présence et le volume de fibroathérome dans l’artère. 

  
Figure 4-26 : le LCBI régional et maximal pour la région sélectionnée s’affichent à gauche dans le chemogram 

(fonctionnalités optionnelles SmartImaging™ activées).  

Le logiciel affichera le LCBI maximal d’une fenêtre de longueur fixe (4 mm par défaut) 
dans un segment et indiquera la position dans la région.  

 

LCBI Lipid Core Burden Index calculé pour chaque retrait effectué 
avec un cathéter compatible et dans une région d’intérêt 
définie par l’utilisateur. 

LCBI max. Lipid Core Burden Index calculé sur une largeur spécifiée 
dans un retrait total ou une région numérisée spécifiée par 
l’utilisateur. La valeur maximale trouvée sera présentée à 
l’utilisateur. 

Le chemogram du niveau du bloc, qui améliore le chemogram, est affiché au centre de 
la vue IVUS (écographie intravasculaire) longitudinale et se trouve sans dimension dans 
la direction y. Le bloc chemogram associé au support affiché actuellement apparaîtra 
au centre de la vue IVUS transversale. Le chemogram du niveau du bloc est divisé en 
deux grands blocs de 2 mm et résume l’ensemble des résultats prédictifs valables dans 
le segment correspondant du chemogram. Le chemogram du niveau du bloc est 
représenté par 4 couleurs allant de la probabilité la plus forte à la plus faible : jaune, 
brun, orange et rouge. Si le nombre de pixels dans le bloc du chemogram affecté par 
une interférence ou un signal faible dépasse 25 %, alors la couleur du bloc est noire. 

 

LCBI 

LCBI max 

Emplacement 
du LCBI max. 

Région 
sélectionnée 
pour le LCBI 
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REMARQUE :  Si le pourcentage de spectres trop faibles pour contribuer à la 
génération du chemogram dépasse 12 %, aucun chemogram ne sera 
généré. 

4.6 Ultrason intravasculaire 
Le système d'imagerie intravasculaire Makoto® est conçu pour identifier la lumière et la 
paroi des vaisseaux, à travers le sang, dans les vaisseaux du corps, à l'exclusion des 
vaisseaux cérébraux, via un cathéter d'imagerie à balayage. Le système utilise les 
ultrasons pour évaluer les limites de la lumière et de la paroi du vaisseau de l'artère et 
aide le médecin à évaluer les plaques d'athérosclérose. Les ultrasons sont capables 
d'identifier d'autres caractéristiques du vaisseau, telles que les endoprothèses 
implantées et les plaques d'athérome, comme la calcification. 
Cette information est analysée par l’envoi d’impulsions sonores à la paroi de la cuve 
depuis l’extrémité de l’imagerie du cathéter et la réception de l’écho. Les 
caractéristiques morphologiques de l’artère absorbent et renvoient le son différemment. 
Ces signaux s’affichent ensuite à l’écran pour l’interprétation. 

Avec des images d’angiographie, les analyses de la progression de la lésion peuvent 
être réalisées en comparant deux diamètres dans la zone d’intérêt. Généralement, ces 
diamètres sont sélectionnés depuis un emplacement de référence et l’emplacement 
avec le plus petit diamètre de lumière dans la zone ciblée. La réduction de ce diamètre 
est désignée par une sténose. L’utilisation de l’angiographie pour analyser les 
diamètres d’une projection unique peut s’avérer difficile au moment d’analyser les 
emplacements des lésions ou de la cible avec des lumières excentriques. L’IVUS 
permet de mieux analyser la lumière, y compris les lumières excentriques.  

Comparer la zone de lumière peut également offrir un moyen supplémentaire d’analyser 
la progression d’une lésion. Le Makoto® Système d’imagerie intravasculaire comparera 
deux zones à des emplacements différents pour fournir la lumière de la zone de 
sténose (AS). 

 

AS%   =  [(SurfaceLumièreDistal - SurfaceLumièreMinimum)/ SurfaceLumièreDistal] x 100 
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4.7 « Condition Display » (Affichage des conditions) 
 

 
Figure 4-27 : « Condition Display » (Affichage des conditions).  Ensemble de seuils un actif (fonctionnalités optionnelles 

SmartImaging™ activées) . 

Le système d’imagerie intravasculaire Makoto® est conçu comme un système 
d’imagerie bimodal.Le « Condition Display » (Affichage des conditions) est un affichage 
configurable destiné à aider l’utilisateur à identifier les segments des données 
d’imagerie qui dépassent, ou au contraire ne dépassent pas, des seuils spécifiés 
générés par les mesures automatiques par ultrasons et l’algorithme mxLCBI.  Le 
système est capable de stocker et d’alterner entre deux ensembles de seuils pour les 
mesures par image. Ces seuils peuvent être définis pour le pourcentage de charge 
plaque (percentage plaque burden) et pour le mxLCBI.  Le pourcentage de charge 
plaque est calculé comme expliqué à la section 10, et le mxLCBI est déterminé en 
fonction de la taille de la fenêtre configurée, comme expliqué à la section 10, centrée 
sur l’image. La configuration des seuils est décrite à la section 10.2.9. 
Les lignes d'affichage des conditions mxLCBI et PB% sont colorées lorsque les seuils, 
pour chaque coupe transversale, sont atteints.    
 
Par exemple, l’utilisateur peut configurer le seuil 1 pour révéler l’état « normal » ou 
acceptable des zones d’implantation du stent, en utilisant l’affichage des conditions 
pour pointer les régions du vaisseau, dérivées des mesures automatisées, où se 
trouvent des zones d’implantation du stent inacceptables ou moins souhaitables. 
. 
De même, l’utilisateur peut configurer le seuil 2 pour révéler les régions du vaisseau 
susceptibles de présenter un risque accru de progression de la maladie, basées sur les 

Les deux 
seuils 
dépassés 

Un seuil 
dépassé 

Aucun seuil 
dépassé  

Seuils 
programmés 
dans les 
réglages  
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valeurs mxLCBI ou la charge plaque accumulée, conformément à des recherches 
médicales pertinentes et reconnues. 
 

REMARQUE : Sélectionnez ou modifiez les valeurs de l’ensemble de seuils 
en accédant à la fenêtre « Scan Edit » (Modification des 
scans, voir Section 10.2) et en ajustant les paramètres. 

 
REMARQUE : Basculez entre l’ensemble de seuils 1 et 2 en cliquant avec le 

bouton droit sur l’affichage des conditions. 

 
 

4.8 Mesures échographiques automatisées (SmartImagingTM) 

 

 
Figure 4-28 : Vue « Measurement » (Mesure). Affichage de la surface : la surface EEM générée automatiquement est 
affichée en vert et la surface de la lumière en magenta. L’identification correspondante est superposée à l’affichage IVUS 
longitudinal. (fonctionnalités optionnelles SmartImaging™ activées). 

 
Le système d’imagerie intravasculaire Makoto® peut être configuré en option avec des 
fonctions d’évaluation automatique des images, SmartImaging™, afin de faciliter les 
tâches courantes de l’utilisateur. SmartImaging™ est un ensemble de fonctionnalités 
qui identifie automatiquement les contours de la lumière et du vaisseau, ce qui permet 
de mesurer l’aire, le diamètre et la charge plaque. À la fin de l’acquisition des images, le 
système tente d’évaluer chaque image IVUS enregistrée afin de localiser la limite de la 
lumière et la membrane élastique externe (EEM) du vaisseau.  

4.8.1 Révision des résultats 
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AVERTISSEMEN

T 

L'utilisateur doit examiner et évaluer les performances des 
fonctions d'aide à la mesure avant d’établir un diagnostic et de 
choisir une thérapie. 

 

 
AVERTISSEMEN

T 

Dans la mesure du possible, le système d’aide à la mesure 
alertera l’utilisateur sur les segments susceptibles de nécessiter 
une interprétation ou une modification supplémentaire. 

 
 
Dans la zone de révision des résultats, certains segments peuvent être mis en évidence 
lorsque la fonctionnalité n’est pas certaine de la mesure affichée. Il peut donc être 
nécessaire d’accepter, de corriger ou de supprimer ces mesures. Cliquez sur l’action 
souhaitée dans la zone de mesure située dans la vue transversale. Les segments à 
réviser sont représentés par des barres verticales dorées dans la vue graphique 
longitudinale et par des cercles dorés dans la vue transversale. 
Une fois modifiées, les mesures seront considérées comme révisées et acceptées. Les 
mesures d’origine peuvent être restaurées. Voir la section 10.5.2.1 relative à la 
réalisation des mesures de zone. 
 

REMARQUE : La visibilité des mesures SmartImaging™ sur l’IVUS 
transverse ou longitudinal peut être rapidement ajustée en 
effectuant un clic droit à la souris sur l’IVUS longitudinal ou 
transverse pour modifier le paramètre approprié, ou en 
accédant à la fenêtre « Scan Edit » (Modification du scan) 
pour régler ce paramètre. 

  
REMARQUE : SmartImaging™ utilisé avec le cathéter Infraredx Clarispro® 

HD-IVUS peut nécessiter une activation manuelle. 

 
L’emplacement de la limite de la lumière identifiée et de l’EEM sera automatiquement 
affiché dans l’IVUS longitudinal. 
Les zones créées par ces mesures sont présentées à l’utilisateur sous forme d’une 
silhouette représentant un vaisseau, afin d’améliorer la visualisation et l’interprétation 
des données d’imagerie médicale. 
Les zones mesurées seront également évaluées automatiquement pour déterminer le 
diamètre luminal minimal et le diamètre de l’EEM à chaque image. Ces diamètres ainsi 
évalués seront présentés à l’utilisateur sous forme d’une silhouette représentant le 
vaisseau, afin d’améliorer la visualisation et l’interprétation des données d’imagerie 
médicale.
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5 Stockage, déplacement et positionnement du 
Makoto® Système d’imagerie intravasculaire 

 

5.1 Déplacement du Makoto® Système d’imagerie intravasculaire  
Le Makoto® Système d’imagerie intravasculaire est équipé de deux roulettes 
verrouillables à l’arrière du système et deux roulettes verrouillables directionnelles à 
l’avant du système. 

  
Figure 5-1 : Makoto® Système d’imagerie intravasculaire. 

  

Débloquez les verrous de toutes les roulettes pour déplacer les manettes des roulettes 
vers le haut pour déplacer, tourner ou manœuvrer le système dans des espaces réduits. 
 

Remarque : Bloquez les roulettes à verrou directionnel à l’avant du 
système pour faciliter le transit sur des distances plus 
longues. 

 

Roulettes à 
frein de 
position 

 

 Roulettes à 
frein de 

direction 
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Remarque : Pendant le transit, positionnez les moniteurs en ligne 
avec la base du Makoto® Système d’imagerie 
intravasculaire pour augmenter la visibilité. 

5.2 Positionnement pour utilisation 
 

 
AVERTISSEMENT 

NE positionnez PAS l’opérateur de la console mobile de 
Makoto® Système d’imagerie intravasculaire entre le système et 
un autre équipement en mouvement dans le laboratoire de 
cathétérisme.  

 

 
AVERTISSEMENT 

NE positionnez PAS le Makoto® Système d’imagerie 
intravasculaire avec les verrous de roulette bloqués dans 
l’amplitude normale de mouvement de pièces du système de 
radiographie ou d’autres équipements du laboratoire de 
cathétérisme pendant son utilisation. 

 

Le Makoto® Système d’imagerie intravasculaire est positionné pour utilisation à 
proximité du pied de la table d’opération ou à l’autre bout de la table d’opération par le 
médecin, à droite du système d’opération de radiographie. 

Une fois la position souhaitée du système obtenue, engagez les roulettes verrouillables 
de position sur le système. 

 

ATTENTION 

NE repositionnez PAS le Makoto® Système d’imagerie 
intravasculaire de manière à entraver l’accès à la prise 
électrique. 

 

Remarque : Réglez la position d’affichage du médecin sur le Makoto® 
Système d’imagerie intravasculaire pour optimiser la visibilité de 
l’image pendant son utilisation. 

 

 

Remarque : Pour éviter tout mouvement accidentel de la console Makoto®, 
engagez les roulettes verrouillables de position à l’arrière de 
la console. 
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5.3 Stockage avant utilisation 
 

ATTENTION 

Ces instructions NE sont PAS pour un stockage à long terme 
du Makoto® Système d’imagerie intravasculaire. Veuillez 
contacter le service client d’Infraredx ou votre fournisseur de 
service local pour être guidé sur la manière de préparer le 
système pour un stockage à long terme. 

 

Lorsqu’il n’est pas en fonctionnement, le Makoto® Système d’imagerie intravasculaire 
doit être configuré afin de réduire le risque d’endommagement du système.  

1. Positionnez le contrôleur Makoto® fermement dans le 
support à l’arrière du système. 

2. Enroulez le cordon du contrôleur Makoto® soigneusement 
et accrochez le crochet supérieur au panneau arrière 
du système. 

3. Enroulez le cordon d’alimentation soigneusement et 
accrochez le crochet inférieur à l’arrière du système. 

4. Engagez les roulettes verrouillables à l’arrière du système. 
5. Tournez les moniteurs pour les aligner avec la base du 

système. 

En plus des étapes précédentes, sélectionnez un emplacement de stockage facile 
d’accès situé dans une zone de faible trafic où le risque d’impact avec d’autres 
équipements en mouvement (lits, brancards...) est réduit. L’emplacement doit répondre 
aux exigences environnementales et physiques définies dans la section 17 de ce manuel. 
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6 Démarrage du Makoto® Système d’imagerie 
intravasculaire 

6.1 Alimentation On  
 

 
AVERTISSEMENT 

Assurez-vous que les câbles provenant du Makoto® Système 
d’imagerie intravasculaire ou y étant branchés sont bien à plat 
sur le sol. 

 
 

1. Retirez le cordon d’alimentation à l’arrière du système. Laissez le reste du 
cordon tomber à plat sur le sol tout en tenant la prise. 
 

2. Branchez le système à une prise de terre accessible facilement. 

 
Figure 6-1 : panneau latéral et bouton d’alimentation Makoto® Système d’imagerie intravasculaire sélectionnés. 

3. Allumez le système en appuyant et en relâchant le bouton situé sur le côté de la 
console. Cette action alimentera la console du système Makoto® et du contrôleur 
Makoto®. 

 

Après la mise sous tension du système et le chargement du logiciel, l'écran de 
connexion du Makoto® est présenté à l'opérateur. 

Bouton 
d’alimentation 
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ATTENTION 

 
Si la prise du câble d’alimentation appropriée à la région 
d’utilisation n’est pas équipée d’une mise à la terre, alors 
raccordez un câble de mise à la terre au goujon de terre 
équipotentiel situé à l’arrière du Makoto® Système d’imagerie 
intravasculaire dans la partie inférieure. 
 
 

 
Figure 6-2 : goujon de mise à la terre équipotentiel 
situé à l’arrière du Makoto® Système d’imagerie 
intravasculaire à l’extrémité droite de la partie 
inférieure. 

 
 

ATTENTION 

Pendant le démarrage, la prise de connexion du cathéter du 
contrôleur Makoto® pivotera automatiquement. Si un cathéter 
est raccordé pendant le démarrage du système, assurez-vous 
que le cathéter a été retiré du patient 

 

Remarque : Si le Makoto® Système d’imagerie intravasculaire est allumé et 
n’est pas en position « READY » (PRÊT), lorsque le système 
l’exige, veuillez utiliser les contrôles de mouvement distal pour 
faire avancer l’imagerie distale jusqu’à ce que vous atteigniez la 
position « READY » (PRÊT). 
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6.2 Alimentation Off  
 

 
AVERTISSEMENT 

Si à tout moment, le bouton « STOP » (ARRÊT), , situé sur 
le contrôleur du Makoto® n’arrête pas le mouvement du cathéter, 
débranchez immédiatement le Makoto® Système d’imagerie 
intravasculaire. 

 

Pour éteindre le Makoto® Système d’imagerie intravasculaire, appuyez et relâchez le 
bouton d’alimentation situé sur le côté droit de la console. 

 

ATTENTION 

Si une brève pression du bouton d’alimentation n’éteint pas le 
système, laissez le bouton d’alimentation enfoncé (~5 
secondes) jusqu’à ce que le système s’arrête. 

 

 

6.3 Connexion de l’utilisateur 
 
Le système d’imagerie Makoto®  peut être configuré pour prendre en charge 
différents profils d'utilisateurs afin de contrôler l'accessibilité de certaines 
fonctionnalités, de certains paramètres ou de certaines données patient. 
 
Consultez la section 14.12 Gestion des utilisateurs pour plus d'informations sur les 
profils d'utilisateurs, les autorisations et les restrictions. 
 

 
Figure 6-3. Écran de connexion de l'utilisateur du système d’imagerie Makoto®  
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6.3.1 Connexion standard 
Lorsque le système est allumé, une combinaison valide de nom d'utilisateur et de 
mot de passe sera demandée pour enregistrer l'accès au système et définir les 
autorisations appropriées et l'accès aux données enregistrées sur le système.  

 

6.3.2 Saut ou connexion anonyme 
Dans certains cas d'intervention urgente ou si les utilisateurs ont oublié leurs 
identifiants Makoto®, il est toujours possible de faire fonctionner le système et 
d'obtenir des données. Lorsqu'un utilisateur s'est connecté au système d’imagerie 
Makoto®  sans utiliser un nom d'utilisateur ou un mot de passe valide, les 
caractéristiques et les fonctions du système sont limitées à celles qui sont 
essentielles pour effectuer une procédure. 

6.3.3 Activation du clavier virtuel 
Dans certaines situations ou configurations du système d’imagerie Makoto®, il peut 
être préférable de désactiver le clavier virtuel à l'écran. Touchez l'icône du clavier 
pour activer ou désactiver le clavier. La désactivation du clavier peut limiter 
certaines fonctions d'annotation et de recherche qui nécessitent une saisie au 
clavier si aucun clavier physique n'est connecté. 
 

6.4 Déconnexion de l'utilisateur  
 
Le système d’imagerie Makoto® offre la possibilité aux utilisateurs de se 
déconnecter de la séance en cours sans éteindre le système. 
 
L'utilisateur peut se déconnecter du système en touchant ou en cliquant sur l'icône « 
Settings » (Paramètres), puis en sélectionnant « Log Out Username » (Déconnexion 
nom d'utilisateur). 
Si le système reste inactif au-delà de la limite de temps configurée, le système se 
déconnecte automatiquement si aucun cathéter n'est connecté. 

 

6.5 « Help » (Aide) 

 
Une version électronique de ce manuel est disponible pour consultation dans une 
fenêtre en touchant le bouton « Help » (Aide) depuis l’écran de connexion utilisateur 
du système. 
 

REMARQUE : Une fois connecté, la version électronique de ce document est 
également accessible en touchant ou en cliquant sur l'icône « 
Settings » (Paramètres) en haut à droite de l'écran, voir 
section 13.1 « Accès au guide d'utilisation électronique ». 
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7 Configuration des informations du patient et de 
la procédure 

Dans le mode d’acquisition pendant la phase de configuration, l’utilisateur peur entrer 
des informations sur le patient et la procédure afin d’archiver et de faciliter la 
récupération dans le cadre d’une révision ultérieure. Ces informations peuvent être 
insérées au début de la procédure ou à chaque fois avant la fin de la procédure. 
 

 
Figure 7-1 : phase de configuration du mode d’acquisition dans les contrôles principaux sélectionnés. 

Quatre éléments d’identification du patient peuvent être entrés pour chaque procédure. 
Il s’agit du nom du patient, de son numéro d’identification, de son genre et de sa date 
de naissance. Les champs de données configurés comme « requis » doivent être 
complétés pour fermer la procédure afin de l’examiner ou de l’archiver par la suite. 

 Nom du patient Le nom du patient peut être inséré dans le format 
suivant : nom, prénom, et initiale du deuxième prénom. 

 Identification du patient Le numéro médical enregistré ou le numéro de fichier 
du patient. 

 Genre Le Makoto® Système d’imagerie intravasculaire 
propose trois options de genre différentes pour aider à 
décrire le patient. 

 Date de naissance Le jour, mois et année du patient peuvent être 
spécifiés. 

Remarque : Utilisez l’option de genre « Autre » pour l’entrée de patients 
anonymes. 

 

Quatre autres champs peuvent être utilisés pour identifier plus en détail la procédure :  

Paramètres 

« Clear » 
(Effacer) 

Continuer 
 LCBI 

Source de liste 
de patients 
prévus 
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 Identification de procédure Le numéro ou code utilisé pour identifier cette 
procédure. 

 Identification d’adhésion Il s’agit d’une valeur d’identification de la procédure 
souvent assignée au moment de l’enregistrement du 
patient pour la procédure et qui peut être utilisée par 
le PACS (système d’archivage et de transmission 
d’images) afin de vérifier les données transférées. 
Cette valeur est généralement insérée 
automatiquement lorsque les paramètres de liste de 
travail de modalité sont utilisés. 

 Médecin Le nom du médecin chargé de la procédure. 

 Groupe de cathéter Le numéro de groupe construit du cathéter utilisé 
pendant cette procédure d’imagerie.  

 

ATTENTION 

Assurez-vous de l’insertion correcte des informations du patient 
pour éviter un mauvais étiquetage des données ou une perte 
des données de la procédure. 

 

REMARQUE : Les champs requis pour l’identification du patient et de la 
procédure peuvent être configurés dans les paramètres, voir 
section 14.7. 

 

Remarque : Insérez le numéro de groupe du cathéter pour acquérir des 
données pour insérer automatiquement le numéro de groupe du 
cathéter dans chaque fichier numérisé lorsqu’il est enregistré. 
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7.1 Insertion manuelle des informations du patient et de la procédure 

L’insertion manuelle des informations du patient et de la procédure peut être effectuée 
avec le clavier du logiciel à l’écran.  

Appuyez sur « Clear » (Effacer)  pour supprimer les données du patient et de la 
procédure dans les champs de configuration puis recommencez. 

 

Remarque : Les champs d’information peuvent être complétés avant de 
fermer la procédure lorsque le système n’est pas en train 
d’acquérir activement des données d’image. 

 

7.2 Insertion semi-automatique des informations du patient et de la 
procédure 

Les données du patient peuvent être directement insérées dans les champs 
fournis tels que décrits ci-dessus. Pour améliorer la cohérence de l’insertion pour 
les patients revenus ou prévus, il est possible de sélectionner les informations 
dans le répertoire local ou la liste des patients programmés (liste de travail). 

Remarque : Appuyez sur les titres de colonne dans la liste de patients 
prévus pour réduire la liste de différentes manières. 

 

Remarque : Tapez le texte dans le filtre pour réduire la liste aux noms et 
identifications du patient allant avec votre insertion. Effacez le 
texte ou appuyez sur effacer pour revenir à la liste complète. 

 

Remarque : La liste des patients locaux apparaît par défaut. L’option 
« Worklist » apparaît lorsque le système est configuré sur 
connexion de la liste de travail de modalité. 

 

Remarque : Faire un choix dans la liste effacera les données 
correspondantes dans les champs Patient et Procédure. 

 

7.2.1 Listing des patients locaux 
Le système chargera automatiquement les informations du patient des procédures 
enregistrées précédemment du système dans le listing des patients prévus.  

Cliquez sur le nom souhaité dans la liste pour compléter la configuration du nom 
du patient, de l’identification du patient, du genre et de la date de naissance.  

Les champs de la dernière procédure nécessiteront une insertion manuelle. 
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Figure 7-2 : phase de configuration avec contrôle de sélection pour la source du listing des patients prévus sélectionnée. 

 

7.2.2 Liste de travail de modalité 
Si le système a été configuré pour charger les informations de la liste de travail de 
modalité du système d’information de l’hôpital (HIS), alors le contenu du listing 
des patients prévus peut être remplacé par un listing des patients locaux dans la 
liste de travail de modalité récupérée dans le HIS. 

Consultez la section 14.5 pour configurer les paramètres de connexion de la liste 
de travail de modalité. 

Le système récupèrera automatiquement tous les détails du patient et de la 
procédure pour l’angiographie, « XA », le type de modalité pour la date 
d’aujourd’hui et le rend disponible pour la sélection sur le système. 

Cliquez sur le nom souhaité dans la liste pour compléter la configuration du nom 
du patient, de l’identification du patient, du genre et de la date de naissance et les 
informations de procédures rendues disponibles par le HIS, tout comme 
l’identification d’adhésion.  

Les champs de procédure restants devront être saisis manuellement. 

 

Remarque : Pour actualiser les saisies de la liste de travail de modalité 

affichées, alternez entre les options « Local », , 

et « Worklist » (Liste de travail) . 
 

 

7.3 Effacer les informations du patient et de la procédure 
Pour effacer les informations du patient et de la procédure et recommencer, cliquez sur 

« Clear » (Effacer) . 

Cette action n’effacera pas les données numérisées de la procédure active. 

 

Source de liste de 
patients prévus 
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7.4 Passage à la phase suivante  
Après avoir inséré les données du patient et de la procédure, pour aller à la phase 
« Prime » (Amorçage) du mode Acquisition, cliquez sur « Continue » (Continuer) 

. 

 

Remarque : Utilisez le contrôle de progression pour modifier les phases ; 
appuyez sur la phase de votre choix pour passer les phases de 
la procédure. 

 

 
Remarque : 

Avec un cathéter connecté, en pressant sur le bouton « Mark » 

(Marque), , le contrôleur Makoto® avancera immédiatement 
à la phase « Prime » (Amorçage). 

 

 

Remarque : Avec un cathéter connecté, en pressant le bouton « Live IVUS » 

(IVUS en direct), , le contrôleur Makoto® avancera 
immédiatement à la phase « Prime » (Amorçage). 

 

Remarque : Avec un cathéter connecté, en pressant le bouton « Pullback » 

(Retrait), , le contrôleur Makoto® avancera immédiatement 
à la phase « Scan ». 
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8 Amorce du cathéter et préparation du contrôleur 
Makoto®

 pour utilisation  
 

La phase suivante de la procédure commence avec l’amorce du cathéter. En parallèle, 
le contrôleur Makoto® peut être placé dans le champ stérile pour utilisation. La 
préparation de l’imagerie s’achève avec la connexion du cathéter au contrôleur et en 
évaluant la préparation du cathéter. 

8.1 Amorce du cathéter 
 

 
AVERTISSEMENT 

Le cathéter stérile doit être amorcé et préparé conformément au 
document contenant les instructions d’utilisation inclus dans 
l’emballage du cathéter. 

 

  
Figure 8-1 : le guidage d’amorce à l’écran proposé dans la phase « Prime » (Amorçage) du mode Acquisition. 

 
Le Makoto® Système d’imagerie intravasculaire proposera un guidage à l’écran dans 
les étapes principales pour amorcer un cathéter raccordé au contrôleur Makoto®. 
 
Ces étapes sont prévues pour illustrer et augmenter les instructions fournies avec le 
cathéter. Cela ne remplace pas la nécessité pour l’utilisateur d’être formé, et de lire et 
de comprendre les instructions d’utilisation fournies avec le cathéter. 

À l’aide des illustrations à l’écran, des illustrations fournies avec le cathéter et des 
instructions écrites d’utilisation du cathéter, l’opérateur stérile doit amorcer le cathéter. 
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8.2 Préparation du contrôleur Makoto® 
Le contrôleur Makoto® doit être placé dans une barrière stérile du contrôleur Makoto® 
avant d’être placé sur la table d’opération.  

Veuillez remarquer que les instructions suivantes nécessitent la participation d’un 
opérateur stérile et non stérile pour appliquer la barrière stérile et placer le contrôleur 
Makoto® dans le champ d’opération : 

 

 
AVERTISSEMENT 

Si la barrière stérile du contrôleur Makoto® est endommagée, 
remplacez-la par une nouvelle barrière stérile. 

 

 
AVERTISSEMENT 

Gardez la main de l’opérateur en dehors du couvercle bleu de la 
barrière stérile.  

 

 
AVERTISSEMENT 

 
Positionnez le contrôleur Makoto® sur un emplacement stable 
de la table d’opération. NE placez PAS le contrôleur à proximité 
des bords de la table. 
 

 

 
AVERTISSEMENT 

La table d’opération doit être maintenue à niveau pendant 
l’utilisation du système Makoto® ou à tout moment lorsque le 
contrôleur du système Makoto® se trouve dans le champ stérile. 
N’utilisez PAS les commandes d’inclinaison ou de déplacement 
de la table, si ces dernières sont disponibles. 

 

 
AVERTISSEMENT 

Assurez-vous que le cordon détendu est fourni dans le champ 
stérile pour s’adapter aux mouvements de la table, de la console 
ou du patient pour réduire les risques de mouvements 
inattendus du contrôleur Makoto®. 
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AVERTISSEMENT 

Les articles stériles NE doivent PAS être en contact avec le 
contrôleur Makoto® jusqu’à l’ouverture de la prise du cathéter de 
la barrière stérile du contrôleur Makoto®. 

 

 
AVERTISSEMENT 

Ne permettez pas au côté du couvercle du joint de la barrière 
stérile qui a été en contact avec la prise du contrôleur Makoto® 
d’être en contact avec l’opérateur stérile. 

 

Pour positionner le contrôleur Makoto® dans le champ stérile, effectuez les étapes 
suivantes : 

 

1. L’opérateur non stérile retire la barrière stérile de la boîte du cathéter. 
 

2. L’opérateur non stérile ouvre le package contenant la barrière stérile du 
contrôleur Makoto®. 
 

3. L’opérateur stérile retire la barrière stérile du contrôleur Makoto® de son 
emballage, et déplie les deux petits plis de la barrière qui cachent le joint blanc et 
le couvercle en plastique bleu. 
 

4. L'opérateur non stérile retire le contrôleur Makoto® du support de stockage, qui 
se trouve en dehors du champ stérile. 
 

5. L’opérateur non stérile maintient le contrôleur Makoto® parallèle au sol dans les 
airs à proximité du champ stérile tout en tenant la poignée à l’arrière du 
contrôleur. 
 

6. L’opérateur stérile insère sa main droite dans le pli de la barrière stérile du 
contrôleur Makoto® indiqué par une main et une flèche. La barrière doit être 
orientée de manière à ce que le couvercle bleu de la prise soit aligné avec la 
partie supérieure du contrôleur Makoto®. 
 

7. La main gauche est insérée dans le pli de l’autre côté de la barrière stérile du 
contrôleur Makoto® également indiqué par une main et une flèche. 
 

8. L’opérateur stérile maintient la barrière stérile du contrôleur Makoto® ouverte. 
 

9. L’opérateur non stérile envoie le contrôleur Makoto® à l’opérateur stérile en 
plaçant le contrôleur dans la barrière stérile du contrôleur Makoto® ouverte. 
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10. L’opérateur stérile saisit le contrôleur Makoto® jusqu’à la barrière stérile du 
contrôleur Makoto® par les poignées sur le dessus du contrôleur, supportant tout 
son poids. 
 

11. L’opérateur non stérile relâche ensuite le contrôleur puis tient les bords de 
l’ouverture de la barrière stérile du contrôleur Makoto® indiqués par des flèches 
et tire la barrière pour couvrir le câble ombilical du contrôleur Makoto®. 
 

12. L’opérateur stérile place le contrôleur Makoto® fermé sur la table d’opération. 
 

13. L’opérateur stérile aligne le joint blanc de la barrière stérile du contrôleur 
Makoto® avec la prise du contrôleur Makoto® et raccorde le joint de la barrière à 
la prise.  
 

14. L’opérateur non stérile doit raccorder la position du cordon pour éviter que la 
partie ensachée sorte de la zone de procédure stérile pendant l’utilisation. 
 
 
Le contrôleur Makoto® est désormais prêt pour la connexion du cathéter. 
 

ATTENTION 

Assurez-vous que le joint blanc est fermement raccordé à la 
prise du contrôleur Makoto®. Le matériel de la barrière ne doit 
pas gêner l’ouverture. Si cela est appliqué correctement, il doit y 
avoir un espace entre le joint blanc et la surface avant du 
contrôleur. 
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8.3 Connexion du cathéter 
 

 
AVERTISSEMENT 

Le cathéter stérile doit être manipulé et préparé conformément 
au document contenant les instructions d’utilisation inclus dans 
l’emballage du cathéter. 

 

 
AVERTISSEMENT 

Ne touchez pas le dessous du couvercle bleu car il pourrait avoir 
été en contact avec la prise du contrôleur Makoto® qui n’est pas 
stérile. 

 

Les instructions du cathéter fournies dans ce manuel sont uniquement pour les 
directives générales. Suivez toujours les instructions pour l’utilisation de la 
documentation fournie avec chaque cathéter Infraredx. 

Le cathéter doit être connecté au contrôleur Makoto® par un opérateur stérile. 

 

ATTENTION 

Le contrôleur Makoto® doit être positionné sur la table du 
patient de manière à ce qu’il y ait un espace suffisant pour que 
la connexion du cathéter soit disponible et que la prise du 
cathéter du contrôleur Makoto® ne soit pas entravée. 

 

ATTENTION 

Ne contaminez pas les faces en fibre du cathéter ou du 
contrôleur Makoto® pendant la connexion. 

 

1. Confirmez que le joint blanc de la barrière du contrôleur Makoto® stérile est 
raccordé à la prise du contrôleur Makoto®. 
 

2. Retirez le couvercle bleu de la barrière du contrôleur Makoto® stérile le long des 
lignes perforées et placez-le hors du champ stérile. 
 

3. Confirmez que le contrôleur Makoto® est en position PRÊT comme indiqué par le 
message « LOAD » sur l’écran LCD situé sur la partie supérieure du contrôleur. 
 

4. Alignez la poignée du cathéter avec le côté coloré vers le haut.  

 
5. Insérez la poignée du cathéter dans la prise du cathéter du contrôleur Makoto®. 
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6. Tournez la poignée du cathéter dans le sens des aiguilles d’une montre jusqu’à 

ce que l’écran LCD du contrôleur indique que le cathéter est correctement 
connecté en observant le message « READY » (PRÊT).  
 

 
Remarque : Si le contrôleur Makoto® localise une connexion partielle du 

cathéter, alors les instructions seront indiquées sur l’écran LCD 
ou « Voir l’écran » sera indiqué sur l’écran LCD du contrôleur et 
des indications supplémentaires détaillées s’afficheront sur 
l’écran du système Makoto®. 

 

8.4 Test du cathéter 
Après l’amorce du cathéter comme indiqué dans les instructions fournies avec le 
cathéter et la connexion du cathéter au contrôleur Makoto®, la performance du cathéter 
peut être vérifiée avec la fonction « Live IVUS » dans le système.  

Amorcez le cathéter avec une solution saline de 0,5 mL supplémentaire puis appuyez 

sur « Live IVUS » (IVUS en direct), , dans le contrôleur Makoto® pour démarrer 
l’imagerie. Si une image IVUS apparaît sous forme de cercles concentriques et que la 

clarté de l’image est satisfaisante, alors appuyez sur « STOP » (ARRÊT), , sur 

l’écran ou appuyez sur « STOP » (ARRÊT), , dans le contrôleur Makoto®. 

 

Remarque : Si la qualité de l’image n’est pas satisfaisante ou est sombre, 
continuez de rincer le cathéter avec la seringue d’amorçage. 

 

Procédez à la phase de numérisation en appuyant sur « Scan », , dans le 
contrôle de progression en haut de l’écran.  

 

Remarque : L’analyse de la qualité du cathéter principal peut être effectuée 
sur les écrans de phase « Prime » (Amorçage) ou « Scan ». 

 

Remarque : Pendant la rotation du cathéter et la mise à jour de l’image, 

appuyez sur le bouton « Mark » (Marque), , du contrôleur 
Makoto® pour passer à la phase de numérisation. 
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Remarque : 

Appuyez sur le bouton « Pullback » (Retrait), , de l’écran 
du contrôleur Makoto® pour passer le système à la phase de 
numérisation et démarrer une acquisition de retrait automatique.  
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9 Acquisition des images numérisées 
intravasculaires Makoto® 

 

 
AVERTISSEMENT 

Consultez les instructions d’utilisation du cathéter pour le 
guidage du chargement du cathéter sur le fil-guide, le cathéter 
dans le cathéter de guidage et le passage du cathéter dans 
l’artère. 

 
Après l’analyse de la qualité du cathéter principal, le cathéter doit être positionné sur le 
fil-guide et passé comme indiqué dans les instructions d’utilisation du cathéter. 

Il y a deux types d’acquisitions de données pouvant être réalisées avec le Makoto® 
Système d’imagerie intravasculaire : Acquisition du Live IVUS et du retrait automatique.  

L’acquisition du Live IVUS génèrera des images IVUS sans chemogram. Un retrait 
automatique génèrera des images IVUS avec un chemogram. 

 

9.1 Acquisition du Live IVUS 
Durant l’acquisition de données Live IVUS, le système démarrera la rotation de 
l’imagerie du cathéter sans démarrer le retrait automatique (translation proximale) 
de l’imagerie. Une image IVUS transversale apparaîtra à l’écran et sera mise à jour 
pendant l’activation du Live IVUS.  

 

Figure 9-1 : Mode Acquisition du Makoto® pendant un balayage IVUS en direct non enregistré, avec les fonctions de 
contrôle à distance activées 

 

« Mark » 
(Marque) 

Enregistrement 

Arrêt 

Vitesse de 
translation 
actuelle 

Position 
PRÊT 

Retrait 
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Remarque : Un scan Live IVUS ne sera pas sauvegardé dans la mémoire du 
système sauf si l’utilisateur décide de l’enregistrer. 

 
Remarque : Live IVUS produira seulement une image IVUS ; aucune donnée 

NIRS ne s’affichera ou ne sera générée sur le chemogram. 

 
Remarque : Live IVUS produira une image IVUS transversale en direct. 

L’image IVUS apparaîtra également sur l’écran de l’IVUS 
longitudinale pendant un scan Live IVUS enregistré. 

 

9.1.1 Démarrage du Live IVUS 

Appuyez sur le bouton Live IVUS, , du contrôleur Makoto® pour activer 
l’imagerie IVUS en temps réel. Le statut du mode imagerie sur l’écran LCD sera 
mis à jour pour afficher « LIVE » et les informations d’emplacement sont 
imprimées avec un texte blanc. 

 

  
Figure 9-2 : le contrôleur Makoto® affiche l’acquisition Live IVUS non enregistrée à la position PRÊT (gauche) et à la 

position 0,0 mm (droite). 

REMARQUE : Si les fonctions de contrôle à distance sont activées, 
l'imagerie IVUS en direct peut être lancée en touchant l'icône 

« Live IVUS » (IVUS en direct), , sur le moniteur. Voir la 
section 14.10.6 Activer le contrôle à distance pour activer les 
fonctions. 

 
 
 
 
 

9.1.2 Translation du Live IVUS 
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WARNING 

Des situations dangereuses, y compris des blessures au patient 
ou à l'opérateur, peuvent se produire si les avertissements 
affichés sont ignorés. 

 

WARNING 

Le mouvement linéaire du contrôleur s'arrête lorsqu'une force 
excessive est rencontrée. 

Vérifiez que le cathéter ne présente pas de pliures, de coudes 
aigus ou de dommages et résolvez-les avant de continuer. 

Appuyez sur « STOP » (ARRÊT), , sur le contrôleur 
Makoto® et suivez les instructions à l'écran pour résoudre le 
problème. 
 
N’utilisez PAS les fonctions de translation à une étape pour 
régler le problème d’entortillement ou de déformation. La gaine 
du cathéter pourrait être endommagée ou le patient blessé. 

 
 

 

 

 
 

Figure 9-3 : commandes de base de translation de l’imagerie, différentes configurations (dessus, dessous) peuvent 
exister. 

 

Tout en effectuant un balayage Live IVUS, utilisez les commandes de 
mouvement distal et proximal du contrôleur Makoto® pour ajuster la position de 
l'image actuelle dans le vaisseau. 
Une pression prolongée sur les commandes de mouvement lent effectuera une 
translation dans la direction souhaitée à une vitesse de 2,0 mm/s. Une pression 
rapide effectuera une translation dans la direction souhaitée d’une distance fixe 
de 0,1 mm. 

Une pression prolongée sur les commandes de mouvement rapide effectuera 
une translation dans la direction souhaitée à une vitesse de 10,0 mm/s. Une 

Proximal lent 

Proximal rapide 

Distal lent 

Distal rapide 

Distal rapide 

Distal lent Proximal lent 

Proximal 
rapide 
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pression rapide effectuera une translation dans la direction souhaitée d’une 
distance fixe de 0,5 mm. 

 

Remarque : Pendant l’imagerie active en position PRÊT, la translation dans 
la direction proximale résultera en un déplacement de la position 
de l’image dans la gamme d’imagerie continue de 0 mm à 150 
mm. 

Le retour à la position PRÊT peut se produire uniquement 
lorsque le système n’acquiert pas d’image. 

 

Remarque : Pendant que vous procédez activement à l’imagerie, la 
translation proximale ET distale se produira uniquement dans 
une gamme de 0 mm à 150 mm. La translation s’arrêtera 
automatiquement lorsque les emplacements extrêmes sont 
atteints et l’imagerie poursuivra. 

 

Remarque : Pendant qu’à la position 0 mm et aucune imagerie, en appuyant 

sur les commandes de l’emplacement distal,  ou 

, replacera le contrôleur et l’imagerie du cathéter en 
position PRÊT. 

 

9.1.3 Enregistrement d’une image Live IVUS 
Pendant que vous effectuez un scan Live IVUS non enregistré, une image simple 
peut être sauvegardée pour alimenter la procédure. Cette image peut être 
sauvegardée, vérifiée, mesurée, ou supprimée. 

Lors d’un scan Live IVUS, appuyez sur le bouton « Mark » (Marque) du contrôleur 

Makoto®, , ou appuyez sur la commande « Mark » (Marque), , de l’écran 
du système Makoto® pour ajouter un signet à l’image. Cette image sera enregistrée 
comme un scan d’image simple.  

 

9.1.4 Enregistrement d’un scan Live IVUS 
Un ensemble d’images de Live IVUS peut être enregistré en un seul fichier numérisé.  
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Figure 9-4 : Mode Acquisition Makoto® pendant un scan Live IVUS enregistré avec la télécommande activée. 

Appuyez sur le bouton Live IVUS du contrôleur Makoto®, , ou appuyez sur 

« Record » (Enregistrer) , sur l’écran du système Makoto® à proximité de 
l’image IVUS transversale pour activer l’enregistrement. 

Appuyez sur le bouton Live IVUS du contrôleur Makoto®, , ou appuyez sur 

Enregistrer, , toujours sur l’écran du système Makoto® pour arrêter 
l’enregistrement de données uniquement. Le cathéter poursuivra sa rotation et 
l’image IVUS transversale poursuivra sa mise à jour.  

   
Figure 9-5 : Écran LCD du contrôleur Makoto® avec cathéter d'imagerie IVUS+NIRS connecté pendant le processus de 
transition du début du Live IVUS non enregistré sur READY (PRÊT) (gauche) à l’enregistrement, puis de la translation 
proximale et stationnaire du Live IVUS (milieu) à la remise à zéro, et à la translation proximale pendant 
l’enregistrement (droite). Remarquez l’apparition de l’icône d’enregistrement pendant le Live IVUS enregistré.  
Lorsque la translation est effectuée pendant le Live IVUS enregistré une barre pleine apparaît où l’enregistrement 
dans cette acquisition a déjà été effectué depuis la dernière marque (milieu et droite), tandis que l’enregistrement 
préalable à la dernière marque est une barre vide (droite). 

Pendant la translation du Live IVUS, l’emplacement relatif, réel, et les indicateurs de 
vitesse de la translation seront mis à jour. 
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Remarque : Appuyez sur le bouton « STOP » (ARRÊT) du contrôleur 

Makoto®,  ou encore appuyez sur « STOP » (ARRÊT) 

 sur l’écran du système Makoto® pour arrêter la rotation et 
le mouvement du cathéter ET terminer l’enregistrement.  

 

Remarque : Appuyez sur le bouton « Pullback » (Retrait) du contrôleur 

Makoto®, , pour terminer l’enregistrement du Live IVUS en 
cours et démarrer un nouveau scan de retrait automatique dans 
la configuration du taux de retrait en cours. Les scans de retrait 
automatique sont toujours enregistrés. 

 

Remarque : Des marques peuvent être placées dans le fichier numérisé et 
des mesures IVUS transversales peuvent être réalisées dans les 
images d’un scan Live IVUS enregistré pour mieux alimenter la 
procédure. 

 

9.1.5 Marquer et remettre à zéro en Live IVUS 
Pendant l’acquisition Live IVUS enregistrée, des marques peuvent être placées et 
consultées grâce au bouton « Mark » (Marque) du contrôleur ou à l’icône « Mark » 
(Marque) à l’écran. 
Pendant l’acquisition Live IVUS non enregistrée, des marques peuvent être placées et 
consultées en enregistrement image par image grâce au bouton « Mark » (Marque) du 
contrôleur ou à l’icône « Mark » (Marque) à l’écran. 
Ajouter une marque pendant l’acquisition Live IVUS réinitialisera l’affichage de la 
distance parcourue à 0,0 mm. 

 

9.1.6 Arrêt du Live IVUS 
Un scan Live IVUS peut être supprimé de deux manières :  

a. Appuyez sur le bouton STOP, , du contrôleur Makoto® ou appuyez 

sur STOP, , sur l’interface utilisateur pour arrêter les mouvements du 
contrôleur Makoto®, interrompre les mises à jour de l’image IVUS 
transversale, et finir l’enregistrement d’un scan Live IVUS en cours.  

 

Ou, 
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b. Appuyez sur « Pullback » (Retrait), , pour compléter le scan Live 
IVUS et démarrer immédiatement une acquisition de retrait automatique. 

 

REMARQUE : Après avoir arrêté l’acquisition Live IVUS, le contrôler Makoto® 
affichera la distance parcourue depuis la dernière pression sur 
le bouton « Mark » (Marque). Cette valeur restera affichée 
jusqu’à ce que le bouton « Live IVUS » (IVUS en direct), 
« Pullback » (Retrait), ou « Return to READY » (Retour à 
PRÊT) ou un bouton de translation soit actionné. 
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9.2 Acquisition de retrait automatique 
Une acquisition de retrait automatique démarrera la rotation et le retrait du contrôleur 
Makoto® et de l’imagerie du cathéter. Cette action lancera également la collecte et 
l'enregistrement des données IVUS et NIRS en cas d'utilisation d'un cathéter 
compatible IVUS+NIRS ou uniquement des données IVUS en cas d'utilisation d'un 
cathéter compatible HD-IVUS uniquement, à la vitesse de retrait définie par l'utilisateur. 

  
Figure 9-6 : Mode d'acquisition avec acquisition par retrait automatique IVUS+NIRS en cours. 

 

9.2.1 Configuration du taux de retrait automatique suivant 
La vitesse de translation pour un retrait automatisé doit être configurée par 
l'utilisateur avant de commencer toute imagerie. Réglez la vitesse de translation 

souhaitée en touchant l'icône du panneau de contrôle du Makoto®, . 
Sélectionnez la vitesse souhaitée pour le prochain retrait : 0,5 mm/s, 1,0 mm/s, ou 
2,0 mm/s.  

 
Figure 9-7. Panneau de contrôle du Makoto® avec fonctions de contrôle à distance activées. 
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9.2.2 Démarrage du retrait automatique 

Appuyez sur le bouton « Pullback » (Retrait), , du contrôleur Makoto® pour 
démarrer une acquisition de retrait automatique. Pendant un retrait, l’IVUS transversal, 
l’IVUS longitudinal, l’indicateur de détection du fil-guide et l’indicateur de spectre sont 
mis à jour en temps réel. 

REMARQUE : Si les fonctions de contrôle à distance sont activées, les 
retraits automatisés peuvent être lancés en touchant l'icône 

« Pullback » (Retrait), , sur le moniteur. Voir la 
section 14.10.6 Activer le contrôle à distance pour activer les 
fonctions. 

 

9.2.2.1 Acquisition de retrait automatique avec aperçu 
Lorsque vous démarrez l’acquisition de retrait automatique depuis l’emplacement PRÊT 

avec le bouton « Pullback » (Retrait), , le système se déplacera d’abord à 
l’emplacement « 0,0 mm » et démarrera l’acquisition Live IVUS. Cela permet un aperçu 
intravasculaire de l’emplacement de démarrage du retrait. Après l’aperçu, appuyez sur 

le bouton « Pullback » (Retrait), , de nouveau pour poursuivre l’acquisition. 

9.2.2.2 Indicateur de spectre 
Au démarrage d’un scan de retrait automatique, le Makoto® Système d’imagerie 
intravasculaire contrôlera la qualité du spectre lumineux enregistré. Le système 
nécessite un nombre minimum de spectres pour générer un chemogram. 
Lorsque des spectres sont enregistrés, l’indicateur de spectre se remplira. Il 
disparaîtra une fois le nombre minimum atteint. 

Remarque : Lorsque le système Makoto® collecte suffisamment de données 
nécessaires pour créer un chemogram, l’indicateur de spectre 
disparaîtra de l’écran. 

 
Remarque : Il faut enregistrer environ 12 mm de données numérisées de 

retrait pour avoir suffisamment de données pour générer 
un chemogram. 

 

Remarque : Même si l’indicateur de bons spectres se remplit en raison de la 
collecte initiale de spectres de bonne qualité, si plus de 12 % 
d’entre eux sont trop faibles pour contribuer à la génération du 
chemogram, aucun chemogram ne sera généré. 

Remarque : L'indicateur de bon spectre ne sera présenté que lorsque des 
retraits automatiques avec des cathéters NIRS compatibles sont 
effectués. 
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9.2.3 Arrêt du retrait automatique 

 
AVERTISSEMENT 

L’imagerie à l’intérieur du cathéter de guidage doit être réduite 
au minimum pour des résultats de chemogram optimaux. 

 
Une fois que la distance de retrait souhaité a été atteinte ou que la quantité de 
données a été enregistrée, le Makoto® Système d’imagerie intravasculaire peut 
s’arrêter de deux manières : 

a. Appuyez sur le bouton « STOP » (ARRÊT), , du contrôleur Makoto® ; 

 

Ou 

b. Appuyez sur « STOP » (ARRÊT), , sur l’interface utilisateur de la console 
Makoto®.  

 

Ces deux actions arrêteront les mouvements du contrôleur Makoto® et l’acquisition 
de données.  

 

ATTENTION 

En cas d’urgence, utilisez le bouton « STOP » (ARRÊT), , 
du contrôleur Makoto®. 

 

Remarque : Le contrôleur Makoto® arrêtera automatiquement le retrait si le 
prochain point le plus proche est atteint (emplacement 
150,0 mm). 

 

Remarque : Après avoir arrêté le retrait, le contrôleur Makoto® affichera la 
distance parcourue depuis la dernière pression sur le bouton 
« Mark » (Marque). Cette valeur restera affichée jusqu’à ce que 
le bouton « Live IVUS » (IVUS en direct), « Pullback » (Retrait), 
ou « Return to READY » (Retour à PRÊT) ou un bouton de 
translation soit actionné. 
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Figure 9-8 : Mode d'acquisition après l'achèvement d'un balayage IVUS+NIRS par retrait automatique avec un cathéter 

guide détecté (fonctionnalités optionnelles SmartImaging™ activées). 

À la fin de l'acquisition par retrait automatique avec un cathéter capable, le chemogram, 
le chemogram au niveau du bloc et l'indice de charge du noyau lipidique seront mis à 
jour. L’indicateur de détection du fil-guide sera masqué de la vue. Consultez la 
section 10.2.11 pour plus d’informations. 

 

Si le cathéter de guidage est détecté par le Makoto® Système d’imagerie 
intravasculaire, alors un masque de cathéter de guidage sera appliqué au chemogram, 
à l’IVUS longitudinal et au chemogram bloc. Consultez la section 0 pour plus 
d’informations sur la manière de retirer le masque de cathéter de guidage de la vue. 
 

Remarque : Si le masque de cathéter de guidage est activé, la partie du 
chemogram dans le masque de cathéter sera exclue du calcul LCBI. 

 

9.2.4 Marquer ou remettre à zéro pendant le retrait automatique 
Pendant l'acquisition de retrait automatique, des marques peuvent être placées et 
consultées grâce au bouton « Mark » (Marque) du contrôleur, à l’image ou à l’icône 
« Mark » (Marque) à l'écran. 

Ajouter une marque pendant l’acquisition de retrait réinitialisera l’affichage de la 
distance parcourue à 0,0 mm. 

 

 

 

 

Masque de 
cathéter de 

guidage  

Sélection 
de scans  
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9.3 Réalisation de scans supplémentaires avec le Makoto® Système 
d’imagerie intravasculaire 

 

 
AVERTISSEMENT 

Consultez les instructions d’utilisation du cathéter pour le 
guidage de la préparation du cathéter pour des scans 
supplémentaires. 

 

 
AVERTISSEMEN

T 

Des situations dangereuses, y compris des blessures au patient 
ou à l'opérateur, peuvent se produire si les avertissements 
affichés sont ignorés. 

 

 
AVERTISSEMEN

T 

Le mouvement linéaire du contrôleur s'arrête lorsqu'une force 
excessive est rencontrée. 

Vérifiez que le cathéter ne présente pas de pliures, de coudes 
aigus ou de dommages et résolvez-les avant de continuer. 

Appuyez sur « STOP » (ARRÊT), , sur le contrôleur 
Makoto® et suivez les instructions à l'écran pour résoudre le 
problème. 
 
N’utilisez PAS les fonctions de translation à une étape pour 
régler le problème d’entortillement ou de déformation. La gaine 
du cathéter pourrait être endommagée ou le patient blessé. 

 

Plusieurs scans peuvent être effectués dans chaque procédure. Le cathéter peut nécessiter 
une quantité supplémentaire de solution saline héparine pour l’imagerie suivante.  

Appuyez sur le bouton Live IVUS, , ou le bouton « Pullback » (Retrait), , du 
contrôleur Makoto® pour acquérir des données supplémentaires. Le scan précédent 
sera sauvegardé et un nouveau scan actif apparaîtra.  

REMARQUE : Si les fonctions de contrôle à distance sont activées, l’imagerie 
IVUS en direct et les retraits automatisés peuvent être lancés 

en touchant l'icône correspondante,  ou , sur le 
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moniteur. Voir la section 14.10.6 Activer le contrôle à distance 
pour activer les fonctions. 

 

 

Un nouveau scan créera un nouveau bouton d’activation du scan pour une révision 
située au-dessus du chemogram. 

 

Remarque : Si vous enregistrez plus de trois scans, utilisez les flèches droite 
et gauche pour amener le bouton scan souhaité dans les vues. 

 

Remarque : Un total de 20 enregistrements par procédure peut être 
sauvegardé. Si la limite est atteinte, effacez les scans non 
souhaités ou fermez la procédure et démarrez-en une nouvelle. 

 

Remarque : L’annotation d’un nom de scan changera le texte du bouton 
associé. 
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10  Révision, mesure et annotation des scans 

10.1 Sélection de scans 
Après avoir enregistré de nombreux scans, il est possible de commuter entre les scans 
avec les contrôles de sélection du scan. 

 
Figure 10-1 : Phase « View » (Visualisation) avec le scan « RCA » sélectionné pour examen review (fonctionnalités 

optionnelles SmartImaging™ activées). 
 

Appuyez sur le nom de scan souhaité et chargez les données pour l’affichage à l’écran. 

Vous pouvez voir jusqu’à trois scans à tout moment dans la commande de sélection du 
scan. Appuyez sur les contrôles de flèche de chaque côté de la commande de sélection 
du scan pour déplacer d’autres scans dans les vues. 

 

  

Commande 
de sélection 
du scan 

Modifier scan 
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10.2 Modification des scans 
 

  
 

Figure 10-2 : Fenêtre de modification du scan ouverte pour « PRE LAD » (fonctionnalités optionnelles SmartImaging™ 
activées). 

Les informations de scan peuvent être modifiées pour fournir des détails 
supplémentaires et faciliter une sélection ultérieure.  

Appuyez sur le bouton Modifier, , du scan sélectionné pour accéder à la fenêtre 

d’édition du scan. Appuyez sur le « X », , ou à l’extérieur de la fenêtre d’édition du 
scan pour fermer ou sauvegarder tous les changements. 

 

10.2.1 Nom du scan 
Le nom du scan peut être personnalisé pour renvoyer des informations sur le scan. Cela 
peut inclure les noms, emplacements ou le timing de l’artère (ex. : « pre » ou « post »). 
Le nom peut être configuré en insérant les informations dans le champ du nom. 

Ce nom de scan apparaîtra dans le répertoire des procédures et scans complétés, 
tout comme les fichiers DICOM et les rapports. 

 
Remarque : Utiliser le filtre dans la phase de sélection du mode Révision 

pour rechercher des noms de scan. Consultez la section 12.1 
pour plus d’informations. 
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10.2.2  Numéro de groupe du cathéter  
Chaque scan est collecté avec un cathéter ayant un numéro de groupe de production 
associé. Cette information peut être enregistrée indépendamment pour chaque scan en 
insérant la valeur du package de cathéter dans le champ du numéro de groupe du 
cathéter dans la fenêtre d’édition du scan. 

 
Remarque : Insérez le numéro de groupe du cathéter pendant la phase de 

configuration pour alimenter automatiquement ce champ pour 
les scans tels qu’ils sont enregistrés. 

 

 
Remarque : S’il est disponible, le système lira le numéro de lot du cathéter et 

l'entrera automatiquement dans le champ. 

 
Remarque : Utilisez le filtre dans la phase « Select » (Sélection) du mode 

Révision pour rechercher des références de lot de cathéter. 
Consultez la section 12.1 pour plus d’informations. 

  

10.2.3 Remarque du scan 
Les remarques concernant le scan collecté peuvent être enregistrées dans le champ 
Remarques de la fenêtre d’édition du scan.  
 

Remarque : Utilisez le filtre du mode Révision, de l’écran de la phase de 
sélection pour rechercher des détails importants du scan 
enregistrés dans les remarques du scan. Consultez la 
section 12.1 pour plus d’informations. 

10.2.4 Scanner la visibilité longitudinale du chemogram au niveau du bloc 
La visibilité du chemogram au niveau du bloc sur l’écran IVUS longitudinal peut être 
activée ou désactivée à l’aide de cette case. Ce choix concerne uniquement le scan 
actuel. 

REMARQUE : Le paramètre de visibilité par défaut du chemogram au niveau 
du bloc pour chaque nouveau scan peut être défini dans les 
paramètres du système. Voir section 14.8 Affichage des 
scans. 

 
REMARQUE : Ce paramètre peut être ajusté rapidement en effectuant un 

clic droit avec la souris sur le chemogram au niveau du bloc et 
en choisissant le réglage approprié.  
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10.2.5 Scanner la visibilité transversale du chemogram au niveau du bloc 
La visibilité du chemogram au niveau du bloc sur l’écran IVUS transversal peut être 
activée ou désactivée à l’aide de cette case. Ce choix concerne uniquement le scan 
actuel. 

REMARQUE : Le paramètre de visibilité par défaut du chemogram au niveau 
du bloc pour chaque nouveau scan peut être défini dans les 
paramètres du système. Voir section 14.8 Affichage des 
scans. 

 
REMARQUE : Ce paramètre peut être ajusté rapidement en effectuant un 

clic droit avec la souris sur le chemogram au niveau du bloc et 
en choisissant le réglage approprié.  

 

10.2.6 Visibilité du contour logitudinal IVUS 

La visibilité des contours mesurés automatiquement sur l’affichage longitudinal IVUS 
peut être activée ou désactivée via cette case à cocher. Cette sélection n’affectera que 
le scan en cours. 
 

REMARQUE : Ce paramètre peut être rapidement ajusté en effectuant un 
clic droit sur l’IVUS longitudinal ou transversal, puis en 
modifiant le paramètre approprié. 

10.2.7 Visibilité du contour transversal IVUS 

La visibilité des contours mesurés automatiquement sur l’affichage transversal IVUS 
peut être activée ou désactivée via cette case à cocher. Cette sélection n’affectera que 
le scan en cours. 
 

REMARQUE : Ce paramètre peut être rapidement ajusté en effectuant un 
clic droit sur l’IVUS longitudinal ou transversal, puis en 
modifiant le paramètre approprié. 

10.2.8 Scan mxLCBI 
La taille de fenêtre du LCBI maximale peut être ajustée pour chaque scan par rapport à 
la valeur par défaut. Utilisez le curseur pour ajuster la fenêtre utilisée pour calculer le 
mxLCBI entre 1 mm et 10 mm. 
 

REMARQUE : La valeur par défaut poru tous les nouveaux scans peut être 
définie dans les paramètres du système. Voir section 14.8.5 
« mx LCBI Window Size » (Taille de fenêtre du LCBI max). 
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10.2.9 Seuils de condition au niveau de l’image (frame) 

Dans la fenêtre « Scan Edit » (Modifier le scan), utilisez les boutons radio pour 
sélectionner l’ensemble des seuils de condition à afficher dans la « Condition View » 
(vue des conditions). Lorsque les mesures sur une image dépassent une ou les deux 
conditions définies, la vue des conditions colore soit la ligne inférieure, soit les lignes 
inférieure et supérieure. Deux couleurs sont disponibles, bleu et vert. Une seule couleur 
peut être affichée pour un scan, déterminée par le bouton radial sélectionné dans la 
fenêtre de modification. 
 

10.2.10 Activer le cathéter de guidage 

 

 
AVERTISSEMENT 

L’imagerie à l’intérieur du cathéter guide doit être minimisée 
pour obtenir des résultats optimaux du chemogram. 

 
Dans la fenêtre d’édition du scan, utilisez la commande d’activation du masque du cathéter 
de guidage pour alterner la visibilité du masque du cathéter de guidage sur le chemogram, 
l’indicateur de fil-guide, l’IVUS longitudinal et le chemogram bloc.  
 

   

Figure 10-3 : modification du scan avec masque du cathéter de guidage activé (gauche). Modification du scan 
avec masque du cathéter de guidage désactivé (droite) (fonctionnalités optionnelles SmartImaging™ activées). 

10.2.11 Activer l’indicateur du fil-guide 
Dans la fenêtre d’édition du scan, utilisez la commande d’activation de l’indicateur  
de fil-guide pour alterner la visibilité de l’indicateur de fil-guide et du chemogram. 
La commande apparaît en bleu lorsque l’indicateur de fil-guide est visible. 

Masque de 
cathéter de 

guidage  
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Figure 10-4 : la fenêtre d’édition du scan avec l’activation de l’indicateur de fil-guide activé (gauche) ; le chemogram est 

masqué et l’indicateur de fil-guide est visible (droite) (fonctionnalités optionnelles SmartImaging™ activées). 

REMARQUE : Le basculement de la carte du fil-guide ne modifie pas 
l'affichage si aucune donnée NIRS n'est disponible. 

 

10.2.12 Effacer scan 
Les scans individuels peuvent être effacés dans la fenêtre d’édition du scan. Une 
demande de confirmation sera fournie à l’utilisateur. 

    
Figure 10-5 : la commande de scan effacé dans la fenêtre d’édition du scan (gauche) et la demande de confirmation (droite) 

(fonctionnalités optionnelles SmartImaging™ activées) . 

 

ATTENTION 

Une fois confirmée par l’utilisateur, la suppression d’un scan ne 
peut être annulée. 

 

 

Activer 
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fil-guide 
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10.3 Navigation du scan 
Le scan sélectionné peut être révisé avec plusieurs commandes. 

 

  
Figure 10-6 : Phase « View » (visualisation) du mode « Review » (Révision) avec la sélection du scan et les commandes de 

lecture mises en évidence (fonctionnalités optionnelles SmartImaging™ activées). 
 

10.3.1 Lecture automatique 

Appuyez sur la commande Lecture/Pause,  / , située en dessous de l’image 
IVUS transversale pour répéter automatiquement les images enregistrées dans leur 
ordre d’enregistrement.  

La lecture se produira à environ 16 images par seconde pour les enregistrements Live 
IVUS ou 30 images par seconde pour les enregistrements de retrait automatique. 

 
Figure 10-7 : Phase « View » (visualisation) du mode « Review » (Révision) pendant la lecture automatique avec la 

commande Pause mise en évidence (fonctionnalités optionnelles SmartImaging™ activées) 

La mise sur pause arrêtera la lecture sur l’image affichée. La reprise de la lecture 
démarrera par la répétition des images à partir du dernier fragment affiché. 
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Remarque : Une fois la dernière image enregistrée atteinte, la lecture en 
boucle reprendra par la première image des séries. 

 

Remarque : Lorsqu’une région est sélectionnée, la lecture automatique 
tournera les images dans la région sélectionnée. 

 

10.3.2 Révision de la lumière 
Comme une aide pour réaliser les mesures et réviser les images individuelles, la 
révision de la lumière lira une très courte boucle des images pour accentuer les 
différences dans l’apparence IVUS de la cuve et de la plaque immobiles du mouvement 
relatif à la circulation sanguine. 

La révision de la lumière activée en appuyant sur la commande de révision de la 

lumière, , à droite du bouton de lecture automatique. 

 

REMARQUE : Il est possible d’ajuster la durée ou la plage de la révision du 
flux lumineux dans les paramètres du système. Voir section 
14.8.2 Plage d’images de la révision du flux lumineux. 

 

10.3.3 Lecture manuelle 
Le scan sélectionné peut également être lu manuellement. Appuyez et relâchez la 

commande de sélection de l’image fine, , pour lire le scan lentement dans 
la direction de votre choix. Ainsi, la lecture s’arrêtera une fois l’image atteinte par le 
scan ou la région sélectionnés ; cela ne fermera pas les images sélectionnées.  

Remarque : Appuyez et relâchez la commande de sélection de l’image fine, 

, pour lire les images sélectionnées dans leur ordre 

inverse d’enregistrement. 

 

10.3.4 Sélection de l’image 

10.3.4.1 Sélection de l’image approximative 
Faites glisser la commande de sélection de l’image approximative entre le chemogram 
ou la carte de détection du fil-guide et l’IVUS longitudinal ou tout autre endroit sur la 
ligne bleue pour actualiser rapidement l’image affichée.  
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Remarque : Le déplacement de la commande de sélection de l’image 
approximative est une lecture à taux variable. 

 

10.3.4.2 Sélection de l’image fine 
Appuyez sur l’image fine approximative ou les commandes de sélection de l’image fine 

distale, , pour changer l’image affichée en augmentation d’une image. 

 

Remarque : Avec le curseur au-dessus du chemogram, de l’indicateur de fil-
guide, de l’IVUS transversal ou de l’IVUS longitudinal, faites défiler 
la molette de la souris pour changer l’image affichée en 
augmentation d’une image. 

 

10.3.5 « Go To MLA » (Aller au MLA) ou « Go To MLD » (Aller au MLD) 

Touchez ou cliquez sur le bouton MLA ou MLD pour accéder directement à l’image où 
l’aire ou le diamètre minimal de la lumière a été calculé.  
 

REMARQUE : Basculez l'affichage graphique des mesures entre Aire et 
Diamètre pour afficher l'emplacement et la valeur du MLA ou 
du MLD. 

 
 

10.4  Marques 
Pendant et après que le scan soit complété, des marques peuvent être placées. 

Pendant l’acquisition du scan, appuyez sur les commandes « Mark » (Marque),  

ou . Pendant la révision, naviguez sur l’image souhaitée et appuyez sur « Mark » 
(Marque) à l’écran. 

 

Remarque : Une seule marque peut être placée sur chaque image. 

 

Remarque : Jusqu’à 30 marques peuvent être créées dans un seul scan. 

 

Remarque : Jusqu'à six marques peuvent être visibles à l'écran à tout 
moment. 
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Remarque : Compléter une mesure IVUS transversale ou sur une annotation 
d’image créera automatiquement une marque pour l’image. 

 

Remarque : Utilisez le bouton « Mark » (Marque) dans les phases de 
configuration ou d’amorçage pour passer à la phase suivante du 
mode Acquistion. 

 
Remarque : Pendant l’acquisition d’images, utilisez le bouton « Mark » 

(Marque) pour réinitialiser les distances affichées à 0 mm. 

 

La position relative d’une marque dans le scan est indiquée par de petits triangles verts 
sur le chemogram et l’IVUS longitudinal. Lorsque la marque est sélectionnée, l’image 
affichée en cours connectera les triangles. 

 
Figure 10-8 : Les positions des marques sont affichées par des indicateurs en forme de triangle vert sur le Chemogram et 
l’IVUS longitudinal, accompagnées d’une vignette visuelle montrant le contenu de l’image mise en surbrillance. (fonctions 

optionnelles SmartImaging™ activées). 

 

10.4.1  Sélection de marques 
Une vignette de marque sera créée pour chaque marque placée. La vignette est la 
commande pour sélectionner l’emplacement marqué pour une révision ultérieure. Elle 
fournit également une représentation visuelle du contenu à l’emplacement de l’image. 

Appuyez sur l’image de la marque souhaitée pour mettre à jour l’écran et afficher 
l’image dans l’écran de l’IVUS transversal. 
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10.4.2  Modifications de marques 

Les marques peuvent être effacées ou annotées. Appuyez sur le bouton Modifier, , 
de la marque sélectionnée pour ouvrir la fenêtre d’édition de marque. 

Appuyez sur « X », , ou à l’extérieur de la fenêtre d’édition de marque pour fermer 
la fenêtre, en sauvegardant les changements. 

10.4.2.1  Notes de marque 
 

 
Figure 10-9 : note de marque saisie dans la fenêtre d’édition de marque. 

Des remarques concernant le contenu d’une image peuvent être enregistrées dans le 
champ Notes de la fenêtre d’édition de marque. 
 

10.4.2.2 Suppression 

Les marques peuvent être supprimées avec la commande « Delete » (Supprimer), , 
dans la fenêtre d’édition de marque.  

Remarque : La suppression de marque ne peut être annulée. 

 
Remarque : La suppression d’une marque comprenant des mesures ou des 

annotations d’image nécessitera une confirmation. 

 
 
 

10.5 Mesures 
Le système d’imagerie Makoto® fournit des commandes avec la phase de numérisation 
pour effectuer des mesures de l’affichage transversal et des affichages longitudinaux 
(Chemogramet IVUS longitudinal).  

Note de scan 
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Figure 10-10 : phase « View » (Visualisation) avec une région sélectionnée dans le scan « RCA » (fonctionnalités 

optionnelles SmartImaging™ activées). 

 

10.5.1  Mesure de la longueur, de la sténose de la zone de lumière et du LCBI 
Les mesures de la longueur, de la sténose de la zone de lumière et du LCBI sont effectuées 
sur la vue de l’IVUS longitudinal et du chemogram à travers la création de régions. 

10.5.1.1 Création de régions 
Les régions sont les sous-segments d’un scan importants pour l’opérateur ou le médecin. 
Ces segments peuvent concerner les lésions, les segments normaux, les stents...  

  
Figure 10-11 : phase « View » (Visuealisation) avec création de région en cours. Les consifnes pour terminer la région 

apparaissent à l’écran (fonctions optionnelles SmartImaging™ activées). 
 

Les régions sont créées en appuyant sur la commande Longueur, , puis en 
indiquant un emplacement de début et de fin de la région sur l’IVUS longitudinal ou 
chemogram. Il est possible de définir la région : 

(A) En appuyant et en maintenant au niveau de la position de départ souhaitée 
puis en étirant jusqu’à la position de fin souhaitée ; 

ou  
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(B) En appuyant sur les positions de marques de départ et de fin dans les 
vignettes de marque. 

Remarque : Utilisez les marques pour définir le début ou la fin d’une région 
souhaitée avec une précision accrue. 

 

Une fois la région créée, les zones de l’affichage longitudinal situées en dehors de la 
région s’estompent et un contrôle de sélection de la région s’affiche sous les contrôles 
de sélection de scan. 

Remarque : 

Utilisez le bouton de lecture, , pour créer une boucle avec la 
région sélectionnée. 

 

Le LCBI et les résultats s’affichent à gauche de la région du chemogramet la longueur 
s’affiche à gauche de l’IVUS longitudinale. 

 
Figure 10-12 : phase « View » (Visualisation) avec la région sélectionnée (fonctionnalités optionnelles SmartImaging™ 

activées). 

  

LCBI de la région 
sélectionnée 

LCBI max de la 
région sélectionnée 

Longueur de la 
région sélectionnée 

Emplacement 
du LCBI max 
dans la région 
sélectionnée. 

Zone de sténose 
de la région 

sélectionnée 

Diamètre moyen 
de la lumière et de 

l’EEM au bord 
proximal 

Diamètre moyen 
de la lumière et 
de l’EEM au 
bord distal 

« Aller au MLA » 
ou « Aller au 
MLD  » 

Emplacement du 
MLA ou MLD 



Makoto® Système d’imagerie intravasculaire 
Guide d’utilisation 

   
IFU0163rS.fr (2025-06-27)  10-14 

10.5.1.2  Modification des régions 
Il est possible de modifier la position ou l’emplacement de début et de fin des régions 
qui ont été créées dans le chemogram. 

  
Figure 10-13. Commandes de modification des régions (fonctionnalités optionnelles SmartImaging™ activées). 

 
Faites glisser la position de la région pour déplacer la région définie sans en modifier la 
longueur. 
Faites glisser la limite proximale ou distale de la région pour ajuster de manière 
grossière l’extrémité sélectionnée de la région. La longueur de la région s'adaptera 
automatiquement. Les LCBI s'actualiseront lorsque la modification sera terminée. 
 

REMARQUE : Placez le curseur sur les commandes de modification du 
début ou de la fin et utilisez la roulette de la souris pour 
effectuer des ajustements précis de l’emplacement de la limite 
de la région. 

 
REMARQUE : Verrouillez la région pour éviter tout ajustement accidentel. 

Voir section 10.5.1.7 Verrouiller une région. 

10.5.1.3 Longueur, diamètre, AS%, LCBI et LCBI max. 
Une fois la création de la région achevée, cinq résultats de mesure liés à la région sont 
présentés. 
 Longueur : Il s’agit de la distance en millimètres (mm) entre la 

position de début et la position de fin de la région. 

 Diamètre Dans les systèmes équipés des fonctionnalités 

SmartImaging™, la moyenne des diamètres minimum 

Modification 
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Modification 
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et maximum sera affichée pour la lumière et l’EEM aux 

limites distale et proximale de la région. 

 AS% Dans les systèmes équipés des fonctionnalités 

SmartImaging™, le pourcentage de sténose de l’aire de 

la lumière (AS%) pour le segment sera calculé, comme 

décrit à la section 4.6 Ultrason intravasculaire, et 

affiché automatiquement. 

 LCBI : Il s’agit du Lipid Core Burden Index (Indice de masse 
du cœur lipidique) de la région. Le LCBI est le ratio des 
signaux positifs de lipides et du total de pixels valides 
dans la région sélectionnée, exprimé sur une échelle 
de 0 à 1000. 

 mx(4) : Il s’agit du Lipid Core Burden Index maximum d’une 
taille fixe de fenêtre dans les limites de la région. 
La taille de fenêtre par défaut est de 4 mm. 

REMARQUE : Les valeurs LCBI et Mx(4) ne sont fournies que si des 
données NIRS sont enregistrées par le système. 

 

REMARQUE : Dans les systèmes équipés des fonctionnalités 
SmartImaging™, si le système détecte que le cadre de 
délimitation proximal ou distal nécessite une révision, les 
résultats concernant le diamètre, le pourcentage de sténose 
(AS%), ou les deux, peuvent ne pas s’afficher tant que la 
mesure du cadre de délimitation n’a pas été modifiée ou 
confirmée.  Voir la section 10.5.2.1 « Mesure de zone » pour 
apprendre comment modifier et valider les mesures 
automatiques. 

 

10.5.1.4 Sténose de l’aire de la lumière (AS%) 
La sténose de l’aire de la lumière (AS) peut être calculée lorsqu’une région est créée. 
L’aire minimale de la lumière dans cette région sera comparée à l’aire de la lumière de 
l’image distale correspondante.   
 

Remarque : Ajoutez les mesures de la lumière aux images de début et de fin 
d’une région existante afin d’obtenir la sténose de l’aire de la 
lumière pour cette région. 

 

REMARQUE : Dans les systèmes équipés des fonctionnalités 
SmartImaging™, l’AS% sera calculé automatiquement. 
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10.5.1.5 Sélection et désélection 
Atlasiet reģionus pieskaroties attiecīgajām pogām reģionu atlases vadīklā (Region 
Selection Control). L'affichage longitudinal, la longueur, le LCBI, les diamètres moyens, 
l'AS% et les résultats LCBI max. seront mis à jour en conséquence. 
 

Désélectionnez les régions en appuyant à nouveau sur le bouton de région 
correspondant ou sélectionnez le scan actuel ou un autre scan.  

 

Remarque : Le fait de créer une nouvelle région désélectionne la région 
actuelle. 

 

10.5.1.6  Annotation de la région  
 

  
Figure 10-14 : nom de région saisi dans la fenêtre de modification de la région. 

Appuyez sur le bouton « Edit » (Modifier), , du bouton « Selected Region » 
(Région sélectionnée) pour ouvrir la fenêtre « Region Edit » (Modifier la région). 
Appuyez sur le champ souhaité pour en modifier le contenu. 

Appuyez sur le « X », , ou à l’extérieur de la fenêtre « Region Edit » (Modifier la 
région) pour fermer ou sauvegarder votre saisie. 

 

Fenêtre de 
modification 
de la région 

Supprimer la 
région 

Note 
relative à 
la région 

Nom de 
région 

Verrouillage 
d’une région 



Makoto® Système d’imagerie intravasculaire 
Guide d’utilisation 

   
IFU0163rS.fr (2025-06-27)  10-17 

10.5.1.7 Verrouiller une région 

Appuyez sur le bouton « Edit » (Modifier),  , du bouton « Selected Region » (Région 
sélectionnée) pour ouvrir la fenêtre « Region Edit » (Modifier la région). Appuyez sur 

l’icône « Region Lock » (Verrouillage de la région),  , pour autoriser ou 
empêcher l’ajustement de la position ou des limites de la région. 
 

10.5.1.8 Suppression de région 

Appuyez sur le bouton « Edit » (Modifier), , du bouton « Selected Region » (Région 
sélectionnée) pour ouvrir la fenêtre « Region Edit » (Modifier la région). Appuyez sur le 

bouton « Delete » (Supprimer), , pour supprimer la région.  

Remarque : La suppression d’une région ne peut être annulée. 

 

10.5.2  Mesure sur image  
Il est possible d’effectuer des mesures sur toute image transversale d’IVUS afin de 
clarifier ou de quantifier le contenu de l’image. 

 

Remarque : Effectuer une mesure sur image crée automatiquement une 
marque pour l’image. 

 

Remarque : Effectuer une mesure sur image actualise l’image de la vignette 
de marque. 

 
REMARQUE : Lorsque l’outil est actif, appuyez sur l’outil pour abandonner la 

mesure ou l’annotation sur l’image en cours. 

 

10.5.2.1 Mesure de zone 

L’outil de mesure de zone, , peut être utilisé pour mesurer l’aire ainsi que les 
diamètres minimum et maximum des éléments à l’image. 
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Figure 10-15 : Phase « Scan » (Numérisation) avec mesure de la zone activée et en cours. Le premier point placé est 

indiqué par un plus grand cercle plein. 
 

Appuyez sur l’outil de mesure de zone, , pour commencer à mesurer. L’icône 
devient bleue lorsqu’elle est active. Des instructions s’affichent au-dessus de l’image 
transversale d’IVUS et servent de guide pour terminer la mesure. 
 
Appuyez sur l’image transversale d’IVUS pour placer les points le long de l’élément 
souhaité afin de commencer à définir la zone. Continuez à ajouter des points jusqu’à 
ce que la zone soit définie. 
 

Remarque : Lorsque le troisième point est ajouté pour définir la zone, un 
aperçu de la zone apparaît en pointillés. Il illustre la manière 
dont la zone terminée apparaîtra si l’utilisateur appuie sur le 
point de départ pour compléter la zone. 

 
 

Remarque : 

Appuyez sur « Cancel » (Annuler), , au niveau des 
instructions à l’écran pour abandonner la mesure en cours. 
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Figure 10-16 : mesure de zone terminée et affichage des résultats. 

Appuyez sur le premier point pour terminer la mesure et afficher les résultats. Pour 
chaque zone terminée, la zone transversale avec diamètres minimum et maximum 
s’affichera dans le coin supérieur gauche de l’image transversale d’IVUS. 
 

Remarque : Appuyez sur le résultat de mesure pour afficher les diamètres 
minimum et maximum dans l’image. 

 
 

Résultats 
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Figure 10-17 : Des contours et résultats codés par couleur s’affichent si une zone tracée est totalement imbriquée dans une 

seconde zone. Le contour de la lumière est sélectionné et les emplacements des diamètres minimum et maximum sont indiqués. 
 

S’il y a plus d’un contour de zone tracé, les résultats seront codés par couleur. 
 

Remarque : Trois zones peuvent être tracées sur chaque image. 

 

Remarque : Chaque résultat de mesure d’une zone possède la même 
couleur que son contour. Chaque icône de zone calculée, par 
exemple une zone de plaque, correspond à la couleur utilisée 
pour les contours qui servent à définir le résultat de la zone 
calculée. 

 
Remarque : Si une zone est toalement imbriquée dans une seconde zone 

sur la même image, le système Makoto® en désignera 
automatiquement une pour représenter la « Lumière » et l’autre 
« EEM », tandis qu’une zone de plaque et une progression de 
plaque, « PP » seront calculées. 

 
Remarque : Si trois zones impriquées apparaissent sur la même image, la 

zone 1 tracée entièrement à l’intérieur de la zone 2 et la zone 2 
entièrement à l’intérieur de la zone 3, le système Makoto® 
désignera automatiquement la zone la plus à l’extérieur pour 
représenter « EEM », celle la plus à l’intérieur pour représenter 
la « Lumière », et celle du millieu pour représenter le « Stent ». 
Une zone de plaque et une progression de plaque, « PP », 
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seront calculées entre « EEM » et la « Lumière ». Une autre 
zone sera calculée entre le « Stent » et la « Lumière ». 

 
 
Ajustez la taille ou la forme de la zone en appuyant sur les points existants et en les 
faisant glisser vers l’emplacement désiré. Pour affiner la forme de la zone terminée, 
ajoutez des points à la zone terminée et faisant glisser le contour de la zone entre les 
points existants. Les résultats présentés s'actualiseront lorsque la modification sera 
terminée. 
 

Remarque : Faites glisser les points de mesure pour ouvrir le zoom local et 
améliorer la visualisation de l’image près du curseur ou sous le 
doigt de l’opérateur. 

 

   
Figure 10-18 : SmartImaging™ invite l'utilisateur à confirmer ou accepter les mesures suggérées (à gauche) ou à restaurer 

les mesures modifiées ou supprimées (à droite). 

 
Lorsque les fonctionnalités optionnelles SmartImaging™ sont activées, le système 
analyse automatiquement chaque image pour suggérer à l’utilisateur la localisation de 
la lumière et de la membrane élastique externe (EEM). L’utilisateur peut confirmer les 
mesures sur l’image en touchant le bouton « Accept automated contours » (Accepter 
les contours automatiques) situé près des résultats, ou en modifiant les zones 
proposées de la même manière que pour les zones dessinées manuellement. Pour 
rejeter les résultats automatiques générés par SmartImaging™, supprimez le résultat 
correspondant. 
  
 

10.5.2.2 Mesure linéaire 
Il est possible d’effectuer des mesures linéaires au niveau de l’image transversale d’IVUS 
pour mesurer des éléments de l’image, comme des diamètres ou des épaisseurs.  
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Figure 10-19 : Mesure linéaire terminée. Trois mesures linéaires ont été faites sur cette section. 

Appuyez sur l’outil de mesure linéaire, , pour commencer à mesurer. L’icône 
devient bleue lorsqu’elle est active. Des instructions s’affichent au-dessus de l’image 
transversale d’IVUS et servent de guide pour terminer la mesure. 
 
Appuyez sur le point de départ de la fonction à mesurer sur l’image IVUS transversale.  
Appuyez sur la position de fin de la fonction pour terminer la mesure. La mesure linéaire 
entre les deux points s'affichera en millimètres sur l’image IVUS transversale. 
 

Remarque : Lorsque vous utilisez la souris ou faites glisser le point de fin, un 
aperçu de la ligne et de la distance apparaît jusqu’à ce que vous 
placiez le point de fin. 

 
Remarque : Il est possible de tracer jusqu’à six mesures linéaires par image. 

 
Faites glisser le point de début ou de fin pour ajuster la mesure.  
 

10.5.2.3  Supprimer des mesures sur image 
Pour supprimer des mesures sur image individuelles, commencez par sélectionner le 
résultat de mesure. 

Supprimer la 
mesure 

Mesure 
sélectionnée 

Mesure linéaire 
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Figure 10-20 : marque avec une mesure linéaire sélectionnée. Notez l’option permettant de supprimer la mesure et le résultat. 

Lorsque vous sélectionnez une mesure, un bouton « Delete » (Supprimer), , 
s’affiche à gauche du résultat sélectionné. Appuyer sur le bouton « Delete » 

(Supprimer), , efface la mesure et le résultat du scan. 

Remarque : La suppression de mesure ne peut pas être annulée. 

 
Remarque : Aucune confirmation n’est demandée lors de la suppression de 

mesures individuelles. 

 
Remarque : Supprimez la marque pour effacer TOUTES les mesures d’une 

image en une fois. 

10.6  Annotation sur image 
Outre les mesures, il est possible de placer des commentaires directement sur 
l’image transversale d’IVUS.  

Appuyez sur le bouton d’annotation sur image, , pour commencer à créer 
des commentaires sur image. Déterminez l’emplacement où la note devra 
s’afficher, qui correspondra au bord gauche de la note. Appuyez sur <Enter> 
(<Entrée>) sur le clavier virtuel pour terminer l’annotation. 

 
Remarque : Effectuer une annotation sur image crée automatiquement une 

marque pour l’image. 

 
Remarque : Vous pouvez faire glisser les annotations sur image terminées 

vers un nouvel emplacement sur l’image actuelle. 

 

Supprimer la 
mesure 
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Remarque : Terminer une annotation sur image actualise l’image de la 
vignette de marque. 

 
Pour supprimer une annotation sur image, appuyez sur l’annotation pour la 

sélectionner puis appuyez sur le bouton « Delete » (Supprimer), . 

 

10.7 Capture d’écran 
Vous pouvez effectuer des captures de la totalité de l’écran lors des phases « Scan » 
(Numérisation) et « View » (Visualisation). Cette image capturera tout le contenu à 
l’écran ainsi que tous les boutons et commandes. 

Lorsque vous examinez un scan, naviguez jusqu’à l’image souhaitée à l’aide des 
commandes de réglage grossier ou fin de l’image. 

 
Figure 10-21 : Phase « View » (Visualisation) du mode « Review » (Révision) avec la commande de capture d’écran affichée 

(fonctionnalités optionnelles SmartImaging™ activées) . 

Appuyez sur le bouton Capture, , pour enregistrer une image de l’écran entier pour 
un usage ultérieur. 

 
Remarque : Vous pouvez enregistrer jusqu’à 30 captures d’écran par scan. 

 
Remarque : Les captures d’écran peuvent être supprimées depuis la phase 

« Close » (Fermeture) du mode Acquisition ou la phase 
« Select » (Sélection) du mode « Review » (Révision). 

 

Capture 
d’écran 
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10.8 Paramètres d’affichage 
Le Makoto® Système d’imagerie intravasculaire propose plusieurs boutons permettant 
d’optimiser la disposition de l’affichage et la qualité des images obtenues par IVUS.  

10.8.1 Rotation longitudinale d’IVUS 
L’image longitudinale d’IVUS est créée à partir des données d’image le long de l’axe 
marqué au niveau de l’image transversale d’IVUS. L’axe marqué au niveau de l’image 
transversale d’IVUS est indiqué par les triangles solides et ouverts sur l’axe. Le triangle 
solide sur l’axe indique la portion de l’image qui sera tracée dans la moitié supérieure 
de l’IVUS longitudinale. 

 
Figure 10-22 : rotation longitudinale d’IVUS. La ligne verte en pointillés indique l’emplacement initial de l’axe de l’IVUS 
longitudinale, et la ligne solide son emplacement actuel (fonctionnalités optionnelles SmartImaging™ activées) . Les 

lignes sont accentuées ici à des fins d’illustration. 

Pour ajuster les données affichées dans l’IVUS longitudinale, faites glisser le triangle 
plein sur l’axe marqué jusqu’à un nouvel emplacement sur la circonférence de l’image 
IVUS transversale. 
 

REMARQUE : Ajuster cet affichage de l’IVUS longitudinal n’affecte pas les 
ajustements apportés à la rotation du chemogram. 

 

10.8.2 Rotation du chemogram 
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Figure 10-23 : Il est possible de faire pivoter les chemograms de manière à éloigner les groupes de lipides du bord du 
chemogram afin de faciliter l’examen et l’interprétation (fonctionnalités optionnelles SmartImaging™ activées). 

 
L’axe vertical du chemogram est une dimension continue de 360°. Cela signifie que le 
bord supérieur du chemogram est relié au bord inférieur. L’emplacement de la coupe 
est arbitraire et permet de la représenter sur un plan en deux dimensions. Certains 
éléments peuvent dès lors être séparés entre les bords supérieur et inférieur. 
 
Touchez ou cliquez puis faites glisser verticalement dans le chemogram pour ajuster la 
position de coupe du chemogram.  
 

REMARQUE : Le système se souviendra de l’ajustement de la ligne de 
coupe du chemogram et l’utilisera lors des consultations de 
scans ou générations de rapports suivantes. Les captures 
d’écran ne seront pas ajustées. 

 
REMARQUE : Ajuster cet affichage du chemogram n’affecte pas les 

ajustements apportés à l’IVUS longitudinal. 

 

10.8.3 Vues des mesures de surface et de diamètre 

Le graphique des mesures automatiques peut être basculé entre la vue « Area » 
(Surface) et la vue « Diameter » (Diamètre). 

Pour changer l’affichage, touchez ou cliquez sur l’icône .  La surface minimale de 
la lumière (MLA) ou le diamètre minimal de la lumière (MLD) pour le scan ou la région 
sélectionnée sera affiché, et son emplacement sera indiqué à l’écran.  
 

REMARQUE : Appuyez sur la valeur MLA ou MLD pour accéder directement 
à cet emplacement. 

 

10.8.4 Vue Condition 

La vue Condition se trouve sous la vue graphique des mesures. À l’aide des 
commandes de la fenêtre « Scan Edit » (Modifier le scan), l’utilisateur peut définir des 
critères de seuil pour la charge plaque ou le mxLCBI afin de mettre en évidence les 
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segments vasculaires présentant un intérêt clinique. Si une condition est remplie à un 
emplacement, la ligne inférieure est colorée. Si les deux conditions sont remplies, les 
lignes inférieure et supérieure sont colorées. 
La vue peut être activée ou désactivée dans la fenêtre « Scan Edit » (Modifier le scan) 
en sélectionnant le bouton approprié situé à côté des valeurs des conditions. 
 

REMARQUE : Cliquez avec le bouton droit de la souris sur la vue Condition 
pour basculer rapidement entre les deux ensembles de 
conditions. 

10.8.5 Rotation de l’IVUS transversale 
 Il est possible de faire pivoter l'image transversale afin de faciliter la comparaison avec 
d'autres scans ou d’aider l’utilisateur à mieux visualiser l'anatomie. 

 
Figure 10-24. Rotation de l’IVUS transversale. L’image de gauche montre l’orientation par défaut et l’image de droite 
montre l’image après rotation, effectuée en faisant glisser la commande sur le halo du chemogram vers un nouvel 

emplacement. 

Pour ajuster la rotation de l’image transversale, faites glisser la commande de l'arc gris 
qui apparaît dans le halo du chemogram vers un nouvel emplacement. 
 

REMARQUE : Les orientations de l'image IVUS transversale et du halo du 
chemogram sont liées. Faire pivoter l'image transversale fait 
également pivoter le halo du chemogram. 

 
REMARQUE : La rotation de l’image transversale s'applique à toutes les 

images du scan. 

 
REMARQUE : La rotation de l’IVUS longitudinale est relative à la rotation de 

l’IVUS transversale, de sorte que les ajustements de la 
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rotation de l’IVUS transversale ne perturberont pas la vue de 
l’IVUS longitudinale sélectionnée. 

 
REMARQUE : La rotation de l’IVUS transversale apparaîtra dans les 

rapports, AVIS et images DICOM créés dans le mode 
Révision. 

 

10.8.6 Paramètres de l’image transversale 
Il est possible d’ajuster l’image transversale de l’IVUS à l’aide des boutons de 
paramètres d’image. Ces boutons incluent un ensemble de commandes de base ainsi 
qu’un ensemble de commandes avancées. 

  
Figure 10-25 : paramètres de l’image transversale. À gauche, les commandes de base. À droite, les commandes avancées. 

Appuyez sur le bouton des paramètres d’image pour y accéder puis utilisez le bouton 

Étendre, , pour accéder aux paramètres et fonctions avancés. 

Appuyez sur la croix, , ou à l’extérieur de la fenêtre pour utiliser les paramètres 
actuels et fermer la fenêtre. 

10.8.6.1 Zoom  
Vous pouvez ajuster la profondeur de champ de l’IVUS transversale à l’aide des 
commandes de zoom à côté de l’image transversale d’IVUS. Il est possible 
d’ajuster la profondeur d’image transversale d’IVUS de 6 à 16 mm, par 
incréments de 2 mm. 

         
Figure 10-26 : les commandes de zoom permettent d’ajuster le diamètre d’IVUS transversale. 6 mm de diamètre, à gauche. 

10 mm de diamètre, au centre. 16 mm de diamètre, à droite. 

Zoom 

Diamètre de 
champ d’IVUS 

 Étendre les 
commandes 
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Appuyez sur les commandes de zoom pour augmenter, , ou réduire , 
le zoom sur l’IVUS transversale. L’affichage de l’IVUS longitudinale sera actualisé 
en conséquence. 

 

10.8.6.2 Gain  
Faites glisser le curseur pour ajuster la valeur du paramètre de gain. La valeur est 
comprise entre 0,5 et 3,0.  

Une valeur basse produit une image sombre, tandis qu’une valeur élevée produit une 
image plus claire. 

10.8.6.3 Saturation  
Faites glisser le curseur pour ajuster la valeur du paramètre de saturation. La valeur est 
comprise entre 0,50 et 1,50.  

Une valeur basse produit une image sombre, tandis qu’une valeur élevée produit une 
image plus claire. À utiliser conjointement au paramètre de Noir pour contrôler la plage 
dynamique. 

10.8.6.4 Noir  
Faites glisser le curseur pour ajuster la valeur du paramètre de noir. La valeur est 
comprise entre 0,00 et 0,50.  

Une valeur basse produit une image claire, tandis qu’une valeur élevée produit une 
image plus sombre. À utiliser conjointement au paramètre de saturation pour contrôler 
la plage dynamique. 

10.8.6.5 Gamma  
Faites glisser le curseur pour ajuster la valeur du paramètre gamma. La valeur est 
comprise entre 0,5 et 2,6.  

Une valeur basse produit une image plus blanche, tandis qu’une valeur élevée produit 
une image plus sombre. 

10.8.6.6 Revenir au réglage précédent  

Appuyez sur le bouton Revenir aux paramètres précédents , pour réinitialiser les 
paramètres aux valeurs qu’ils avaient au moment d’ouvrir la fenêtre de paramètres. 
Cela n’a aucun effet sur le zoom.  

10.8.6.7 Enregistrer comme paramètres locaux par défaut  

Appuyez sur le bouton Enregistrer en local, , pour enregistrer les paramètres 
actuels comme paramètres par défaut. Toutes les nouvelles procédures démarreront avec 
ces paramètres d’image, à l’exception du zoom.  
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Ces valeurs seront utilisées lorsque vous appuyez sur le bouton Return to Local 
Settings (Revenir aux paramètres locaux).  

10.8.6.8 Revenir aux paramètres locaux  

Appuyez sur le bouton Revenir aux paramètres locaux, , pour charger les 
paramètres locaux par défaut. 

10.8.6.9  Revenir aux paramètres d’usine  

Appuyez sur le bouton Revenir aux paramètres d’usine, , pour charger les 
paramètres par défaut établis par le fabricant. 
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11  Clore les procédures 
Lors de la phase « Close » (Fermeture) de la procédure, il est possible d’examiner les 
détails de la procédure avant d’enregistrer les scans et l’analyse dans la mémoire locale 
du système. 

 
Figure 11-1 : phase « Close » (Fermeture) du mode Acquisition avec la commande « Close procedure » (Fermer la 

procédure) activée. 

Les détails de la configuration, des scans recueillis, des marques et des captures 
d’écran sont affichés pour confirmation. C’est l’occasion d’évaluer les données de la 
phase « Setup » (Configuration) ou de supprimer les scans indésirables avant de clore 
la procédure.  

 
Remarque : Si des informations essentielles nécessaires pour identifier une 

procédure sont manquantes, l’opérateur sera invité à retourner à 
la phase « Setup » (Configuration). 

 
Remarque : Si un scan est initié depuis le contrôleur Makoto®, le mode 

Acquisition reviendra automatiquement à la phase de scan. 
 
Si des modifications sont requises, appuyez sur le bouton « Return to scan » (Revenir 

au scan) ou « Edit » (Modifier), , ou appuyez sur la phase appropriée sur le ruban 
de progression pour modifier la procédure. 

Appuyez sur « Close Procedure » (Fermer la procédure), , confirmez que 
vous souhaitez enregistrer tous les scans dans la mémoire locale et réinitialisez le 
mode Acquisition pour une nouvelle procédure.  

Clore la 
procédure  

Revenir au 
scan  

Modifier les 
informations 
de procédure  
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12  Procédures d’évaluation et d’archivage 
 

 
 

ATTENTION 

La connexion du système Makoto® à un réseau augmente le 
risque que l’équipement soit affecté par des cyberattaques 
provenant du réseau. Le système est conçu pour sécuriser les 
connexions et communications réseau. Cependant, les risques 
liés à une cyberattaque réseau ne peuvent pas être entièrement 
éliminés.   

Consultez la Déclaration du fabricant relative à la sécurité des 
dispositifs médicaux (MDS2) pour gérer les risques liés à la 
cybersécurité et garantir une utilisation sûre et efficace de 
l’appareil dans son environnement d’utilisation prévu. Contactez 
le fournisseur de services pour demander des exemplaires 
supplémentaires de cette déclaration, si nécessaire. 

 
 
 
 
 
 

 

 

Il est possible d’évaluer, d’archiver, de modifier et de supprimer les procédures 
enregistrées précédemment en mode Révision.  

Pour passer en mode Révision depuis le mode Acquisition, appuyez sur le bouton de 
mode Makoto® lorsqu’aucune procédure n’est en cours. 

 

 

 

 

 

 

 

 

 

 

 
  

ATTENTION 

L’utilisation de supports amovibles avec le système Makoto® 
peut exposer le système à des risques logiciels présents sur 
ces supports. Le système est conçu pour sécuriser ces ports de 
supports et n’interagir qu’avec des fichiers reconnus. 
Cependant, les risques liés aux menaces logicielles ne peuvent 
pas être entièrement éliminés. 
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Figure 12-1 : mode Révision affichant la phase « Select » (Sélection). 

En entrant en mode Révision, l’opérateur voit apparaître la phase « Select » (Sélection) 
du flux de travail de révision. Lors de cette phase, l’opérateur sélectionnera les 
procédures et scans sur lesquels effectuer des actions supplémentaires. L'opérateur 
peut choisir de modifier, consulter ou supprimer les rapports correspondant à la 
procédure ou aux scans sélectionnés. 

Il est également possible de sélectionner des scans pour les importer dans la mémoire 
locale.  

 

 

12.1  Sélectionner des procédures et scans 
Il est possible de sélectionner des procédures et scans individuels pour effectuer des 
actions supplémentaires dans la phase « Select » (Sélection) du mode Révision. 

Les données contenues dans le système sont disposées dans trois tableaux, en fonction 
du type d’informations. Il y a un tableau pour les procédures, pour les scans de la 
procédure sélectionnée, et pour les marques et captures d’écran du scan sélectionné. 

Destination 
d’exportation 

Vue  

Importation 

Basculement entre les 
modes du Makoto® 
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Figure 12-2 : phase « Select » (Sélection) du mode Révision avec indication des différentes listes d’informations. 

Les procédures sélectionnées peuvent être consultées ou faire l’objet d’une capture 
d’écran ou d’une exportation des rapports de marques (Mark Reports) vers une clé USB 
ou un DVD. Les procédures cochées peuvent être exportées et consultées. Elles 
peuvent également avoir leurs captures d’écran ou leurs rapports de repères exportés 
si la procédure cochée correspond également la sélection actuelle.   
 

Pour sélectionner une seule procédure, appuyez à n’importe quel endroit sur la ligne 
d’informations de la procédure dans la liste de procédures. La procédure sélectionnée 
devient la sélection actuelle. Les scans de cette procédure s’affichent dans la liste 
de scans.  

Cochez les cases pour sélectionner plusieurs procédures afin d’exporter des lots de 
données depuis le système. 

 

Remarque : Par défaut, les procédures seront classées en commençant par 
la date de procédure la plus récente en haut de la liste. 

 

Remarque : Les scans seront classés par défaut dans l’ordre chronologique, 
le scan le plus ancien étant en haut de la liste. 

 
Remarque : Appuyez sur les en-têtes de colonnes des listes de procédures 

et de scans pour modifier le classement des informations. 

 
Remarque : Lorsqu’une procédure est cochée, tous les scans qu’elle 

contient sont cochés par défaut. 

 

Liste de 
procédures 

Liste de 
scans 

Liste de 
marques 

Historique 
de scans 

Filtre 
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Pour sélectionner plusieurs procédures, appuyez sur la case à cocher à côté des 
informations de la procédure souhaitée. Enlevez les procédures d’une sélection multiple 
en appuyant à nouveau sur la case à cocher. 

Remarque : L’exportation personnalisée n’est possible que pour une seule 
procédure. 

 

12.1.1 Historique de scans 
Les modifications apportées aux scans après la procédure seront enregistrées dans 
l’historique de scans. Ceci inclut les modifications portant sur le nom de scan, les ajouts 
ou suppressions de marques, et les actions d’exportation ou d’archivage. 

 

12.1.2 Filtrer la liste de procédures 
Entre l’archivage de routine et la suppression des données du système, le catalogue de 
procédures enregistrées peut devenir fort long. Utilisez un filtre par terme pour réduire 
le nombre d’entrées affichées dans la liste de procédures et faciliter la sélection.  

 

  
Figure 12-3 : phase « Select » (Sélection) avec filtre appliqué aux listes de procédures et de scans pour les entrées 

contenant le mot « Sample ». 

 

Saisissez un court volume de texte dans la case de filtre, cela réduira la liste à un 
nombre d’entrées plus facilement gérable.  

Le système recherchera ces caractères dans les ID de procédure, noms de patients, 
ID de patients, noms de médecins, références de lot de cathéter ou notes de scan. 

Appuyez sur Effacer, , pour revenir à la liste complète des procédures. 

 

12.1.3 Modifier la procédure 
Vous pouvez modifier les informations de procédures ou de patients pour rectifier ou 
mettre à jour des informations. Dans la liste de procédures comprenant la sélection 

Modifier la 
procédure 



Makoto® Système d’imagerie intravasculaire 
Guide d’utilisation 

   
IFU0163rS.fr (2025-06-27)  12-5 

actuelle, appuyez sur l’icône Modifier, , pour ouvrir la fenêtre « Edit Procedure » 
(Modifier la procédure). 

Les détails de la procédure actuelle s’affichent dans la fenêtre « Edit Procedure » 
(Modifier la procédure). Utilisez les commandes disponibles pour mettre à jour 
les champs.  

 

 
Figure 12-4 : phase « Select » (Sélection) avec fenêtre « Edit Procedure » (Modifier la procédure) ouverte. 

 

Appuyez sur « Save » (Enregistrer), , pour enregistrer les modifications et fermer 

la fenêtre. Appuyez sur « Cancel » (Annuler), , pour fermer la fenêtre sans 
enregistrer les modifications.  

 

Remarque : Les modifications apportées à la procédure affecteront tous les 
scans associés à la procédure dans le système. Ceci inclut les 
scans non cochés. 

 
Remarque : Affichez la procédure pour modifier les détails de scans inclus 

dans la procédure sélectionnée. 

 

 

Save 
(Enregistrer) 

Cancel 
(Annuler) 
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12.1.4  Afficher  
Pour afficher, modifier, analyser et supprimer des scans inclus dans la procédure 

actuellement sélectionnée, appuyez sur le bouton « View » (Afficher), . Ceci 
charge tous les scans de la procédure actuellement sélectionnée dans la phase 
« View » (Visualisation) du mode Révision. 

Vous pouvez naviguer, afficher, modifier et supprimer la procédure et les scans de la 
même manière que dans la phase « Scan » (Numérisation) du mode Acquisition.  

Reportez-vous à la section 10 Révision, mesure et annotation de scans pour plus 
d’informations et de conseils. 

 
Figure 12-5 : phase « View » (Visualisation) du mode Révision (fonctionnalités optionnelles SmartImaging™ activées). 

 
Remarque : Les modifications apportées aux marques, régions, mesures et 

annotations lors de la phase « View » (Visualisation) seront 
intégrées aux données de procédure enregistrées lorsque vous 
revenez à la phase de sélection. 

 

Appuyez sur « Select » (Sélectionner), , sur le ruban de progression ou sur le 
bouton de sélection de mode Makoto® pour revenir à la phase de sélection du mode 
Révision. 

 

12.2 Exportation et archivage 
Le Makoto® Système d’imagerie intravasculaire offre plusieurs méthodes et formats 
d’exportation des données depuis le système. Vous disposez de deux méthodes 
rapides configurables pour l’exportation et d’une méthode d’exportation personnalisée. 
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Il est possible d’exporter une ou plusieurs procédures sélectionnées depuis le système, 
à des fins d’archivage ou pour toute autre utilisation. Après avoir sélectionné les 
procédures souhaitées, utilisez le bouton « Export Destination » (Destination 
d’exportation) pour démarrer le transfert de données. 

 

 
Figure 12-6 : phase « Select » (Sélection) avec indication des boutons de destination d’exportation. 

 
Lorsque l’exportation est terminée, la liste de scans est actualisée et indique la 
destination d’archivage dans la colonne « Archive Status » (État d’archivage). 

 

12.2.1 Configurer les destinations d’exportation 
Les formats d’exportation et la compression par défaut peuvent être configurés pour les 
destinations PACS et supports amovibles (USB/DVD).  

Reportez-vous aux sections 12.2.2 et 12.2.3 pour plus d’informations sur la 
configuration de ces paramètres par défaut. 

 
 

12.2.2 Exportation PACS 
 

 
AVERTISSEMENT 

Assurez-vous que les câbles provenant du Makoto® Système 
d’imagerie intravasculaire ou y étant branchés sont bien à plat 
sur le sol. 

 
Les données issues du Makoto® Système d’imagerie intravasculaire peuvent être 
stockées sur le système PACS de l’hôpital si les systèmes ont été correctement 

PACS 

Supports 
amovibles 
(USB/DVD) 

Personnalisé 
(USB/DVD) 

Boutons de 
destination 

d’exportation 

Archive 
Status (État 
d’archivage) 
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configurés. Les systèmes PACS acceptent les données formatées selon la 
norme DICOM. 

Le système est conçu pour fonctionner soit en mode « hors ligne », soit connecté à un 
réseau hospitalier sécurisé afin de permettre le transfert direct des données du système 
d’imagerie intravasculaire Makoto® vers une solution de stockage en réseau telle que le 
PACS.. Raccordez un câble blindé Cat5e au connecteur PACS ou un câble 
d’intégration mobile Infraredx au connecteur pour rayons X du côté droit de la console 
Makoto®. 

Configurez les paramètres de connexion PACS en suivant les conseils fournis à la 
section 14 Paramètres système. 

Appuyez sur le bouton PACS, , pour commencer le transfert des procédures 
cochées vers la destination configurée. 

 

ATTENTION 

La connexion à des réseaux informatiques, y compris d’autres 
équipements, peut entraîner des risques jusque-là non identifiés 
pour les patients, opérateurs et tiers. 

 

ATTENTION 

 
Les modifications apportées au réseau informatique peuvent 
entraîner de nouveaux risques exigeant des analyses 
supplémentaires. Les modifications du réseau informatique 
incluent : 

• modifications de la configuration réseau ; 

• connexion d’éléments supplémentaires ; 

• déconnexion d’éléments ; 

• mises à jour d’équipements ; 

• mises à niveau d’équipements. 
 

 

 

 

 

 

ATTENTION 

Le client est tenu d’identifier, analyser, évaluer et contrôler les 
risques liés à la connexion du Makoto® Système d’imagerie 
intravasculaire à un réseau informatique. 
 
Consultez la Déclaration du fabricant relative à la sécurité des 
dispositifs médicaux (MDS2) pour gérer les risques liés à la 
cybersécurité et garantir une utilisation sûre et efficace de 
l’appareil dans son environnement d’utilisation prévu. Contactez 
le fournisseur de services pour demander des exemplaires 
supplémentaires de cette déclaration, si nécessaire. 
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12.2.3 Exportation vers des supports amovibles (USB/DVD) 
Les données issues du Makoto® Système d’imagerie intravasculaire peuvent être 
exportées vers des supports amovibles, USB ou supports Blu-Ray/DVD/CD 
inscriptibles. 

 
Figure 12-7 : panneau pour supports amovibles du Makoto® Système d’imagerie intravasculaire 

 

REMARQUE : Évitez d’insérer un support amovible dans le système pendant 
la réalisation d’un scan. 

 

Le système vérifiera automatiquement la présence de supports amovibles dans les 
ports USB et le lecteur optique du système.  

Vérifiez les sélections de procédures et de scans ainsi que la taille totale d’exportation. 
Confirmez les formats de fichier d’exportation.  

Si la taille d’exportation souhaitée est inférieure à l’espace disponible sur le support de 
destination de l’exportation, appuyez sur le support souhaité pour commencer 
l’exportation. Si la taille d’exportation estimée est trop importante pour le support, 
révisez les formats et la sélection de procédures afin de réduire la taille de l’exportation. 

 

  
Figure 12-8 : fenêtre d’exportation vers un support amovible. 

Décochez des scans individuels ou des procédures entières pour réduire la 
taille d’exportation. 

Reportez-vous à la section 14.11 pour plus d’informations sur la configuration et la 
modification des formats d’exportation par défaut. 

Espace 
disponible sur 
le support de 
destination 

Taille estimée 
de l’exportation 

Sélection de 
procédures et 

de scans 

Modifier le 
format 

d’exportation 

Blu-Ray/DVD/CD 
USB 3.0 
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Remarque : Un disque de support optique de la session ouverte peut être 
créé ; il acceptera plusieurs exportations en décochant 
« Finalize disc » (Finaliser le disque) dans les options 
d’exportation USB/DVD décrites à la section 14.11. 

 

12.2.4 Exportation personnalisée 
Les données issues du Makoto® Système d’imagerie intravasculaire peuvent être 
exportées vers des supports amovibles de manière personnalisée. Cette méthode 
d’exportation implique de sélectionner ou de confirmer les formats de données et la 
destination de stockage. Cette méthode permet également à l’utilisateur de supprimer 
les identifiants souhaités de l’ensemble de données. 

 

ATTENTION 

Les informations d’identification incluses dans le texte des 
annotations d’image ou de scans ne seront pas modifiées. 

 
Remarque : L’exportation personnalisée est utile pour les exportations de 

données inhabituelles ou pour des applications de recherche qui 
exigent l’anonymat. 

 
Remarque : L’exportation personnalisée n’est possible que pour exporter 

une seule procédure. 

 

Sélectionnez les procédures et scans souhaités en appuyant sur leurs entrées dans les 
listes de procédures et de scans. Appuyez sur le bouton d’exportation personnalisée, 

, pour ouvrir la fenêtre d’exportation personnalisée.  
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Figure 12-9 : fenêtre d’exportation personnalisée permettant de définir des types et des formats de données pour 

l’exportation vers des supports amovibles. 

Confirmez les derniers paramètres de format de données utilisés pour les supports 
amovibles ou modifiez si nécessaire pour cette exportation. Consultez la section 14.11 
pour plus d’informations sur les types et formats de données.  
 
Consultez la section 14.11.3 pour en savoir plus sur la finalisation des supports 
optiques. 
 
Si le lecteur DICOM désiré nécessite que le DICOMDIR soit écrit au niveau de la racine 
du support amovible, cochez l’option « Export files to root directory (top level) of target 
media » (Exporter les fichiers vers le répertoire racine (niveau maximal) du support 
cible). Cette option nécessite que le support cible soit vide. 
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Figure 12-10 : fenêtre d’exportation personnalisée pour configurer des emplacements de stockage réseau alternatifs. 

Si les données d’exportation personnalisée sont transférées en passant par le réseau, 
confirmez ou modifiez les fichiers de données DICOM et les paramètres de compression. 
Configurez un serveur PACS alternatif pour transférer les données personnalisées.  

 

Remarque : Les éléments PACS à inclure et les paramètres PACS utilisés 
pour une exportation personnalisée n’affecteront pas les 
paramètres standards d’exportation PACS. 

 

Remarque : De nombreux programmes d’analyse capables d’analyser des 
données issues du système Makoto® acceptent le transfert 
réseau d’informations DICOM. Utilisez l’exportation 
personnalisée pour configurer l’adresse réseau des postes 
d’analyse si elle diffère du PACS des dossiers médicaux de 
l’hôpital. 
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Figure 12-11 : fenêtre d’exportation personnalisée pour l’anonymisation des données de procédure. 

Rendez les données anonymes en utilisant les fonctions « Anonymize » (Anonymiser). 
Cochez la case « Anonymize » (Anonymiser) et saisissez les informations alternatives 
souhaitées. 

 

REMARQUE : L’anonymisation ne modifie pas les données originales qui 
restent dans le système. 

 

REMARQUE : Les fonctions d’anonymisation n’affectent pas l’heure de 
procédure ou toute note, commentaire ou annotation effectués 
au niveau des scans. 

 

REMARQUE : Les fonctions d’anonymisation permettent de masquer le nom 
et la date de naissance du patient, mais n’ont pas d’impact sur 
le reste du contenu des captures d’écran. 
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Figure 12-12 : fenêtre d’exportation personnalisée avec une exportation de scan vers support USB en cours. 

Vérifiez la taille des données à exporter pour vous assurer qu’elles pourront être 
contenues sur le support de destination. Modifiez vos sélections si nécessaire. 

Appuyez sur le support amovible de destination pour démarrer le transfert vers la 
destination avec les types, formats et compressions de fichiers qui ont été configurés.  

 

12.3  Importer des données 
Il est possible d’importer les données de procédures et de scans sur le Makoto® 
Système d’imagerie intravasculaire pour les visionner, modifier, mesurer et réexporter.  

 

REMARQUE : Les données archivées au format TVC peuvent être importées 
sur tout Makoto® Système d’imagerie intravasculaire ayant un 
numéro de modèle compatible pour être visionnées 
ultérieurement. 

 

Le Makoto® Système d’imagerie intravasculaire accepte les données au format TVC 
(*.tvc de TVC-MC10 ou TVC-MC9) ou les données d’exportation TVC (*.zip de TVC-
MC8 ou TVC-MC8x) générées par ce système ou un autre système d’imagerie TVC. 
Ces données peuvent être importées depuis des sources Blu-Ray, DVD ou USB. 

 

REMARQUE : Les données importées des systèmes TVC-MC10 ou TVC-
MC10i peuvent faire l’objet d’un calcul automatique des 
mesures de surface lors de leur visualisation, si elles sont 
équipées de la fonctionnalité SmartImaging™. 
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12.3.1 Conflits d’importation 
Si les données existent déjà ou que les données de scan de procédure ou de patient 
importées sont similaires aux données déjà présentes dans le système, une intervention 
supplémentaire de l’utilisateur peut être nécessaire pour terminer cette action. 

La résolution de conflit aura lieu après que toutes les tentatives d’importation ont été 
traitées. Cela permettra de résoudre tous les conflits en une fois et de faciliter 
grandement l’importation par lot. 

 
Figure 12-13 : message de conflit d’importation. Écrasez ou annulez l’importation du fichier pour résoudre le conflit. 

Lorsque le message de conflit d’importation s’affiche, vous pouvez choisir : 

« Import » Pour passer à la résolution du conflit. S’il n’y a aucune modification  
(Importer) de données de procédure ou de patient, le fichier existant sur le 

système est écrasé. S’il y a des modifications de données de 
procédure ou de patient, l’utilisateur doit prendre une décision pour 
les informations concernées. 

Ou  

« Skip » (Passer) Ce conflit d’importation sera passé et l’utilisateur devra résoudre 
d’autres conflits liés au lot importé. 
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Figure 12-14 : message de résolution de conflit d’importation. 

Si l’utilisateur décide de résoudre le conflit d’importation et que des informations de 
procédure ou de patient ont été modifiées, l’utilisateur doit choisir : 

« Use Import » Pour utiliser les informations de procédure et de patient du fichier  
(Utiliser le fichier importé. Cette décision s’appliquera aux autres scans importés  
importé) pour cette procédure lors de l’importation de lot ET modifiera 

tous les scans déjà présents sur le système et appartenant à la 
même procédure. 

Ou  

« Use Existing » Pour utiliser les informations de procédure et de patient déjà  
(Utiliser le fichier  présentes dans la mémoire du système pour modifier le fichier  
existant) importé. Cette décision s’appliquera aux autres scans importés 

pour cette procédure lors de cette importation de lot. 

Ou 

« Skip » (Passer) Ce conflit d’importation sera passé et l’utilisateur devra résoudre 
d’autres conflits liés au lot importé. 

 

Sélectionner « Import » (Importer) importera ces données de procédure conformément 
à la sélection. 
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12.4  Supprimer des scans et procédures 
Vous pouvez supprimer des procédures et scans stockés sur le système pour libérer de 
l’espace disponible dans la mémoire locale. 

Vous pouvez supprimer des procédures entières, une à la fois, depuis la phase 
« Select » (Sélection) du mode Révision. Appuyez sur la procédure pour la 

sélectionner, puis appuyez sur le bouton « Delete » (Supprimer), . Vous devrez 
confirmer cette action, car la suppression ne peut pas être annulée.  

 

ATTENTION 

La suppression de données du système est définitive et NE 
PEUT PAS être annulée. 

 

Vous pouvez supprimer des scans lors de la phase « View » (Visualisation) ou « Scan » 
(Numérisation) en supprimant les scans individuellement en ouvrant la fenêtre « Scan 
Edit » (Modifier le scan). Reportez-vous à la section 10.2.12 Supprimer le scan pour 
davantage d’informations et de conseils sur cette fonction.  

 
REMARQUE : Il n’est pas possible de supprimer le dernier scan d’une 

procédure lors de la phase « View » (Visualisation). Revenez 
à la phase « Select » (Sélection) et supprimez la procédure 
pour effacer totalement la procédure du système.  

 

REMARQUE : Supprimer un scan effacera toutes les captures d’écran et 
mesures associées. 

 

Le Makoto® Système d’imagerie intravasculaire n’est pas conçu pour constituer un 
emplacement permanent de stockage de données. Le client est fortement encouragé à 
établir un plan de sauvegarde et d’archivage incluant la suppression périodique des 
données du système. 

 

ATTENTION 

Le Makoto® Système d’imagerie intravasculaire n’est pas 
destiné à servir d’emplacement permanent de stockage de 
données ou d’archivage. 
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13  Guide d’utilisation électronique  
Le guide d'utilisation du système d'imagerie intravasculaire Makoto® (le présent 
document) peut être consulté électroniquement sur les écrans du système.   
 

REMARQUE : Le guide d'utilisation électronique n'est disponible que sur 
certains marchés 

 
REMARQUE : Voir la section 14.4 des paramètres système pour sélectionner 

la langue 
 

REMARQUE : Le réglage de la langue ne peut être activé que par le service 
technique sur site ou l’administrateur du site 

 

13.1  Accès au guide d'utilisation électronique 

L'utilisateur peut accéder au guide d'utilisation en touchant ou en cliquant sur l'icône « 
Help » (Aide) qui apparaît dans la fenêtre « Log In » (Connexion) ou en accédant aux 
menu « Settings and Tools » (Paramètres et outils) lorsque celui-ci est disponible. 
 

 
Figure 13-1 : Fenêtre de connexion au système (à gauche) et menu « Settings and tools » (Paramètres et outils) (à droite) 
où se trouve l'option « Help » (Aide)Langue du guide d’utilisation 
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Figure 13-2 : Interface de consultation du guide d'utilisation électronique 

 
La langue du guide d’utilisation électronique peut être modifiée par rapport à la langue 
par défaut vers toute autre langue installée. Sélectionnez la langue souhaitée dans la 
liste déroulante en haut de la fenêtre. 
 

REMARQUE : Le guide d’utilisation électronique est disponible uniquement 
dans certaines langues. 

 
REMARQUE : Voir la section 14.4 des paramètres système pour sélectionner 

la langue par défaut du guide d’utilisation qui sera affichée. 
 

13.2 Navigation dans le guide de l'utilisateur 

Une fois le guide de l’utilisateur ouvert, vous pouvez y naviguer de manière intuitive. Le 
document contient de nombreux liens permettant d’accéder rapidement aux sections 
recherchées. Outre les liens intégrés (par exemple les entrées de la table des matières 
ou les références à d’autres sections), vous pouvez saisir, augmenter ou diminuer les 
numéros de page, ou faire défiler les pages à l’aide des boutons ou de la molette de la 
souris grâce aux commandes disponibles. Il est également possible d’effectuer des 
recherches dans le texte. 
Touchez ou cliquez sur « Close » (Fermeture) pour revenir à l’écran précédent.
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14  Paramètres système 
 

 
ATTENTION 

La connexion du système Makoto® à un réseau augmente le 
risque que l’équipement soit affecté par des cyberattaques 
provenant du réseau. Le système est conçu pour sécuriser les 
connexions et communications réseau. Cependant, les risques 
liés à une cyberattaque réseau ne peuvent pas être entièrement 
éliminés.   

Consultez la Déclaration du fabricant relative à la sécurité des 
dispositifs médicaux (MDS2) pour gérer les risques liés à la 
cybersécurité et garantir une utilisation sûre et efficace de 
l’appareil dans son environnement d’utilisation prévu. Contactez 
le fournisseur de services pour demander des exemplaires 
supplémentaires de cette déclaration, si nécessaire. 

 
 
 
 
 

 
 
 
 

 
 

Figure 14-1. Menu « Settings and Tools » (Paramètres et outils). 

 
Il est possible de configurer les paramètres locaux du Makoto® Système d’imagerie 
intravasculaire pour répondre aux besoins de l’utilisateur. L’utilisateur peut configurer 
les paramètres de communication réseau, les formats d’exportation par défaut, ajuster 
les paramètres d’affichage et accéder aux utilitaires de diagnostic du système. 

 
ATTENTION 

L’utilisation de supports amovibles avec le système Makoto® 
peut exposer le système à des risques logiciels présents sur 
ces supports. Le système est conçu pour sécuriser ces ports de 
supports et n’interagir qu’avec des fichiers reconnus. 
Cependant, les risques liés aux menaces logicielles ne peuvent 
pas être entièrement éliminés. 
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Figure 14-2 : paramètres système, section « About » (À propos de). 

 

 
REMARQUE : 

L’utilisateur doit appuyer sur « Save » (Enregistrer), , 
pour que les modifications apportées aux paramètres 
soient appliquées. 
 

 
REMARQUE : Les figures de cette section sont visibles pour les utilisateurs 

disposant de droits d'Administrateur. Certains paramètres sont 
restreints en raison des niveaux de permission de l'utilisateur 
actif. 

 

14.1 About (À propos de)  
Cette section des paramètres système fournit des informations sur le numéro de modèle du 
système ainsi que les numéros de version des logiciels installés actuellement. 

Les informations de contact du fournisseur et/ou prestataire de service du client sont 
disponibles à cet emplacement. 

 

14.2  Audit Trail 
Cette section est accessible aux utilisateurs disposant de droits d'Administrateur. Cette 
section fournit un affichage des événements de connexion, de déconnexion et de 
gestion des utilisateurs pour chaque utilisateur du système pendant les plages de dates 
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spécifiées. Le journal d'audit des connexions et déconnexions du système peut être 
exporté sur un support amovible disponible au format *.csv.  

14.3 Features (Fonctionnalités) 

Cette section est réservée aux utilisateurs ayant le rôle d’administrateur. Elle offre aux 
administrateurs système des contrôles pour activer les clés de licence des ensembles 
de fonctionnalités optionnelles.   

 
Figure 14-3 : Paramètres système, section Features (Fonctionnalités) 

14.3.1 Importation de fichiers de licence 

Les administrateurs système peuvent importer des fichiers de licence pour les 
ensembles de fonctionnalités qu’ils ont obtenus en insérant un support amovible 
contenant la clé de licence dans le lecteur USB ou DVD/Blu-ray™.  Toutes les clés de 
licence compatibles reconnues par le système apparaîtront dans la zone « Import 
Licence » (Importer une licence) de l’écran.  Pour importer la licence et activer la 
fonctionnalité, sélectionnez le fichier de clé de licence, puis appuyez sur « Import » 
(Importer). 
 

REMARQUE : Les fonctionnalités peuvent ne pas être approuvées sur tous 
les marchés 

 

14.3.2 Suppresion des fichiers de licence 

Les administrateurs système peuvent supprimer les fichiers de licence pour des 
ensembles de fonctionnalités. La suppression du fichier de licence désactivera les 
fonctionnalités optionnelles associées sur le système. 
 

REMARQUE : La suppression des fichiers de licence SmartImaging™ 
empêche l'application de la fonctionnalité à toute analyse 
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supplémentaire sur le système. Les résultats de 
SmartImaging™ déjà appliqués restent accessibles à 
l'utilisateur. 

 

14.4 Instructions  

14.4.1 Langue par défaut du guide d’utilisation 

 

 
Figure 14-4  Définition de la langue par défaut pour le manuel d'instructions électronique. 

 
La langue par défaut du guide d’utilisation électronique peut être définie par 
l’administrateur système en sélectionnant la langue souhaitée dans la liste déroulante 
en haut de la fenêtre. Appuyez sur Save (Enregistrer) pour valider la modification de ce 
paramètre par défaut. 
 

REMARQUE : Le guide d'utilisation électronique est disponible uniquement 
dans certaines langues. 

 
Des langues supplémentaires ou des instructions mises à jour peuvent être fournies par 
le fabricant ou le prestataire de service du système. Celles-ci seront disponibles sous 
forme de fichier électronique dans un format reconnu par le système.   Insérez le 
support amovible contenant le fichier dans le lecteur USB ou DVD/Blu-ray™, 
sélectionnez le fichier, puis appuyez ou cliquez sur « Install » (Installer). 
 

14.5 Liste de travail de modalité 
Vous pouvez configurer l’emplacement réseau et les identifiants de connexion de la 
liste de travail des modalités en remplissant les champs de cette section. 
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Figure 14-5 : paramètres système, « Modality Worklist » (Liste de travail de modalité). 

 

14.5.1 Paramètres de connexion serveur de la liste de travail des modalités 
Pour utiliser les options de configuration de la procédure semi-automatique de Liste de 
travail de modalité, l'adresse réseau du serveur de la liste de travail doit être configurée. 
Pour configurer l'adresse, entrez les informations suivantes : 
 IP L’adresse de protocole Internet, version 4 du serveur de la 

liste de travail. 

 Port Le port de communication sur lequel le serveur de la liste de 
travail communiquera. Il s’agit généralement du port 104. 

 « Name » (Nom) Le nom de réseau du serveur de la liste de travail. 

 Client Le nom utilisé pour identifier le Makoto® Système d’imagerie 
intravasculaire sur le réseau.  

 

Appuyez sur « Test Connection » (Tester la connexion), , pour vous 
assurer que le serveur de la liste de travail et le Makoto® Système d’imagerie 
intravasculaire peuvent communiquer. Contactez votre agent de service ou le service 
client Infraredx pour obtenir une assistance pour la configuration. 

14.6 PACS 
Cette section des paramètres système vous permet de configurer les types de données 
ainsi que l’emplacement et les identifiants du serveur PACS. 
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Figure 14-6 : paramètres système, section « PACS ». 

14.6.1 Éléments de données à inclure 
Le Makoto® Système d’imagerie intravasculaire permet de générer plusieurs types de 
données et de rapports.  

Ces types et formats de fichiers sont décrits dans le tableau ci-dessous : 

Tableau 14-1 : types et formats de fichiers de données disponibles 

Type de fichier Formats disponibles  
 DICOM Standard Description 

NIRS-IVUS Oui *.avi Une boucle des images transversales 
enregistrées des données NIRS et 
IVUS.  
Les enregistrements en direct d’IVUS 
ou d’images ne produiront que des 
images d’IVUS ou en niveaux de gris. 
 

IVUS Oui *.avi Une boucle des images transversales 
enregistrées des données IVUS 
uniquement. 
 

Rapport Oui *.pdf Un rapport résumant les informations 
du patient, les détails de la procédure, 
les annotations, les mesures, les 
régions et les marques. 
 

TVC Non *.tvc Un fichier contenant les données NIRS 
et IVUS au format natif du système. 
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Type de fichier Formats disponibles  
 DICOM Standard Description 

 
Capture d’écran Oui *.png Captures d’écran générées par le 

système et enregistrées par 
l’utilisateur. 

 

14.6.2 Compression JPEG 
Les paramètres de compression du format de données DICOM peuvent être ajustés 
pour améliorer la qualité d’image ou réduire la taille du fichier de données. 

Le Makoto® Système d’imagerie intravasculaire offre une compression JPEG pour 
produire des fichiers images à compression faible, moyenne ou élevée.  

 
Tableau 14-2. Paramètres de compression DICOM 

Paramètre de 
compression 

Qualité 
d’image 

Paramètre de 
qualité d’image 

Taille de fichier 

 (qualitative) (1-100) (qualitative) 

Bas Très 
élevée 

100 Large 

Moyen Élevée 80 Moyenne 
Élevé Bon 50 Petite 

 

14.6.3 Interprétation photométrique pour les fichiers couleur DICOM 
La norme DICOM propose différentes méthodes d’encodage des informations d’images 
couleur. Le Makoto® Système d’imagerie intravasculaire vous permet de choisir 
« RGB » ou « YBR Full 422 ».  
 

14.6.4 Adaptateur réseau 
Vous trouverez dans cette section des informations relatives aux adaptateurs réseau du 
système d’imagerie intégré Makoto® qui peuvent être utiles pour connecter le système 
au réseau de l'hôpital. 
 

14.6.5 Paramètres de connexion au serveur PACS 
Pour utiliser l’option d’exportation PACS, il est nécessaire de configurer l’adresse réseau 
du serveur PACS. Pour configurer l’adresse, saisissez les informations suivantes : 

 IP L’adresse de protocole Internet, version 4 du PACS. 

 Port Le port de communication sur lequel le PACS 
communiquera. Il s’agit généralement du port 104. 

 « Name » (Nom) Le nom de réseau du serveur PACS. 
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 Client Le nom utilisé pour identifier le Makoto® Système d’imagerie 
intravasculaire sur le réseau. 

 « Enable TLS » Activer ou désactiver l’utilisation d’identifiants sécurisés pour  
 (Activer TLS) accéder au PACS. Si cette option est activée, fournissez le 

mot de passe et le certificat requis. 

 

Appuyez sur « Test Connection » (Tester la connexion), , pour vous 
assurer que le PACS et le Makoto® Système d’imagerie intravasculaire peuvent 
communiquer. Contactez votre agent de service ou le service client Infraredx pour 
obtenir une assistance pour la configuration. 

 

14.7 Champs requis 
La phase « Setup » (Configuration) du système peut être configurée de manière à ce 
que certains champs doivent être remplis avant de fermer une procédure ou de modifier 
les informations relatives à des procédures terminées. Il est possible de définir un 
champ comme requis en le sélectionnant dans la liste « Not Required » (Non requis) et 
en cliquant ou en appuyant sur le bouton « Add >> » (Ajouter >>). Sélectionnez des 
champs dans la liste « Required » (Requis) et en cliquant ou en appuyant sur « << 
Remove » (<< Retirer) pour réduire les exigences. 

 
Figure 14-7 : paramètres système, section « Required Fields » (Champs requis). 

 

14.8  Affichage des scans 
La section « Scan Display » (Affichage des scans) des paramètres système permet de 
personnaliser certains aspects visuels des phases « Scan » (Numérisation) et « View » 
(Visualisation).  
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Figure 14-8 : paramètres système, section « Scan Display » (Affichage des scans). 

14.8.1 Mesures transversales 
Utilisez ce bouton pour afficher ou masquer les mesures et les résultats transversaux 
sur l’affichage. Le fait de réduire les résultats de mesure masquera également les 
contours des mesures. Lorsque vous ouvrez des scans pour les examiner, les mesures 
seront masquées et les résultats seront réduits.  

14.8.2 Plage d’images de la révision du flux lumineux 
Utilisez cette commande pour modifier la plage d'images jouées lorsque la fonction de 
révision du flux lumineux est activée, voir section 10.3.2 Révision de la lumière.  

14.8.3 Visibilité longitudinale du chemogram du niveau du bloc 
La visibilité du chemogram au niveau du bloc peut être modifiée en fonction des 
préférences de l’utilisateur. Ces changements deviendront les paramètres par défaut 
pour les nouveaux scans enregistrés. La visibilité du chemogram au niveau du bloc sur 
chaque scan peut être définie en modifiant les propriétés du scan, section 10.2 
Modification des scans. 
 

REMARQUE : Pour ajuster la visibilité du chemogram longitudinal au niveau 
du bloc sur un scan, consultez la section 10.2 Modification des 
scans. 

 

14.8.4 Visibilité transversale du bloc du chemogram 
La visibilité du chemogram au niveau du bloc au centre de l’IVUS transversal peut être 
modifiée en fonction des préférences de l’utilisateur. Ces changements deviendront les 
paramètres par défaut pour les nouveaux scans enregistrés. La visibilité du chemogram 
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au niveau du bloc sur chaque scan peut être définie en modifiant les propriétés du scan, 
section 10.2 Modification des scans. 
 

REMARQUE : Pour ajuster la visibilité du chemogram au niveau du bloc sur 
l’image de l’IVUS transversal d’un scan, consultez la section 
10.2 Modification des scans. 

 

14.8.5 « mx LCBI Window Size » (Taille de fenêtre du LCBI max) 
Utilisez cette commande pour modifier la taille de fenêtre du LCBI max du scan par 
défaut sur l'écran. Les résultats du LCBI max dans les rapports seront générés à l'aide 
du réglage actuel de la taille de fenêtre du LCBI max. Cette valeur peut être réglée à 
l’aide du curseur entre 1 mm et 10 mm par incréments de 1 mm.  
 

REMARQUE : Pour ajuster la fenêtre mxLCBI sur un scan, consultez la 
section 10.2 Modification des scans. 

14.8.6 Afficher le cathéter-guide 
Utilisez cette commande pour définir la visibilité par défaut du masque du cathéter-
guide automatique. 
 

14.8.7 Seuils d’images 

Utilisez cette commande pour définir les seuils par défaut de mxLCBI et de charge de 
plaque (Plaque Burden) à afficher sur l’écran Indicateur d’état.   
 

14.9  Assistance technique 
Cette section des paramètres système permet de configurer l’exportation des fichiers 
journaux du système. Ces fichiers fournissent des informations utiles aux techniciens de 
maintenance pour diagnostiquer les problèmes de performances du système.  
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Figure 14-9 : paramètres système, section « Support » (Assistance technique). 

Définissez la plage de dates souhaitée à l’aide des contrôles fournis, décidez de 
l’inclusion des fichiers de données et de résultats SST améliorés, puis choisissez la 
destination où les fichiers seront copiés. 
Les fichiers générés par cet utilitaire ne contiennent aucune information de santé 
protégée. 

 

14.10 Système 
Cet ensemble de paramètres permet de configurer le fonctionnement du système ou les 
paramètres d'étiquetage. Certaines modifications de ces paramètres nécessiteront un 
redémarrage du système pour être activées. 
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Figure 14-10 : paramètres système, section « System options » (Options du système). 

14.10.1 Nom de l'établissement 
Utilisez ce champ pour configurer le nom de l'établissement tel qu'il apparaîtra dans 
l'en-tête des fichiers DICOM ou d'autres rapports générés par le système.  

14.10.2 Format de la date 
Utilisez cette option pour configurer le format de date affiché par le système à l'écran et 
dans les rapports.  

14.10.3 Délai d'inactivité 
Utilisez cette option pour configurer le temps d'inactivité du système avant que le 
système ne déconnecte automatiquement l'utilisateur actif. 
Le système ne se déconnecte pas automatiquement pendant une procédure active.  

14.10.4 Fichier DICOM unique de captures d'écran 
Utilisez cette option pour rassembler toutes les captures d'écran enregistrées pour un 
examen dans une seule pile d'images DICOM. 

14.10.5 Méthode de transfert DICOM 
Le système d’imagerie intégré Makoto® a la capacité de transférer ou de communiquer 
des fichiers DICOM à un PACS de deux manières. La première méthode est activée par 
défaut. Certains systèmes PACS sont limités dans les méthodes de communication 
PACS qui seront acceptées. Cochez cette option pour utiliser la méthode de 
communication alternative pour les transferts PACS. 
Cette méthode de communication n'a pas d'impact sur le contenu du fichier DICOM 
transféré. 

14.10.6 Activer le contrôle à distance 
Utilisez cette option pour permettre à l'interface utilisateur du système Makoto® de 
contrôler certains mouvements du contrôleur Makoto® et du cathéter attaché. 
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14.11 USB/DVD (supports amovibles) 
Vous pouvez configurer les options de formats de données par défaut à enregistrer 
pour les supports amovibles dans cette section des paramètres système. 

 
Figure 14-11 : paramètres système, section « USB/DVD ». 

14.11.1 Formats DICOM à inclure 
Les formats DICOM disponibles, décrits dans le Tableau 14-1 ci-dessus, sont 
également disponibles pour l’exportation vers des supports amovibles. Il est possible 
d’associer l’exportation de formats de fichiers DICOM et standards en une seule action 
d’exportation. 

14.11.2 Formats standards à inclure 
Outre les types de fichiers de données uniquement disponibles en format DICOM, vous 
pouvez sélectionner des types de fichiers de données supplémentaires en format 
standard (non DICOM). 

Les formats standards peuvent être plus adaptés à la présentation, la création ou le 
visionnage lorsque les outils DICOM ne sont pas disponibles. 

14.11.2.1 Compression AVI 
Les paramètres de compression avi des données IVUS ou IVUS+NIRS sont définis sur 
les codecs suivants : XviD.  

14.11.3 Supports optiques 
L’enregistrement multisession est pris en charge lors de l’exportation sur supports 
optiques (CD, DVD, Blu-ray™). Décochez « Finalyze disc » (Finaliser le disque) pour 
permettre des exportations supplémentaires vers le même support. 
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14.12 Gestion des utilisateurs 
Cette section est accessible aux utilisateurs disposant de droits d'Administrateur. Cette 
section des paramètres permet de gérer les listes d'utilisateurs, de modifier les 
autorisations des utilisateurs, de définir ou de modifier les mots de passe ou de 
répliquer les profils d'utilisateurs sur d'autres systèmes d’imagerie intégrés Makoto®. 

  
Figure 14-12 : paramètres système, section « User Management » (Gestion des utilisateurs). Gérer les utilisateurs (à 
gauche) et Importer/Exporter des utilisateurs (à droite). 

14.12.1 Gérer les utilisateurs 
La liste des utilisateurs enregistrés peut être consultée et modifiée. Les Administrateurs 
sont autorisés à ajouter, supprimer ou modifier les profils des utilisateurs. 

14.12.1.1 Ajouter un utilisateur 

14.12.1.1.1 Nom d’utilisateur 

Le nom d’utilisateur doit comporter au minimum un caractère et ne pas être un doublon 
d’un autre nom d’utilisateur déjà enregistré.  

14.12.1.1.2 Rôles 

Profil Administrateur 

Ce profil est établi pour créer et maintenir d'autres profils d'utilisateurs établis. Le profil 

Administrateur peut configurer tous les paramètres du système accessibles à 

l'établissement, y compris la connectivité du PACS et de la liste de travail de modalité. 

Le profil Administrateur a accès à toutes les données patient du système et peut 

importer et exporter des données. 

Profil Standard 

Il s'agit du profil utilisé par les utilisateurs types du système d'imagerie intégré 

Makoto®. Ces utilisateurs doivent fournir des identifiants de connexion valides. Ce profil 

peut avoir un accès limité à certaines options de configuration du système. Les 

données patient peuvent être consultées et importées ou exportées vers des 

destinations configurées. 
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Profil Anonyme 

Il s'agit du profil utilisé lorsqu'une connexion valide n'est pas effectuée en raison de 

l'utilisation de la fonction « Skip » (Saut). Ce profil n'a pas le droit de visualiser d'autres 

procédures ou données patient sur le système, en dehors des données collectées 

pendant la séance active en cours. La configuration des paramètres du système et les 

options d'exportation des données sont limitées. 

Profil Service 

Un profil défini en usine pour les ingénieurs de service est préconfiguré. Ce profil est 

accessible au personnel de service autorisé dans le but de configurer le Makoto® pour 

l'établissement ou de restaurer les profils Administrateurs. 

 

14.12.1.1.3 Mot de passe 

Les mots de passe doivent être configurés avec l’aide d’un utilisateur ayant le rôle 
d’administrateur. Si un utilisateur standard oublie son mot de passe, il peut toujours 
enregistrer les informations de procédure en contournant la connexion. Cependant, 
l’accès aux données antérieures et aux fonctions de transfert sera limité. Avec l’aide de 
l’administrateur du système, le mot de passe de l’utilisateur standard peut être 
réinitialisé. Si un administrateur doit réinitialiser son mot de passe et qu’aucun autre 
utilisateur n’a le rôle d’administrateur, veuillez contacter votre représentant de service 
pour assistance. 
 

 
ATTENTION 

Il est fortement recommandé que l'administrateur Makoto® 
mette en œuvre et applique des exigences en matière de 
robustesse des mots de passe conformes aux politiques de 
sécurité de son établissement pour ce type d'équipement 
médical. 
 

 

14.12.1.2 Supprimer un utilisateur 

Les utilisateurs ayant un profil de type « Administrateur » peuvent supprimer d’autres 
profils utilisateurs. L’administrateur actuellement connecté ne peut pas supprimer le 
profil en cours d’utilisation. 

14.12.1.3 Modifier un utilisateur 

Les utilisateurs ayant un profil de type « Administrateur » peuvent modifier d’autres 
profils utilisateurs. Les administrateurs peuvent modifier le rôle des autres utilisateurs et 
activer l’attribution des mots de passe. 
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14.12.2 Importer/exporter des utilisateurs 

14.12.2.1 Importer des utilisateurs 

Le système analysera les supports connectés à la recherche de fichiers valides de base 

de données utilisateur Makoto®. Pour importer un fichier de base de données utilisateur 

depuis un autre système d'imagerie Makoto®, sélectionnez la base de données souhaitée 

dans la liste disponible en cliquant ou en touchant le nom du fichier, puis cliquez ou 

touchez « Import » (Importer). Tout nouvel utilisateur trouvé dans le fichier de base de 

données sera ajouté au système. 

14.12.2.2 Exporter des utilisateurs 

Touchez la destination du support amovible pour effectuer une sauvegarde des profils 

utilisateur contenus dans le système. Ce fichier peut être utilisé pour répliquer les profils 

utilisateur sur d'autres systèmes d’imagerie Makoto® afin de garantir des informations 

d'identification utilisateur communes à tous les Makoto® gérés par l'institution. 
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15  Intégration de l’exportation vidéo et du système 
à rayons X 

 

  
ATTENTION 

La connexion du système Makoto® à un réseau augmente le 
risque que l’équipement soit affecté par des cyberattaques 
provenant du réseau. Le système est conçu pour sécuriser les 
connexions et communications réseau. Cependant, les risques 
liés à une cyberattaque réseau ne peuvent pas être entièrement 
éliminés. 

Consultez la Déclaration du fabricant relative à la sécurité des 
dispositifs médicaux (MDS2) pour gérer les risques liés à la 
cybersécurité et garantir une utilisation sûre et efficace de 
l’appareil dans son environnement d’utilisation prévu. Contactez 
le fournisseur de services pour demander des exemplaires 
supplémentaires de cette déclaration, si nécessaire. 

 

Le Makoto® Système d’imagerie intravasculaire peut transmettre de la vidéo, des 
données ou partager le contrôle avec un système à rayons X fluoroscopique 
compatible. 

L’utilisation des fonctions présentées dans cette section peut impliquer des connexions 
câblées supplémentaires depuis des emplacements fixes vers la console Makoto®.  

 
AVERTISSEMENT 

Assurez-vous que les câbles provenant du Makoto® Système 
d’imagerie intravasculaire ou y étant branchés sont bien à plat 
sur le sol. 

 

15.1 Sortie vidéo numérique 
Il est possible d’exporter le signal vidéo de la console Makoto® en raccordant un moniteur 
externe au système à l’aide d’un câble DVI-D. Le raccordement du câble DVI-D au 
connecteur de sortie vidéo permet d’exporter une image de 1920 x 1080 pixels de l’écran 
du moniteur du médecin.  

De manière optionnelle, il est possible de configurer la résolution de la vidéo exportée à 
1600 x 1200 pixels (rapport d’aspect 4:3), contactez votre agent de service ou le service 
client Infraredx pour obtenir une assistance. 
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Figure 15-1 : panneau d’exportation vidéo et de contrôle du Makoto® Système d’imagerie intravasculaire 

La sortie vidéo DVI-D est située au centre du panneau, il s’agit du troisième connecteur 
en partant de la droite. 
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16  Glossaire des termes 
 

Chemogram au niveau du 
bloc 

Une représentation simplifiée des informations de chemogram, 
segmentée en blocs discrets qui ne dépendent pas des 
informations de position de rotation.  

Chemogram Une carte prenant la forme d’une représentation graphique 
indiquant la probabilité de présence de plaques d’intérêt 
contenant un cœur lipidique. 

Bloc de chemogram Un segment unique du chemogram du niveau du bloc. 

Halo du chemogram Une représentation de la portion du chemogram située au 
niveau d’une image IVUS transversale donnée, qui s’affiche 
avec un anneau de couleur autour de l’IVUS transversale qui 
est enregistrée en rotation. 

Image composée La configuration d’affichage du Makoto® Système d’imagerie 
intravasculaire qui inclut le chemogram, l’IVUS longitudinale et 
l’IVUS transversale avec halo de chemogram. 

Console Le principal composant du Makoto® Système d’imagerie 
intravasculaire ; il contient le laser, le logiciel, l’alimentation 
électrique et l’ordinateur. 

Interface utilisateur de la 
console 

Fournit à l’utilisateur une interface interactive pour collecter ou 
examiner des données à l’aide des boutons de contrôle à 
l’écran.  

Indicateur de spectre Affichage graphique représentant le nombre de spectres 
valides enregistrés lors d’une acquisition de retrait. 

Masque de cathéter de 
guidage 

Inclus dans le progiciel pour détecter automatiquement un 
cathéter guide. Cette fonctionnalité peut être activée et 
désactivée par le médecin. 

Indicateur du fil-guide Une carte permettant au médecin d’identifier de possibles 
artefacts, y compris ceux causés par la présence d’un fil guide. 

Letterbox (panoramique) Un format d’affichage d’informations dans lequel des bandes 
noires apparaissent au-dessus et en dessous du contenu de 
l’image afin de remplir l’écran sans déformer le contenu de 
l’image. 
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Indice de masse du cœur 
lipidique  

Une mesure de la proportion globale de cœur lipidique dans le 
segment artériel scanné sur une échelle de 0 à 1000 (masse 
du cœur lipidique faible à élevée). 

Cordon Le câble permettant de raccorder le contrôleur Makoto® à la 
console Makoto®. 

XviD Un codec de compression de fichier vidéo produisant de petits 
fichiers vidéo faciles à gérer et pouvant être lus sur de 
nombreux lecteurs. 
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17  Entretien 

17.1 Informations relatives au système 
Le système comprend trois composants principaux : une console, un contrôleur (sous-
système de retrait/rotation) et le cathéter. Ces composants sont connectés de manière 
optique, électrique et mécanique. 

Le système est compatible avec les accessoires suivants : 

Câble blindé Cat5e (RÉF PN2690) 

Câble vidéo blindé DVI-D (RÉF PN2665) 

Données intégrées et câble vidéo (RÉF TVC-10PMC) 

Les dispositifs Makoto® Système d’imagerie intravasculaire (TVC-MC10, TVC-MC10i) 
fabriqués par Infraredx®  sont conçus pour une utilisation avec le modèle de cathéter 
suivant : 

Cathéter d'imagerie IVUS+NIRS Dualpro® (RÉF TVC-C195-42) 

Cathéter d’imagerie DualproNIRS™  (REF TVC-C195-42J) 

Cathéter d’imagerie DualproPlus® IVUS+NIRS (REF TVC-C195-52, TVC-C195-52J) 

Cathéter d'imagerie HD-IVUS Clarispro® d’Infraredx (RÉF TVC-E195-42) 

 

REMARQUE : Le cathéter Infraredx Clarispro® HD-IVUS est uniquement 
approuvé sur certains marchés. 

 

REMARQUE : 
Le cathéter d’imagerie DualproPlus® IVUS+NIRS est 
uniquement approuvé sur certains marchés.  

 

REMARQUE : Le DualproNIRS™ est uniquement disponible sur certains 
marchés. 

 

Le système dispose de la fonctionnalité additionnelle suivante : 
 SmartImagingTM       (RÉF TVC-MC10-UPA) 
 

REMARQUE : La fonctionnalité SmartImagingTM est uniquement disponible 
sur certains marchés. 

 
REMARQUE : La fonctionnalité SmartImagingTM peut nécessiter du matériel 

supplémentaire. Veuillez contacter votre fournisseur pour plus 
d'informations. 
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Les caractéristiques de la console du Makoto® Système d’imagerie intravasculaire et du 
contrôleur Makoto® sont détaillées ci-dessous. Les spécifications des cathéters 
d'imagerie se trouvent dans les consignes d'utilisation du cathéter associé, incluses 
dans l'emballage du cathéter. 

 

17.1.1 Caractéristiques physiques 

• La console Makoto® occupe un espace de 61 cm de large, 150 cm de haut et 71 cm de 
profondeur (24" x 56" x 28") (hors câbles et fibres). 

• La console Makoto® comporte quatre roues, dont deux avec blocage de position et 
deux avec blocage de direction. 

• La poignée de la console Makoto® est conçue pour faire rouler la console. La console 
ne peut pas être soulevée par sa poignée. 

• Le contrôleur Makoto® occupe un espace de 12,7 x 15,2 x 43,2 cm (5" x 6" x 17") (hors 
câbles et fibres). 

• Le Makoto® Système d’imagerie intravasculaire  pèse 92 kg (202 lb). 

17.1.2 Environnement 
 
Tableau 17-1 : Conditions environnementales de transport, d’entreposage et d’opération de la console 

 

Type Température °C % d’humidité  
(sans condensation) 

Transport et 
entreposage 

 

 

Opération 
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Tableau 17-2: Conditions environnementales de transport, d’entreposage et d’opération du cathéter 

 

Type Température °C % d’humidité  
(sans condensation) 

Transport 

 

 

Entreposage 

 

N/A 

Opération 

 

N/A 

 

17.1.3 Caractéristiques électriques 

• Le dispositif fonctionne sur une tension secteur nominale de 100 VCA, 120 VCA, 
220 VCA ou 240 VCA, 50 – 60 Hz, monophasé. Le module d’entrée de l’alimentation 
doit être configuré manuellement à une tension d’entrée et une protection par fusibles 
appropriées. Pour une utilisation sur du 100 VCA ou 120 VCA, deux fusibles 3AG 
rapides à haut pouvoir de coupure de 5 A sont utilisés. Pour une utilisation sur du 
240 VCA, deux fusibles 3AG rapides à haut pouvoir de coupure de 3 A sont utilisés.  

• Le dispositif fonctionne sur un seul cordon d’alimentation. 

• Le raccordement électrique est de qualité hospitalière. 

• Le dispositif est un dispositif électrique de classe I. 

• Pièce appliquée à protection de type CF. 

• Le système est capable de transmettre et de recevoir des communications sans fil via le 
protocole de communication Bluetooth®2.0. 

17.1.4 Caractéristiques optiques 

• Le Makoto® Système d’imagerie intravasculaire comprend un laser de classe 1M 
proche-infrarouge. 

• La lumière du laser est transmise de la console au cathéter connecté via le contrôleur 
Makoto® et les câbles de raccordement. 

 

 

17.1.5 le contrôleur du Makoto® 

• Vitesse de rotation = 960, 1800 tr/min, dans le sens antihoraire en regardant la prise de 
connexion. 

• Vitesse longitudinale = 0,5, 1,0, 2,0, 10,0 mm/s.  
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• Amplitude totale du mouvement longitudinal = 155 mm (minimum). 

• Le contrôleur Makoto® fonctionne à l’intérieur d’une barrière stérile intermédiaire de 
contrôleur Makoto®. 

 

17.2 Installation Responsabilités 
Cette section décrit les exigences relatives au site d’installation et le déplacement 
éventuel du système. 

17.2.1 Responsabilités du client 
Le système d'imagerie intravasculaire Makoto® est destiné à être installé dans un 
laboratoire de cathétérisme ou une installation équipée de manière similaire. Avant 
l’installation, il convient de préparer le site prévu comme décrit dans cette section. Le 
site doit disposer d’un espace suffisant pour accueillir le système, garantir une 
configuration et des prises d’alimentation électrique appropriées et se conformer aux 
spécifications environnementales supplémentaires détaillées ci-dessous. 
Il est de la responsabilité du client de s’assurer que la configuration de l’installation du 
Makoto® Système d’imagerie intravasculaire (TVC-MC10) est conforme aux exigences 
applicables décrites dans la norme CEI 60601-1. 

 

17.2.2 Responsabilités du fabricant 
L’installation du Makoto® Système d’imagerie intravasculaire est effectuée par un agent 
de service. Après l’installation, le membre du personnel ou le représentant agréé 
Infraredx donnera aux membres désignés du personnel du laboratoire de cathétérisme 
les instructions élémentaires concernant le fonctionnement de base et l’entretien du 
système. Ces informations viendront en complément des informations plus détaillées 
contenues dans ce manuel. 

 

17.3 Exigences relatives à l’installation 

17.3.1 Exigences liées au site 
Le système d'imagerie intravasculaire Makoto® est conçu pour être utilisé dans un 
laboratoire de cathétérisme type ou une installation équipée de manière similaire.  

REMARQUE :  Les caractéristiques d'émissions de cet équipement permettent de 
l'utiliser dans les zones industrielles et les hôpitaux (CISPR 11 
classe A). S'il est utilisé dans un environnement résidentiel (pour 
lequel la classe B de la norme CISPR 11 est normalement requise), 
cet équipement pourrait ne pas offrir une protection adéquate aux 
services de communication par radiofréquence. L'utilisateur devra 
peut-être prendre des mesures d'atténuation, notamment déplacer ou 
réorienter l'équipement. 
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Dans la plupart des cas, aucune modification particulière d'une installation existante 
n'est nécessaire. 

 

17.3.2 Espace requis 
Il convient de prévoir un espace suffisant au sol pour l’installation du système. Afin de 
laisser un espace suffisant pour le câble d’alimentation et de permettre la circulation de 
l’air provenant de ventilateurs de refroidissement, veillez à laisser un écart d’au moins 
40 cm (15") entre le panneau arrière du système et le mur devant lequel ce dernier 
se trouve.  

 

17.3.3 Système électrique requis 
Le système d'imagerie intravasculaire Makoto® est conçu pour fonctionner avec le 
câblage électrique standard disponible dans un laboratoire de cathétérisme ou une 
installation équipée de manière similaire.  
Le Makoto® Système d’imagerie intravasculaire est équipé d’une borne de terre 
équipotentielle, située à l’arrière de l’appareil. 

 

17.4 Exigences / précautions environnementales 

17.4.1 Qualité de l’air 
Assurez-vous que l’atmosphère n’est pas corrosive et que l’air qui y circule n’est ni salin 
ni acide. L’acide, les agents corrosifs et les matériaux volatiles peuvent attaquer le 
câblage électrique, de même que la surface des composants optiques. 

 

Veillez à maintenir le taux de particules volatiles de poussière au plus bas. Les 
particules de poussière peuvent endommager la surface de l’équipement optique de 
manière irrémédiable. Les poussières métalliques peuvent endommager l’équipement 
électrique. 

 

La console contient un filtre à air. Ce filtre sera inspecté et, si cela s’avère nécessaire, 
nettoyé ou remplacé pendant les maintenances habituelles. 

 

17.5  Informations générales et informations de contact 
En règle générale, le Makoto® Système d’imagerie intravasculaire ne nécessite aucune 
maintenance particulière de la part de l’utilisateur. L’entretien quotidien du contrôleur 
Makoto® et le nettoyage et la désinfection de l’extérieur du système sont abordés à la 
section 17.5.2 Nettoyage et désinfection. 
Les indicateurs de défaut ou d’avertissement et les solutions recommandées sont 
décrits dans la section 17.6 Témoins d’avertissement et de panne. Tout autre travail de 
maintenance ou d’entretien doit être effectué par un agent d’entretien agréé. La 
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maintenance préventive habituelle du système doit être effectuée par un agent 
d’entretien agréé au moins une fois tous les 12 mois. À chaque visite, l’agent de service 
vérifie le bon fonctionnement du système et règle ce dernier en conséquence. 

 

17.5.1 Coordonnées de contact : 
Pour toute demande d’entretien, de maintenance et de remplacement de pièce, veuillez 
contacter votre revendeur et fournisseur de services local, ou appelez Infraredx, Inc. au 
numéro suivant : 1-800-596-3104. 

 

17.5.2 Nettoyage et désinfection 
L’extérieur de la console du Makoto® Système d’imagerie intravasculaire et du 
contrôleur Makoto® peut être nettoyé au moyen d’un chiffon humide imprégné d’une 
solution de savon doux et d’eau. Ne pas utiliser de détergents agressifs. Si vous devez 
désinfecter l’extérieur de la console Makoto® ou du contrôleur Makoto®, vous pouvez à 
cet effet utiliser un chiffon doux imprégné de désinfectant hospitalier. 

ATTENTION 

Pour la gestion des risques hématogènes, les hôpitaux et les 
centres médicaux doivent suivre leur protocole. 

 

ATTENTION 

Il convient de prendre les mesures adéquates afin d’empêcher 
l’entrée de solution nettoyante, de solution saline ou d’autres 
liquides dans le contrôleur ou la console Makoto®.  

 

ATTENTION 

Il convient de prendre les mesures adéquates afin d’empêcher 
la contamination des connecteurs optiques du 
contrôleur Makoto®. Si les connecteurs à fibre optique du 
contrôleur ne peuvent être nettoyés, veuillez contacter votre 
fournisseur de services ou Infraredx pour obtenir plus 
d’informations. 

17.6  Témoins d’avertissement et de panne 
Lorsque vous utilisez le Makoto® Système d’imagerie intravasculaire, le logiciel de 
collecte de données vérifie le lien de communication électrique établi avec le contrôleur 
Makoto® ainsi que la source lumineuse laser. Si les appareils ne sont pas connectés ou 
si la communication avec l’un ou l’autre appareil ne fonctionne pas correctement, le 
logiciel avertit l’utilisateur par un message d’erreur qui apparaît en haut de l’écran. 

Si vous rencontrez ce problème, contactez votre fournisseur de services local ou le 
service clientèle Infraredx. 
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Le Makoto® Système d’imagerie intravasculaire ne comporte aucun autre témoin en 
dehors des témoins d’avertissement ou de panne mentionnés ci-dessus. 
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17.7  Dépannage 
Symptôme Causes possibles Solutions 

Le système ne démarre 
pas 

L’alimentation système n’est 
pas branchée 

Branchez l’alimentation 
système, voir Section 6.1. 

Les fusibles ne fonctionnent 
pas 

Contacter le fournisseur 
de services, voir 
Section 14.1. 

Le système ne reste 
pas allumé 

La batterie du CPU est vide 

Branchez le système à 
une alimentation 
électrique entre les 
utilisations. 

L’alimentation électrique est 
instable 

Essayez une autre prise 
de courant. Prenez 
contact avec le 
fournisseur de services, 
voir section 14.1. 

Rien ne s’affiche sur 
l’écran de la console 

Les écrans sont éteints 

Sur le dessous de l’écran 
destiné au médecin, 
situez et actionnez le 
bouton d’alimentation. 

À l’arrière de l’écran 
destiné au technicien, 
situez et actionnez le 
bouton d’alimentation. 

L’alimentation des écrans n’est 
pas branchée 

Assurez-vous que le 
câble d’alimentation est 
bien connecté à l’écran. 

Contacter le fournisseur 
de services, voir 
Section 14.1. 

Le câble vidéo est déconnecté 
Assurez-vous que le 
câble vidéo est bien 
connecté à l’écran. 

Le sous-système interne de 
distribution vidéo ne 
fonctionne pas 

Contacter le fournisseur 
de services, voir 
Section 14.1. 
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Symptôme Causes possibles Solutions 

Le logiciel du système 
ne démarre pas, un 
message d’erreur 
s’affiche 

Un composant du système n’a 
pas répondu pendant la 
procédure de démarrage. 

Éteignez le système et 
rallumez-le. 

Si le problème persiste, 
contacter le fournisseur 
de services, voir 
Section 14.1. 

Le système d’exploitation ne 
parvient pas à ouvrir un fichier 
de configuration ou de 
données indispensable. 

Éteignez le système et 
rallumez-le. Si le 
problème persiste, 
contacter le fournisseur 
de services, voir 
Section 14.1. 

L’écran tactile ne 
répond pas 

Le câble USB n’est pas bien 
connecté. 

Assurez-vous que le 
câble USB est bien 
connecté. 

La souris est en mouvement. 
Stabilisez la souris ou 
retournez-la. 

Le système n’est pas 
correctement configuré pour la 
sortie vidéo 1600 x 1200 

Contacter le fournisseur 
de services, voir 
Section 14.1. 

Aucun clavier virtuel 
n'apparaît 

Le clavier virtuel est désactivé. 

Cliquez ou appuyez sur 
« Settings » (Paramètres), 
puis sur « Log Out » 
(Déconnexion). Activez le 
clavier sur l'écran de 
connexion. 

Impossible de se 
connecter 

Le nom de l'utilisateur n'est 
pas enregistré. 

Prenez contact avec 
l'Administrateur pour 
enregistrer l'utilisateur. 

Le nom d'utilisateur a été mal 
saisi. 

Entrez à nouveau le nom 
d'utilisateur et le mot de 
passe. 

Mot de passe incorrect fourni 

Saisissez à nouveau le 
mot de passe ou prenez 
contact avec 
l'Administrateur pour 
réinitialiser le mot de 
passe. 
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Symptôme Causes possibles Solutions 

L’interrupteur du Mode 
révision est 
inaccessible 

Une procédure active qui 
utilise les données collectées 
est en cours 

Fermez la procédure, voir 
Section 11. 

Supprimer tous les scans, 
voir Section 10.2.12. 

L’exportation de 
données est 
inaccessible 

Aucune procédure n’est 
sélectionnée 

Sélectionnez des 
procédures, voir 
Section 12.2. 

Autorisations insuffisantes 
pour l'utilisateur 

Prenez contact avec 
l’Administrateur. 

L’exportation 
personnalisée est 
inaccessible 

Plusieurs procédures sont 
sélectionnées 

Ne sélectionnez qu’une 
seule procédure, voir 
Section 12.2.4. 

Autorisations insuffisantes 
pour l'utilisateur 

Prenez contact avec 
l’Administrateur. 

Aucune procédure en 
phase « Select » 
(Sélection) 

Toutes les données ont été 
supprimées du système. 

Lancez plus de 
procédures, voir 
Section 7. 

Importez des données, 
voir Section 12.3. 

Le filtre de recherche n’a pas 
retourné de procédures ou 
de scans. 

Supprimez le filtre de 
recherche, voir 
Section 12.1.2. 

Autorisations insuffisantes 
pour l'utilisateur 

Prenez contact avec 
l’Administrateur. 

Le périphérique de 
stockage USB n’est pas 
reconnu 

Le périphérique est 
incompatible 

Utilisez un autre 
périphérique de 
stockage USB 

Un périphérique crypté tente 
de charger des données ou 
des programmes sur le 
système d’imagerie. 

Utilisez un autre 
périphérique de 
stockage USB. 

Aucune image IVUS 

Niveau du noir trop élevé ou 
autre ajustement incorrect de 
l’image. 
 

Rétablissez les réglages 
d’image d’usine ou réglez 
le niveau du noir, voir 
Section 10.8.6 
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Symptôme Causes possibles Solutions 

Amorçage du cathéter 
insuffisant  

Irriguez le cathéter avec 
un plus grand volume de 
solution saline héparinée  

ou 

Consultez les instructions 
d’utilisation du cathéter. 

Le transducteur du cathéter ne 
fonctionne pas 

Changez le cathéter. 

L’image IVUS est 
sombre ou clignote 

Ajustez les réglages d’image 

Rétablissez les réglages 
d’image d’usine ou réglez 
les paramètres individuels 
de l’image, voir Section 
10.8.6 

Amorçage du cathéter 
insuffisant 

Irriguez le cathéter avec 
un plus grand volume de 
solution saline héparinée  

ou 

Consultez les instructions 
d’utilisation du cathéter. 

L’indicateur du fil-guide 
est d’un blanc uniforme. 

La fibre optique du cathéter 
est endommagée. 

Changez le cathéter. 

Le modèle de fil-guide 
est uniformément noir. 

Le modèle de cathéter ne 
produit pas de chemograms. 

Vérifiez le modèle de 
cathéter et la description 
du produit pour confirmer 
que les données NIRS 
sont générées, voir 
section 4.4. 

Le cathéter ne se 
charge pas ou ne se 
connecte pas 

Le contrôleur n’est pas sur la 
position LOAD (chargement).  

Utilisez les commandes 
de mouvement distal du 
contrôleur Makoto® 
jusqu’à ce que LOAD 
(chargement) apparaisse 
à l’écran. 

Contrôleur mal étalonné. 

Contacter le fournisseur 
de services, voir 
Section 14.1. 
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Symptôme Causes possibles Solutions 

La poignée du cathéter n’est 
pas alignée avec la douille du 
contrôleur. 

Orientez la poignée du 
cathéter avec le bouton 
coloré vers le haut avant 
de l’insérer dans la douille 
du contrôleur Makoto®. 

Le cathéter est connecté alors 
que la séquence de 
réinitialisation automatique est 
en cours. 

Retirez le cathéter de la 
prise du contrôleur, 
laissez la séquence de 
réinitialisation 
automatique se terminer 
et retentez la connexion. 

Le noyau d'imagerie de 
rotation du cathéter n’est pas 
aligné avec la poignée du 
cathéter. 

À l’aide de la partie 
supérieure, faites pivoter 
le noyau de manière à ce 
que les couleurs du noyau 
correspondent à celles 
des boutons. 

Instructions d’utilisation 
introuvables 

Les instructions papier ne sont 
plus fournies avec le système 
Makoto®. 

Appuyez sur Help (Aide) 
sur le Login Screen 
(Écran de connexion) ; 
voir section 6.3 

Appuyez sur Help (Aide) 
dans les Settings 
(Paramètres) ; voir 
section 14 

Le cathéter ne se 
décharge pas ou ne se 
déconnecte pas (le 
noyau rotatif intérieur 
reste connecté après le 
retrait de la poignée) 

Le contrôleur n’est pas en 
position READY (PRÊT) au 
moment de la déconnexion. 

Reconnectez le manche 
du cathéter et placez le 
contrôleur en position 
READY (PRÊT) avant 
d’effectuer la 
déconnexion. 

Les boutons de commande du 
cathéter sont actionnés 
pendant son retrait. 

Reconnectez le manche 
du cathéter, ajustez la 
poignée pour éviter 
d’appuyer sur les boutons 
colorés du manche du 
cathéter pendant la 
déconnexion. 
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Symptôme Causes possibles Solutions 

Retirez le joint de stérilité 
du logement du 
contrôleur. Insérez le 
manche à travers le joint 
et connectez-le au 
logement du contrôleur à 
l’intérieur de la cloison. 
Tentez à nouveau de 
retirer le cathéter. 

Le chemogram ne se 
génère pas 

L’acquisition en direct 
d’images IVUS est en cours. 

Il est impossible de 
générer des chemogram 
pendant l’acquisition en 
direct d’images IVUS. Voir 
Section 9.1. 

Distance de retrait insuffisante 

Relancez l’acquisition du 
retrait automatique avec 
plus de longueur, voir 
Section 9.2.2. 

Excès de signal optique faible 
détecté pendant la 
numérisation. 

Retournez en position 
READY (PRÊT) et 
chargez à nouveau le 
cathéter. Réessayez la 
numérisation. 

Les optiques fibreuses du 
cathéter sont endommagées. 

Changez le cathéter et 
réessayez. 

Panne du composant optique 
du système. 

Contacter le fournisseur 
de services, voir 
Section 14.1. 

Le modèle de cathéter ne 
produit pas de chemograms. 

Vérifiez le modèle de 
cathéter et la description 
du produit pour confirmer 
que les données NIRS 
sont générées, voir 
section 4.4. 

Le chemogram est 
généré de manière 
inattendue 

Le numéro de modèle du 
cathéter HD-IVUS a été mal lu 
ou n'a pas été lu par le sous-
système RFID. 

Remplacez le cathéter par 
un nouveau cathéter HD-
IVUS et réessayez. 
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Symptôme Causes possibles Solutions 

Le chemogram est 
couvert de taches 
noires. 

Artefact d’origine biologique : 
réflexion de thrombus 
excessifs. 

Annulez l’analyse par 
chemogram dans cette 
zone ou relancez 
l’acquisition automatique. 
Voir section 9.3. 

Artefact d’origine non 
biologique : réflexion de 
l’espacement dense des stents 
qui se chevauchent ou des 
stents recouverts. 

Annulez l’analyse par 
chemogram dans cette 
zone ou relancez 
l’acquisition automatique. 
Voir section 9.3. 

Artefact d’origine biologique :  
profondeur sanguine 
excessive 

Annulez l’analyse par 
chemogram dans cette 
zone ou relancez 
l’acquisition automatique. 
Voir section 9.3. 

Optiques fibreuses du 
contrôleur encrassées. 

Contacter le fournisseur 
de services, voir 
Section 14.1. 

Dysfonctionnement du 
contrôleur.  

Contacter le fournisseur 
de services, voir 
Section 14.1. 

Les optiques fibreuses du 
cathéter sont encrassées. 

Changez le cathéter et 
réessayez. 

Les fibres optiques du cathéter 
sont endommagées. 

Changez le cathéter et 
réessayez. 

Le contrôleur ne remet 
pas le noyau d'imagerie 
en position « READY » 
(PRÊT) et ne se 
déplace pas de 
manière distale. 

Le noyau d'imagerie essaie 
d'avancer dans une fenêtre de 
transmission coudée. 

Suivez les consignes à 
l'écran. Redressez les 
coudes et réessayez. 

 

Si le problème persiste, 
remplacez le cathéter et 
réessayez. 
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Symptôme Causes possibles Solutions 

Le noyau d’imagerie du 
cathéter est retenu ou 
endommagé. 

Retirez délicatement la 
poignée du cathéter, puis 
le noyau d'imagerie en 
tirant sur la tige du 
cathéter. 

Suivez les consignes à 
l'écran pour remplacer le 
cathéter. 

Rien ne bouge à 
l’intérieur du contrôleur 
lorsque le moteur 
tourne est que les 
boutons de translation 
sont actionnés 

Le mécanisme d’entraînement 
du contrôleur est usé. 

Contacter le fournisseur 
de services, voir 
Section 14.1. 

Le numéro de lot du 
cathéter n'est pas 
enregistré 
automatiquement 

Le cathéter n'est pas 
programmé avec les 
informations relatives au 
numéro de lot 

Saisissez manuellement 
le numéro de lot figurant 
sur l'emballage du 
cathéter. 

Le numéro de lot du cathéter 
n'est pas lu correctement. 

Saisissez manuellement 
le numéro de lot figurant 
sur l'emballage du 
cathéter. 

 

17.8 Pièces de rechange 
Pour toute information concernant les commandes, veuillez contacter votre fournisseur 
de services local ou Infraredx, Inc. en composant le numéro suivant : 

 +1-800-596-3104.  

 

17.9 Durée de vie du système 
La durée de vie de la console et du contrôleur Makoto® est de 5 ans.. Infraredx 
recommande d'effectuer une maintenance préventive, des réparations et des mises à 
niveau du système si nécessaire. 

17.10 Déclassement du Makoto® Système d’imagerie intravasculaire 
Pour savoir comment déclasser le système en toute sécurité, appelez votre fournisseur 
de services local ou Infraredx au : 

+1-800-596-3104. 
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17.11 Élimination du produit 
Infraredx s'engage à protéger l'environnement naturel et à garantir une utilisation 
continue, sûre et efficace de ce produit grâce à un entretien préventif, des réparations 
et des mises à niveau du système appropriés. Par conséquent, les produits Infraredx 
sont conçus et fabriqués conformément aux directives pertinentes pour la protection de 
l'environnement. Tant que le produit est utilisé et entretenu correctement, il ne présente 
aucun risque pour l'environnement. Cependant, le produit peut contenir des matériaux 
qui pourraient être nocifs pour l'environnement s'ils sont éliminés de manière incorrecte. 
L'utilisation de ces matériaux est essentielle pour les fonctions du produit et sa 
conformité aux exigences légales et autres. 

17.11.1 Élimination finale du produit  
Il est question d'élimination finale lorsque l'utilisateur se débarrasse du produit de 
manière à ce qu'il ne puisse plus être utilisé aux fins prévues. Le retour, l'élimination 
appropriée et la récupération du dispositif médical se font conformément aux exigences 
respectives de la législation nationale. En supposant qu'aucune partie du boîtier du 
système ne soit ouverte et que le système soit utilisé correctement, il n'y a aucun risque 
pour les personnes ou l'environnement. 
 

MISE EN 
GARDE 

Ne jetez pas les pièces de ce produit dans les déchets 
industriels ou ménagers. Le produit contient des matières 
dangereuses qui nécessitent une élimination spéciale. Une 
élimination incorrecte de l'une de ces matériaux peut entraîner 
une grave pollution de l'environnement. 
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18  Annexes 
 

18.1 Annexe A : garantie et informations connexes 
 
La plupart des besoins d’assistance technique qui surviennent au cours de la première année suivant 
l’acquisition du Makoto® Système d’imagerie intravasculaire sont couverts par notre garantie, comme 
l’expliquent les sections suivantes. En ce qui concerne l’assistance qui n’est pas spécifiquement couverte 
par les termes de la garantie Infraredx®, l’assistance sera facturée à l’appel. Pour obtenir une assistance 
technique pour votre Makoto® Système d’imagerie intravasculaire ou pour en savoir plus sur les 
programmes d’assistance technique disponibles, veuillez contacter le service clientèle Infraredx® au 1-
800-596-3104. 

 

Garantie  

Infraredx® garantit que tous les composants standards de son Makoto® Système d’imagerie 
intravasculaire seront exempts de défauts matériels et de fabrication pour une période d’un (1) an. Durant 
cette période de garantie, Infraredx® réparera ou remplacera, à sa discrétion, tous les composants 
défectueux. Un tel remplacement peut inclure des pièces ou des composants remis à neuf. Après la fin 
de la période de garantie initiale ou de toute extension de garantie achetée, les services de réparation 
peuvent être obtenus auprès d’Infraredx® aux tarifs publiés. Infraredx® garantit que le logiciel destiné à 
être utilisé avec l’instrument exécutera correctement ses fonctions s’il est correctement installé. Infraredx® 
fournira toutes les corrections logicielles ou tous les « correctifs de bogue » s’ils sont et lorsqu’ils seront 
disponibles, sans frais, pour une période d’un (1) an après l’installation. Pour le matériel et les logiciels 
installés par le personnel d’Infraredx®, la période de garantie commence à la date d’installation initiale, à 
moins cette date ait été postposée à votre demande. 
Les garanties ci-dessus ne s’appliquent pas aux défauts résultant d’une mauvaise utilisation, d’une 
négligence ou d’un accident, y compris, sans limitation : l’utilisation par des opérateurs non formés ; 
l’utilisation en dehors des prescriptions environnementales relatives à l’instrument ou aux accessoires ; la 
maintenance incorrecte ou inadéquate par l’utilisateur ; l’installation de logiciels ou d’interfaces non fournis 
par Infraredx® ; l’apport de modifications à l’instrument ou au logiciel non autorisées par Infraredx® ; les 
réparations effectuées par quiconque autre qu’Infraredx® ou un agent de réparation agréé par Infraredx®. 
 

Expéditions, retours et réglages au titre de la garantie 
Toute réclamation au titre de la garantie doit être soumise rapidement et doit être reçue par Infraredx® au 
cours de la période de garantie applicable. S’il s’avère nécessaire de nous retourner un produit pour 
réparation et/ou réglage, le client devra obtenir une autorisation de retour de marchandise (ARM) auprès 
du service clientèle d’Infraredx® (1-800-596-3104). Infraredx® informera le client sur la méthode et le lieu 
d’expédition des produits. Tout produit ou composant renvoyé pour examen ou réparation sous garantie 
doit être couvert par une assurance pour l’envoi et payé d’avance, et transiter par le moyen de transport 
spécifié par le service clientèle d’Infraredx®. 
Les frais d’expédition pour tous les produits ou composants remplacés ou réparés sous garantie sont à la 
discrétion de l’acheteur. Dans tous les cas, il relève de la responsabilité exclusive d’Infraredx® de 
déterminer la cause et la nature de la panne d’un produit ou d’un composant, et la décision d’Infraredx à 
cet égard sera irrévocable. 
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Décontamination de l’équipement renvoyé 
Afin de se conformer aux lois des États-Unis sur les services postaux et le transport, l’équipement 
retourné à Infraredx® doit être adéquatement décontaminé au moyen d’un germicide chimique dont 
l’utilisation comme désinfectant hospitalier est approuvée. Si l’équipement reçu n’a pas été décontaminé, 
Infraredx® imputera les frais de nettoyage au client. 
 

Limites 

Cette garantie ne couvre pas les cathéters compatibles, ni les composants de test associés, ni tout autre 
équipement du FEO qui n’est pas inclus dans le système d’imagerie médicale intravasculaire Makoto®. 
Cette garantie ne couvre pas l’étalonnage, le nettoyage ou l’entretien habituel du système. Tout produit 
renvoyé à Infraredx® sans autorisation préalable le sera aux frais de l’expéditeur. Infraredx® se réserve le 
droit de modifier ou d’interrompre ce produit, ses caractéristiques ou son prix, sans préavis. 

 

Indemnisation  

L’acheteur accepte d’indemniser et de tenir Infraredx® à couvert contre toutes actions, poursuites, 
responsabilités, réclamations, amendes, dommages, pertes ou dépenses, y compris les honoraires 
d’avocat raisonnables et les frais de litige (les « pertes ») encourus par ou imposés dans le cadre de 
toutes actions, poursuites, réclamations ou demandes, intentées par des tiers, y compris, sans limitation, 
celles découlant de la violation des lois locales, régionales ou fédérales relatives au produit ou à son 
utilisation, en ce compris les pertes liées à une inspection inadéquate, aux blessures occasionnées à 
quelconque personne ou aux dommages ou à la destruction de toute propriété, à la sélection des 
patients, à l’application, au fonctionnement ou à l’utilisation des produits Infraredx®, y compris l’utilisation 
répétée d’articles à usage unique, sauf pour les pertes résultant de la négligence unique et exclusive 
d’Infraredx®, de ses employés et de ses agents dûment agréés. Aucun agent, employé ou représentant 
d’Infraredx® n’a le pouvoir de modifier ce qui précède, ou d’assumer ou de lier Infraredx® à toute 
responsabilité supplémentaire en rapport avec le produit. 

 

Licences  

Le Makoto® Système d’imagerie intravasculaire  se compose de matériel et de logiciels développés et 
détenus par Infraredx®, Inc. ainsi que de logiciels exploités sous licence par Infraredx® auprès de divers 
concédants de licence de logiciels (« fournisseurs de logiciels d’Infraredx® »). Les logiciels installés 
d’Infraredx® et des fournisseurs de logiciels d’Infraredx®, ainsi que tous les médias, les supports imprimés 
et la documentation « en ligne » ou électronique (« LOGICIEL ») associés sont protégés par les lois et les 
traités internationaux sur le copyright, ainsi que par d’autres lois et traités sur la propriété intellectuelle. Le 
logiciel vous est fourni en vertu d’une licence ou sous-licence non cessible et non exclusive dont vous 
disposez uniquement dans le cadre de l’utilisation de Makoto® Système d’imagerie intravasculaire. Les 
conditions de cette licence peuvent être plus explicitement exposées dans un contrat à part de celui du 
produit. Cette licence ne vous cède aucun titre ni aucun droit de propriété sur le LOGICIEL ou toute partie 
du LOGICIEL. Ce LOGICIEL ne peut être utilisé que sur le Makoto® Système d’imagerie intravasculaire. 
Vous n’êtes pas autorisé(e) à : (1) copier (à des fins autres que la sauvegarde), distribuer, louer, 
concéder ou sous-licencier tout ou partie du LOGICIEL ; (2) modifier ou créer des versions dérivées du 
LOGICIEL ; (3) afficher publiquement la sortie visuelle du LOGICIEL ; ou (4) diffuser le LOGICIEL sur un 
réseau, par téléphone ou par tout autre moyen électronique. Vous acceptez de garder la confidentialité et 
de faire tout ce qui est en votre pouvoir pour prévenir la divulgation ou l’utilisation non autorisée du 
LOGICIEL et pour protéger ce dernier contre toute divulgation ou utilisation non autorisée. Il vous est 
interdit de rétroconcevoir, de décompiler ou de désassembler le LOGICIEL, sauf et uniquement dans la 
mesure où une telle activité est expressément autorisée par la loi en vigueur. 
Infraredx® GARANTIT QU’UN SOIN RAISONNABLE A ÉTÉ MIS DANS LA CONCEPTION ET LA 
FABRICATION DE CE DISPOSITIF. LE LOGICIEL EST FOURNI « TEL QUEL » ET Infraredx® NE 
GARANTIT PAS QUE SON FONCTIONNEMENT SERA ININTERROMPU, EXEMPT D’ERREURS OU 
DE BOGUES. VOUS ASSUMEZ LA TOTALITÉ DU RISQUE EN MATIÈRE DE QUALITÉ 
SATISFAISANTE, DE PERFORMANCES, DE PRÉCISION ET D’EFFORT (Y COMPRIS L’ABSENCE DE 
NÉGLIGENCE). EN OUTRE, IL N’Y A AUCUNE GARANTIE CONTRE LES INTERFÉRENCES À VOTRE 
UTILISATION DU LOGICIEL OU CONTRE LA VIOLATION. LA PRÉSENTE GARANTIE ET LES 
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RECOURS CI-DESSUS REMPLACENT ET EXCLUENT TOUTES LES AUTRES GARANTIES QUI NE 
SONT PAS EXPRESSÉMENT ÉNONCÉES DANS LE PRÉSENT DOCUMENT, QU’ELLES SOIENT 
EXPLICITES OU IMPLICITES PAR L’EFFET DE LA LOI OU DE TOUTE AUTRE MANIÈRE, Y 
COMPRIS, MAIS NON EXCLUSIVEMENT, LES GARANTIES IMPLICITES DE QUALITÉ MARCHANDE 
OU D’ADÉQUATION À UN USAGE PARTICULIER. 
LA MANIPULATION LE STOCKAGE, LE NETTOYAGE ET LA STÉRILISATION DE CE DISPOSITIF 
AINSI QUE D’AUTRES FACTEURS LIÉS AU PATIENT, AU DIAGNOSTIC, AU TRAITEMENT, AUX 
INTERVENTIONS CHIRURGICALES ET À D’AUTRES ÉLÉMENTS ÉCHAPPANT AU CONTRÔLE 
D’INFRAREDX® AFFECTENT DIRECTEMENT LE DISPOSITIF ET LES RÉSULTATS OBTENUS PAR 
SON UTILISATION. INFRAREDX® DÉCLINE TOUTE RESPONSABILITÉ EN CAS DE PERTES, DE 
DOMMAGES OU DE DÉPENSES ACCIDENTELS OU CONSÉCUTIFS, LIÉS DIRECTEMENT OU 
INDIRECTEMENT À L’UTILISATION DE CE PRODUIT (Y COMPRIS, MAIS NON EXCLUSIVEMENT, LA 
PERTE D’USAGE, LES PERTES COMMERCIALES, DE REVENUS, DE BÉNÉFICES, DE DONNÉES 
OU DE TRAVAIL) MÊME SI INFRAREDX® A ÉTÉ INFORMÉE DE LA POSSIBILITÉ DESDITS 
DOMMAGES. INFRAREDX® N’ASSUME, ET N’AUTORISE AUCUNE TIERCE PERSONNE À 
ASSUMER À SA PLACE, AUCUNE AUTRE OBLIGATION OU RESPONSABILITÉ EN LIEN AVEC CE 
DISPOSITIF. 
INFRAREDX® DÉCLINE TOUTE RESPONSABILITÉ À L’ÉGARD DES DISPOSITIFS RÉUTILISÉS, 
RECONDITIONNÉS OU RESTÉRILISÉS ET NE GARANTIT AUCUNEMENT, EXPLICITEMENT OU 
IMPLICITEMENT, Y COMPRIS, MAIS NON EXCLUSIVEMENT, LA QUALITÉ MARCHANDE OU 
L’ADÉQUATION DE CES DISPOSITIFS À UN USAGE PARTICULIER. 

 

Restrictions à l’exportation  

Sauf stipulation contraire de la part d’Infraredx®, si vous exportez le Makoto® Système d’imagerie 
intravasculaire, vous assumez l’entière responsabilité de l’obtention de toute autorisation d’exportation 
requise et êtes tenu de respecter toutes les lois, règles et réglementations en vigueur de toutes les 
autorités gouvernementales, y compris, mais non exclusivement, la loi américaine sur l’administration des 
exportations (Export Administration Act). Vous vous engagez à ne pas exporter ou réexporter les 
données techniques fournies par Infraredx® ou le produit direct de ces données contrevenant aux 
réglementations d’exportation en vigueur. Vous reconnaissez que le logiciel est d’origine américaine. 
Vous acceptez de vous conformer à toutes les lois internationales et nationales en vigueur qui 
s’appliquent au logiciel, y compris les réglementations de l’administration américaine des exportations 
(U.S. Export Administration Regulations), ainsi qu’aux restrictions concernant l’utilisateur final, l’utilisation 
finale et le pays de destination émises par les États-Unis et les autres gouvernements. 
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18.2  Annexe B : résumé des études clinique et ex vivo 
Le système d’imagerie proche infrarouge (PIR) Infraredx a été développé pour identifier les 
plaques d’intérêt contenues dans des cœurs lipidiques (PCL) dans les artères coronaires. 
L’algorithme de détection de PCL de ce système a été développé sur la base de données 
récoltées à partir de cœurs provenant d’autopsies dans le cadre d’une étude ex vivo 
(CDEV3). Parallèlement, des mesures PIR sur des artères coronaires ont été recueillies in 
vivo dans le cadre d’une étude clinique pivot (SPECTACL). L’étude ex vivo a évalué 
prospectivement l’exactitude des relevés PIR par comparaison avec l’histologie, tandis que 
l’étude clinique a évalué prospectivement l’équivalence des mesures in vivo et ex vivo. 
Par la suite, une étude prospective de résultats cliniques in vivo (étude des plaques 
riches en lipides) a été réalisée pour évaluer de manière prospective la capacité des 
lectures NIR à identifier les patients et les segments de vaisseaux à risque 
d'événements cardiaques indésirables majeurs. 
 

 

18.2.1 Étude ex vivo (CDEV3) 
 
Objectif de l’étude 
L’objectif de l’étude ex vivo était d’étalonner et de valider prospectivement le système 
d’imagerie PIR Infraredx pour la détection des PCL. L’étalonnage et la validation du 
système ont été effectués à l’aide d’artères coronaires provenant de cœurs humains 
autopsiés et comparés à l’aide de critères histologiques prédéfinis. 

 
Plan d’étude 
L’étalonnage et la validation du système Infraredx ont été réalisés par la collecte de 
données spectroscopiques et histologiques co-enregistrées de 84 cœurs humains, dont 
33 ont été utilisés pour le processus d’étalonnage et 51 pour la validation finale. 
L’ensemble de données d’étalonnage a été utilisé pour construire un modèle de 
discrimination multivarié afin de détecter la présence de PCL à partir de mesures de 
scan PIR. Ce modèle a ensuite été validé prospectivement en testant sa performance 
de détection des PCL sur l’ensemble de données de validation. 
Pour l’étalonnage comme pour la validation, chaque segment artériel a été installé dans un 
dispositif conçu pour permettre la perfusion de sang et l’enregistrement précis du site de 
mesure PIR ainsi que des sections histologiques qui en découlent. Tous les scans ont été 
réalisés au moyen d’un dispositif automatisé de retrait et de rotation qui tirait l’extrémité 
optique le long de l’artère à 0,5 mm/s et à une vitesse de rotation de 240 tr/min. Les 
spectres individuels ont été recueillis à une fréquence d’environ 40 Hz. Cette configuration, 
avec une longueur moyenne de segment de près de 50 mm, a permis de réaliser l’analyse 
des tissus selon une moyenne de près de 4000 points par segment. 
La PCL a été définie comme un fibroathérome doté d’un cœur lipidique de plus de 
60 degrés d’extension circonférentielle non contiguë, d’une épaisseur moyenne 
supérieure à 200 microns et recouvert d’une coiffe fibreuse d’une épaisseur moyenne 
de 0 à 450 microns. Une section histologique a été analysée à chaque 
section transversale de 2 mm (bloc) d’artère. Les caractéristiques histologiques des 
artères ont été classifiées par un pathologiste selon le schéma de « classification AHA 
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modifiée » (Virmani R, Kolodgie FD, Burke AP, Farb A, Schwartz SM. Lessons From 
Sudden Coronary Death : A Comprehensive Morphological Classification Scheme for 
Atherosclerotic Lesions. Arterioscler Thromb Vasc Biol. 2000; 20(5):1262-1275).  
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Tableau 18-1. Données démographiques sur les donneurs, antécédents médicaux et cause du décès 

Caractéristiques (n = 51) 

Profil démographique   
Homme, n (%) 36 (71) 
Âge moyen +/- écart type, années 65,9 ± 15 

 
Antécédents médicaux, n (%)   

Hypertension 31 (61) 
Fumeur chronique 21 (41) 
Diabète sucré 17 (33) 
Antécédents d’insuffisance cardiaque congestive 16 (31) 
Antécédents de crise cardiaque 11 (22) 
Pontage aorto-coronaire précédent 4 (8) 

 
Cause du décès, n (%)   

Cardiovasculaire 40 (78) 
Non cardiovasculaire   8 (16) 
Inconnu 3 (6) 

 
Critères d’évaluation de l’étude 
L’exactitude du diagnostic du système Infraredx a été évaluée selon trois critères principaux 
de l’étude en utilisant la surface sous la courbe (SSC) de la courbe caractéristique de la 
performance du test (ROC), et ce, pour deux utilisations cliniques : la détection localisée de 
PCL et le calcul de la masse globale du cœur lipidique d’un segment d’artère scanné. 

Critère d’évaluation principal : précision de l’image dans la détection de PCL 
indépendamment de l’épaisseur de la coiffe 
La précision de la détection localisée a été évaluée pour tous les blocs adéquats de 2 mm 
d’artère scannés en utilisant l’analyse ROC des valeurs d’intensité du chemogram par bloc 
par rapport aux comparaisons histologiques appariées pour les blocs ayant un diamètre 
intérieur inférieur ou égal à 3,0 mm. L’intensité du chemogram par bloc correspond au 90e 
centile des pixels du chemogram dans un bloc de 2 mm d’artère scannée, ce qui 
correspond visuellement aux 10 % de pixels les plus jaunes du bloc. La comparaison 
histologique reposait sur la présence ou l’absence de PCL dans chaque bloc de 2 mm. Les 
pourcentages de concordance positive et négative du seuil des valeurs du chemogram par 
bloc ont été calculés à mesure que le seuil a été ajusté à tous les points possibles, en vue 
de balayer la courbe ROC. Ce faisant, la surface sous la courbe (SCC) ROC a également 
été calculée. Pour le critère d’évaluation principal, aucune restriction n’a été fixée quant à 
l’épaisseur de la coiffe de plaque mentionnée dans la définition de la PCL. 

Critère d’évaluation secondaire 1 : précision de l’image dans la détection de PCL avec 
une épaisseur de coiffe <0,45 mm 
Ce critère d’évaluation secondaire reposait sur les mêmes hypothèses et méthodes 
d’analyse que le critère d’évaluation principal, mais limitait la définition de la PCL à ceux 
dotés d’une épaisseur moyenne de coiffe inférieure à 0,45 mm. Les PCL dotées d’une 
épaisseur de coiffe supérieure ou égale à 0,45 mm ont été classifiés dans le groupe négatif. 
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Critère d’évaluation secondaire 2 : Précision de l’Indice de masse du cœur lipidique 
Ce critère d’évaluation secondaire de l’étude de validation CDEV3 étayait une utilisation 
secondaire du système : l’évaluation globale de la masse du cœur lipidique dans un 
segment artériel scanné à l’aide du Lipid Core Burden Index (LCBI). La précision de cette 
mesure a été évaluée pour tous les segments artériels adéquats scannés au moyen de 
l’analyse ROC des valeurs du LCBI par rapport aux comparaisons histologiques appariées. 
Tous les diamètres intérieurs des artères ont été inclus à l’analyse. Le LCBI est une partie 
de pixels du chemogram d’un segment scanné qui possèdent une intensité de plus de 0,6, 
ce qui correspond, sur un plan visuel, au passage du rouge à l’orange foncé sur le 
chemogram. La comparaison histologique reposait sur la présence ou l’absence de 
fibroathéromes quelconques dans le segment scanné. Les pourcentages de concordance 
positive et négative du seuil des valeurs du LCBI ont été calculés à mesure que le seuil a 
été ajusté à tous les points possibles, en vue de balayer la courbe ROC. Ce faisant, la 
surface sous la courbe (SCC) ROC a également été calculée. 

 
Résultats de l’étude 
Pour la détection des PCL, indépendamment de l’épaisseur de la coiffe, l’AUC générale 
du système s’est élevée à 0,80 (zone de confiance de 95 %, 0,76 – 0,85) dans les 
artères d’un diamètre intérieur égal ou inférieur à 3,0 mm. Pour la détection des PCL 
d’une épaisseur de coiffe inférieure à 0,45 mm, l’AUC a également atteint 0,80 (zone de 
confiance de 95 %, 0,76 – 0,84). Pour la détection de la présence d’un fibroathérome le 
long d’un segment d’artère à l’aide du LCBI, l’AUC était de 0,86 (zone de confiance de 
97,5 %, 0,80 – 0,91) pour tous les diamètres d’artères. Le tableau 2 résume les 
résultats de précision des diagnostics pour les trois critères principaux de l’étude. 
Figure 18-1 indique les pourcentages de concordance correspondants en fonction du 
seuil d’intensité du chemogram du bloc (critère principal et critère secondaire 1) ou du 
seuil LCBI (critère secondaire 2). 
 
Tableau 18-2: résultats de précision pour les trois critères de l’étude ex vivo 

Critère de l’étude AUC 

Critère d’évaluation principal : 
Précision de l’image dans la détection de PCL 
indépendamment de l’épaisseur de la coiffe 1 

0,80 (95 % CI : 0,76 - 0,85) 

Critère d’évaluation secondaire 1 : 
Précision de l’image dans la détection de PCL  
avec une épaisseur de coiffe <0,45 mm1 

0,80 (95 % CI : 0,76 - 0,84) 

Critère d’évaluation secondaire 2 : 
Précision de l’Indice de masse du cœur lipidique 2 

0,86 (97,5 % CI : 0,80-
0,91) 

1 51 cœurs, 122 segments, 1909 blocs de 2 mm ; diamètre intérieur moyen ≤3 mm 
2 51 cœurs, 120 segments 
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18.2.2  Étude clinique pivot (SPECTACL) 
Objectif de l’étude 
L’objectif général de l’étude SPECTACL était d’évaluer la similarité des mesures 
obtenues dans des conditions cliniques à celles relevées sur des spécimens autopsiés. 
Les comparaisons histopathologiques n’étaient pas disponibles pour les patients 
cliniques, ce qui a empêché l’évaluation directe de la précision des images 
artérielles PIR in vivo. Ainsi, l’étude a utilisé les données spectrales sous-jacentes aux 
images pour démontrer que les informations recueillies in vivo étaient similaires aux 
informations utilisées dans l’étude ex vivo. 
 
Plan d’étude 
SPECTACL était un essai clinique multicentrique prospectif mené sur des patients 
faisant l’objet d’une intervention coronarienne percutanée facultative ou non urgente 
pour une lésion coronarienne native de novo. Le recrutement incluait des patients 
atteints d’angine stable ou progressive, ainsi que des patients atteints d’un syndrome 
coronarien aigu stabilisé. L’étude clinique SPECTACL a été réalisée dans le but de 
montrer que les caractéristiques spectrales des données acquises chez les patients 
étaient essentiellement similaires aux caractéristiques spectrales des données 
recueillies dans l’étude ex vivo. 
 
Durée de l’étude, sites cliniques et recrutement 
L’étude pivot SPECTACL s’est déroulée sur une période de 21 mois sur 6 sites 
cliniques des États-Unis et du Canada. Au cours de cette période, 106 patients ont été 
recrutés pour l’étude. Des images PIR n’ont pas pu être recueillies chez 17 de ces 
patients, ce qui a réduit l’analyse aux données de 89 patients. Les raisons de l’échec 
de l’acquisition d’images PIR comprenaient l’incapacité de suivre le vaisseau (7), la 
défaillance du dispositif (7), l’erreur de procédure (2) et la mauvaise configuration des 
accessoires (1). 
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Figure 18-1. Courbes ROC (colonne de gauche) et courbes de pourcentages de concordance positive et négative par 
rapport aux seuils de test (colonne de droite) pour les trois critères principaux de l’étude. R. : Critère principal - pas de 
seuil d’épaisseur de la coiffe. Précision du chemogram par rapport à l’histologie par blocs de 2 mm (51 cœurs, 
122 segments et 1909 blocs de 2 mm). Les trois seuils de couleur sur le chemogram par bloc (qui séparent le rouge, 
l’orange foncé, l’orange clair et le jaune) donnent les pourcentages de concordance positive et négative indiqués par les 
cercles. B : critère secondaire 1 - un seuil d’épaisseur de coiffe de 450 microns. C : critère secondaire 2 - précision du 
Lipid Core Burden Index (LCBI) par rapport à l’histologie (51 cœurs, 120 segments). PCP : pourcentage de concordance 
positive. PCN : pourcentage de concordance négative. 

Parmi les 89 patients, les données de 30 d’entre eux ont été dévoilées au cours de 
l’étude clinique aux fins du développement d’algorithmes. En conséquence, l’évaluation 
prospective des similitudes entre les mesures PIR in vivo et ex vivo a été établie sur la 
base des images PIR des 59 patients restants. 
 

Critère d’évaluation principal : AUC = 0,80, 95 % Cl = [0,76-0,85] 

P
C
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100-PCN Seuil du chemogram des blocs 
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Critère d’évaluation secondaire 1 : SCC = 0,80, 95 % Cl = [0,76-0,84] 

P
C
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100-PCN Seuil du chemogram des blocs 

Critère d’évaluation secondaire 2 : SCC = 0,86, 97,5 % Cl = [0,80-0,91] 

P
C

P
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Tableau 18-3 : valeurs démographiques et caractéristiques cliniques de l’étude ex vivo 

 

Caractéristiques sociodémographiques n = 18 cœurs (%) 

 
Âge (années)   

Âge moyen +/- écart type 65 ± 14 
 
Sexe  

Mâle 13 (72) 
 
Race  

Caucasiens 17 (94) 
Afro-américains 0 
Asiatiques 1 (6) 
Originaires des îles du Pacifique 0 
Amérindiens 0 
Autre 0 

 
Historique clinique   
Antécédents familiaux pour les artères coronaires 
maladie   9 (50) 
Hypertension 14 (78) 
Diabète sucré   6 (33) 
Fumeurs   9 (50) 
Antécédents d’infarctus du myocarde 1 (6) 
Accident vasculaire cérébral / attaque ischémique transitoire   9 (50) 
Insuffisance cardiaque congestive   3 (17) 
 
Cause du décès   

Cardiovasculaire 11 (61) 
Non cardiovasculaire   3 (17) 
Inconnu   4 (22) 
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Tableau 18-4 : valeurs démographiques, historique clinique et présentation clinique des patients in vivo 

 

Caractéristiques sociodémographiques 
n = 106 (%) 1 n = 48 (%) 2 

Âge (années)     
Moyen +/- écart type  61,7 ± 10,0 61,4 ± 9,2 

 
Sexe     

Mâle 86 (81) 38 (79) 
 
Race     

Caucasiens 95 (90)  40 (83)  
Afro-américains 5 (5) 2 (4) 
Asiatiques 1 (1) 1 (2) 
Originaires des îles du Pacifique 0 (0) 0 (0) 
Amérindiens 0 (0) 0 (0) 
Autre 4 (4) 4 (8) 
Inconnue / non communiquée  1 (1) 1 (2) 

1 Nombre total de patients recrutés 
2 Nombre de patients dans l’ensemble de validation prospective avec retraits adéquats d’un point de vue spectral 
(voir Résultats de l’étude) 

Historique clinique 
n = 106 (%) n = 48 (%) 

Hyperlipidémie 70 (66)  36 (75) 
Hypertension 74 (70) 36 (75) 
Diabète sucré 23 (22) 11 (23) 
Antécédents d’infarctus du myocarde 16 (15)   5 (10) 
Antécédents d’intervention percutanée  28 (26) 13 (27) 
Pontage aorto-coronaire 3 (3) 0 (0) 
Accident vasculaire cérébral / attaque 
ischémique transitoire 

0 (0) 0 (0) 

Maladie vasculaire périphérique 4 (4) 2 (4) 
Antécédents familiaux pour la maladie 
coronarienne 

46 (43) 19 (40) 

Douleur à la poitrine durant les 7 derniers jours 67 (63) 33 (69) 
Angine stable 54 (51) 27 (56) 
Insuffisance cardiaque congestive 6 (6) 0 (0) 
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Présentation clinique n = 106 n = 48 

Post-infarctus myocardique 15 (14)   8 (17) 

Angine instable 10 (9)   7 (15) 

Angine stable 40 (38) 16 (33) 

Étude fonctionnelle positive 25 (24) 14 (29) 

Douleur atypique à la poitrine 9 (8) 0 (0) 

Insuffisance cardiaque congestive 1 (1) 0 (0) 

Autre 6 (6) 3 (6) 

 
Sécurité 
Bien que l’étude SPECTACL n’ait pas été commandée pour évaluer la sécurité de 
l’instrument Infraredx, la surveillance des événements indésirables a permis de 
s’assurer que le profil d’innocuité était similaire à celui observé avec des cathéters 
similaires. Étant donné la similarité des caractéristiques physiques et de l’utilisation du 
cathéter Infraredx avec celles du cathéter IVUS, l’on s’attendait à ce que les taux et les 
types d’événements indésirables associés au dispositif Infraredx dans 
l’étude SPECTACL soient semblables à ceux relevés dans le cadre de l’expérience bien 
documentée sur les cathéters IVUS dans un groupe de patients ICP similaire. 

 
Critère de l’étude 
Le critère principal de SPECTACL a été évalué de façon prospective en déterminant la 
fraction de patients présentant un retrait semblable à celui des données d’autopsie de 
l’ensemble d’apprentissage de l’algorithme PCL. Les retraits individuels des patients ont 
été jugés semblables à ceux des mesures ex vivo lorsque plus de 80 % des spectres de 
qualité adéquate du retrait atteignaient les seuils des mesures de similarité, tel que 
décrit ci-dessous. 

Adéquation spectrale 
Les retraits inadéquats d’un point de vue spectral ont été jugés de piètre qualité en 
raison d’obstructions ou d’erreurs d’acquisition de données et ont été exclus de 
l’analyse de similarité. L’adéquation spectrale des spectres individuels a été déterminée 
sur la base de plusieurs données aberrantes. Ces données ont été conçues afin 
d’identifier les obstructions dans le trajet du faisceau optique, qui pourraient fausser la 
mesure spectrale. Les obstructions aberrantes comportaient : 

• les spectres collectés lorsque le fil-guide obstruait la paroi artérielle ; 

• les spectres collectés lorsque l’extrémité optique était encore dans le 
cathéter-guide ; 

• les spectres signalés à cause des données d’oscillation (p. ex. en raison 
de mauvaises connexions optiques ou de la présence de microbulles dans 
la solution saline pour l’amorçage des cathéters) ; 

• les spectres signalés par les données de visibilité de la paroi (paroi 
artérielle non visible à cause d’un afflux de sang trop important). 
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En vue d’évaluer la qualité des données, un retrait a été subdivisé en blocs contigus de 
2 mm et chaque bloc a fait l’objet d’une évaluation de l’adéquation spectrale. 
L’adéquation spectrale d’un bloc a été jugée suffisante si plus de 75 % des spectres du 
bloc étaient de bonne qualité. Les retraits étaient à leur tour jugés adéquats d’un point 
de vue spectral si 75 % des blocs de chacun d’entre eux étaient de bonne qualité. 

Similarité spectrale 

Deux mesures multivariées ont été utilisées pour évaluer la similarité entre un spectre et 
ceux de l’ensemble d’étalonnage du modèle : la distance de Mahalanobis (DM) et le 
rapport des variances spectrales (RVS). Le premier est une mesure de la distance 
pondérée par la covariance entre un point et le centre d’un ensemble de points dans un 
espace multidimensionnel. Pour un spectre de prédiction x et le spectre moyen y de 
l’ensemble d’étalonnage, la mesure de la DM est obtenue comme suit (en unités au carré) 
 

),()'( 1 yxSyxMD −−= −

    (1) 

où S-1 est l’inverse de la matrice de covariance de l’ensemble d’apprentissage. Étant donné 
que les données du cas d’utilisation du système sont bimodales (positives ou négatives 
pour les PCL), les DM individuelles ont été calculées en fonction de chaque classe. C’est-
à-dire qu’une DM était calculée sur la base du sous-ensemble de spectres d’étalonnage 
avec une référence PCL positive (DM+), tandis que l’autre était obtenue sur la base du 
sous-ensemble de spectres d’étalonnage avec référence PCL négative (DM-). Un spectre 
de validation donné est attribué à la distance la plus faible des deux (MD+ ou MD-). 

Le RVS est une mesure de la somme des carrés des résidus du spectre de validation 
par rapport à la somme moyenne des carrés de résidus de l’ensemble d’étalonnage. 
Le résidu spectral est la différence entre le spectre estimé construit dans un espace de 
projection dimensionnelle inférieur couvert par le modèle et le spectre réel mesuré. 
Pour les résidus spectraux eval et ecal, respectivement les spectres de validation et 
d’étalonnage (pour l’anglais « calibration »), le RVS est calculé comme suit 
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   (2)  
pour m spectres d’étalonnage et n longueurs d’onde dans un même spectre. 

Un retrait a été considéré comme similaire si un minimum de 80 % des spectres 
adéquats du retrait se trouvait sous les seuils, tant pour la mesure de la DM que celle 
du RVS. Les seuils de la DM et du RVS ont été pris en compte dans l’étalonnage ex 
vivo en tant que paramètres de l’algorithme. 

Vérification des hypothèses 

L’hypothèse nulle à vérifier était : 

H0 : p <= 0,67 

Ha : p > 0,67 
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où p représente la proportion de patients démontrant des similarités spectrales entre les 
relevés cliniques et l’ensemble de données des autopsies. L’hypothèse nulle devait être 
rejetée et, par conséquent, le critère principal était atteint si la limite inférieure de 
l’intervalle de confiance à 95 % dépassait 0,67. 
 

Résultats de l’étude 

Lors de la validation, 59 retraits de patients (un retrait par patient) ont été évalués au 
total. Onze retraits ont été jugés de qualité spectrale inadéquate en raison d’une 
mauvaise connexion optique, de la présence excessive de bulles dans la solution saline 
des cathéters amorcés, de perturbations du flux sanguin ou de l’obscurcissement de la 
paroi artérielle par un excès de sang. Parmi les 48 retraits de qualité suffisante, 40 se 
sont révélés spectralement similaires aux spectres ex vivo, résultant en un taux de 
réussite de 0,83 (intervalle de confiance de 95 %, 0,70 - 0,93). Ce taux de réussite 
répondait au critère principal de l’étude pivot SPECTACL en démontrant que la limite 
inférieure de l’intervalle de confiance de 95 % dépassait 0,67. La Figure 18-2 montre la 
similarité en pourcentage pour chacun des 48 retraits. La ligne pointillée horizontale 
représente une valeur médiane de similarité spectrale (96 %) des retraits. La ligne 
horizontale pleine indique la limite inférieure permettant de déterminer la similarité 
spectrale d’un retrait. 

 
 

 

 

 

 

 

 

 

 

 

Figure 18-2 : Similarité en pourcentage des retraits adéquats. La ligne pointillée représente la similarité médiane en 
pourcentage (96 %). La similarité en pourcentage est définie comme le pourcentage des spectres d’un retrait qui restait 
sous les seuils des mesures de la DM et du RVS. La ligne noire pleine est un seuil minimal de 80 % sous lequel un retrait 
n’était plus considéré comme similaire. Quarante des 48 retraits (0,83) montrent une similarité en pourcentage plus élevée 
que ce seuil. La comparaison des spectres in vivo de l’étude SPECTACL est réalisée en fonction de spectres d’étalonnage 
ex vivo CDEV3 (18 cœurs). 

La Figure 18-3 donne également un autre tracé qui illustre la similarité qui existe entre 
les spectres recueillis sur les patients et ceux mesurés sur les spécimens d’autopsie. 
La figure montre la mesure de la MD pour 1 % au hasard des spectres dans chacun 
des ensembles de données d’étalonnage de CDEV3 (18 cœurs) ainsi que chacun des 
ensembles de données de validation de SPECTACL et de CDEV3. Le recoupement 
significatif entre les différents ensembles de données illustre la similarité entre les 
spectres ex vivo et in vivo mesurés à l’aide du système d’imagerie PIR d’Infraredx.  

Index des patients 
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Figure 18-3 : similarité entre les spectres ex vivo de CDEV3 et in vivo de SPECTACL du point de vue de la DM. Le rouge 
indique une concordance positive de PCL par histologie ; le bleu indique une concordance négative de PCL par 
histologie ; le vert indique l’absence d’histologie. CDEV3 Cal = données du modèle d’étalonnage (18 cœurs, 51 segments, 
790 spectres) ; SPECTACL Val = données de l’étude clinique pivot (48 patients, 48 segments, 1770 spectres) ; 
CDEV3 Val = données de validation (51 cœurs, 126 segments, 3416 spectres). Chaque groupe représente 1 % des spectres 
de chaque ensemble, sélectionné au hasard. 

 
Sécurité 

Dans le cadre de l’étude clinique pivot SPECTACL, des spectres PIR ont été collectés 
chez 89 patients. En combinaison avec les 10 patients scannés lors d’une étude de 
faisabilité préalable, le cathéter d’imagerie PIR a été utilisé sur un total de 99 patients. À 
la suite de ces procédures, aucune corrélation n’a pu être établie entre des événements 
indésirables et l’utilisation du dispositif. 
 

 

 

18.2.3 Étude sur les résultats cliniques (étude des plaques riches en lipides) 
Objectif de l'étude 
L'objectif global de l'étude des plaques riches en lipides était de déterminer, chez des 
patients soumis à une imagerie NIRS-IVUS multivaisseaux, la relation entre les plaques 
riches en lipides détectées par NIRS intracoronaire à des sites non sténosés et la 
prédiction d'événements coronaires ultérieurs à partir de nouvelles lésions coupables, à 
la fois au niveau du patient (patients vulnérables) et du segment (plaque vulnérable). 
Conception de l'étude 
L'étude des plaques riches en lipides est une étude prospective multicentrique menée 
auprès de patients présentant une cardiopathie ischémique stable ou un syndrome 
coronarien aigu stabilisé, examinés par angiographie et imagerie NIRS-IVUS pour 
détecter une ou plusieurs lésions suspectes.  Après une intervention coronarienne 
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percutanée réussie de toutes les lésions limitant le flux angiographique, une imagerie 
intravasculaire avec le cathéter combiné NIRS-IVUS a été réalisée dans au moins deux 
vaisseaux et une longueur minimale de 50 mm d'artère coronaire.  Les données NIRS-
IVUS ont ensuite été envoyées à un laboratoire central pour déterminer la présence ou 
l'absence de plaques riches en lipides.   

 

Tous les patients inscrits présentant un grand nombre de plaques riches en lipides 
(maxLCBI4mm ≥ 250) détectées par NIRS ont été contactés à 2, 6, 12 et 24 mois pour 
déterminer si un nouvel événement coronaire était survenu.  Une moitié des patients 
sélectionnés de manière aléatoire et présentant un nombre de plaques riches en lipides 
faible ou nul (maxLCBI4mm < 250) ont bénéficié d'un suivi identique. 

 

Période d'étude, sites cliniques et recrutement 
Le recrutement pour l'étude des plaques riches en lipides s'est déroulé sur 25 mois 
dans 44 sites cliniques aux États-Unis et en Europe. Au total, 1 563 patients ont été 
inscrits à l'étude au cours de cette période. Les données NIRS n'étaient pas 
analysables chez 11 de ces patients, de sorte que les données de 1 552 patients ont 
été utilisées pour l'analyse primaire.  L'analyse primaire a inclus 1 271 patients qui ont 
été assignés au groupe de suivi. 

 

Hypothèses et résultats de l'étude 
L'étude a été conçue pour tester deux hypothèses primaires avec des critères 
d'évaluation associés. 

 

Hypothèse relative aux patients vulnérables - Au cours d'un suivi de 24 mois après 
l'imagerie NIRS-IVUS, il y aura une association entre la valeur de base de maxLCBI4mm 
(sur tous les segments d'artères coronaires inclus dans l'analyse) et l'incidence des 
événements cardiaques indésirables majeurs sans indice de culpabilité (NC-MACE). 

 

Indicateur de résultat pour les patients vulnérables - Tester l'association entre la valeur 
maxLCBI4mm dans toutes les artères imagées et les futurs événements cardiaques 
indésirables majeurs sans indice de culpabilité. Tout d'abord, un modèle de régression 
univarié des hasards proportionnels dans lequel maxLCBI4mm est la seule variable 
indépendante et NC-MACE est le résultat a été analysé. L'hypothèse nulle a été testée 
par le test de Wald selon lequel le coefficient de régression dans un modèle de 
régression des hasards proportionnels était significativement différent de 0. Cette 
analyse a déterminé si maxLCBI4mm était un facteur de risque de NC-MACE. 

 

Cette analyse univariée a été le test définitif de l'hypothèse primaire du patient 
vulnérable. Dans les analyses de soutien, la validité de l'hypothèse des hasards 
proportionnels a été évaluée. Les hypothèses de hasards proportionnels ont été 
évaluées avant d'exécuter le modèle ; en cas de rejet, l'estimateur de Lin-Wei aurait été 
utilisé pour l'inférence. 
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Après que l'analyse univariée a été jugée positive, une analyse multivariée 
supplémentaire a été réalisée pour évaluer la valeur pronostique supplémentaire de la 
détection des plaques riches en lipides par NIRS par rapport aux mesures 
conventionnelles du risque, en ajustant des modèles de régression des hasards 
proportionnels qui incluent la valeur maxLCBI4mm et d'autres variables pronostiques 
identifiées non liées à l'imagerie NIRS-IVUS. 

 

Pour identifier les variables à inclure dans le modèle multivarié, une régression par 
paliers aveugle aux données NIRS et IVUS a été effectuée pour identifier les facteurs 
pronostiques (y compris, sans s'y limiter, syndrome coronarien aigu, diabète, 
insuffisance rénale, hypertension, âge > 65 ans, sexe masculin, taux de cholestérol 
élevé au départ et taux de cholestérol élevé pendant la période de suivi) autres que les 
données NIRS ou IVUS associés au résultat NC-MACE. Avec ce modèle, la valeur 
maxLCBI4mm a été ajoutée pour évaluer sa valeur pronostique supplémentaire. 

 

Hypothèse relative aux plaques vulnérables - Au cours d'un suivi de 24 mois, il y aura 
une association entre la valeur maxLCBI4mm d'un segment proximal, moyen ou distal 
d'une artère coronaire et l'incidence d'une lésion coupable de suivi dans ce segment 
conduisant à un événement NC-MACE. 

 

Indicateur de résultat pour les plaques vulnérables - Tester l'association entre la valeur 
maxLCBI4mm dans un segment et l'incidence d'un futur NC- MACE dans le même 
segment. 

 

Dans l'hypothèse relative aux plaques vulnérables, chaque segment d'artère coronaire 
est traité comme une unité d'observation distincte. Un participant à l'étude peut fournir 
des résultats pour une moyenne de 12 segments au maximum.  

 
Pour tester cette hypothèse, un modèle de régression des hasards proportionnels a été 
ajusté avec la valeur maxLCBI4mm dans le segment d'artère coronaire comme mesure 
de l'exposition et le NC-MACE pendant 24 mois causé par une nouvelle lésion coupable 
dans ce segment comme résultat. Cette analyse a été effectuée avec un ajustement 
pour l'effet potentiel de regroupement au sein des patients en utilisant la méthodologie 
de Wei, Lin et Weissfeld (WLW).  L'analyse primaire relative aux plaques vulnérables 
était l'analyse univariée déterminant si la valeur maxLCBI4mm est un facteur de risque 
statistiquement significatif pour les événements NC-MACE. 

 
Principaux indicateurs de résultat secondaires - Des critères d'évaluation secondaires 
fondamentaux ont été analysés à la fois pour l'analyse des patients vulnérables et pour 
l'analyse des plaques vulnérables. 

1) Tester l'association entre un seuil de maxLCBI4mm > 400 chez un patient et 
l'incidence des futurs événements NC-MACE. 

2) Tester l'association entre un seuil de maxLCBI4mm > 400 dans un segment 
d'artère coronaire et l'incidence d'un futur événement NC-MACE situé dans ce segment.  
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Résultats 
Les 1 271 patients du groupe de suivi ont eu un suivi moyen de 732 ± 27 jours.  
Caractéristiques de base 
Les caractéristiques de base de la cohorte étudiée étaient typiques des patients 
orientés vers une intervention coronarienne percutanée et sont présentées dans le 
Tableau 18-5. L'âge médian était de 64 ans, 69,5 % étaient des hommes et 36,7 % 
avaient un diabète sucré. L'angine stable avec ou sans épreuve d'effort positive était la 
présentation clinique prédominante des patients. Une intervention coronarienne 
percutanée a été réalisée chez 87,5 % des patients.  
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Tableau 18-5 : Caractéristiques démographiques, cliniques et de présentation des patients 

 
Variable Valeur n ou % 

Âge (années) 64 ± 10,3  1271 

Médiane 64  

Écart interquartile 57-71  

Hommes 883/1271 69,5% 

Diabète 464/1266 36,7%  

Diabète avec insuline 162/1243  13%  

Passé de fumeur 687/1249 55%  

Fumeurs actuels 282/1249  22,6%  

Hypertension 1019/1267 80,4%  

Hyperlipidémie 1013/1261  80,3%  

Antécédents familiaux de coronopathie 782/1386  56,4%  

Précédent d’infarctus du myocarde 294/1253 23,5%  

Précédent d’ICP 569/1267 44,9%  

Présentation clinique   

STEMI stabilisé  32/1271 2,5% 

Non-STEMI 182/1271 14,3% 

Angine instable 468/1271 36,8%  

Angine stable ou test de stress positif 589/1271 46,3% 

IMC 30,2 ± 6,5 1262  

Cholestérol   

Cholestérol total mg/dl 163,5 ± 45,6 875 

LDL mg/dl 91,7 ± 40,4 846 

HDL mg/dl 44,7 ± 15,2 867 

Triglycérides mg/dl 152,3 ± 127,5 859 

Nombre de vaisseaux malades 1 ± 0,7 1227 

<70 % dans une artère épicardique 268/1227 21,8% 

Une 702/1227 57,2% 

Deux 228/1227 18,6% 

Trois 29/1227 2,4% 

ICP réalisée à l’indice# 1111/1270 87,5%  

*Agrégés (valeurs de cholestérol de départ ou premières valeurs de cholestérol dans les 24 mois si le 
patient était sous statines lors de l'inscription). 

#Résumé des ICP dans le Tableau 18-6 et le Tableau 18-7 

Imagerie de départ 
Dans la population suivie, le nombre moyen d'artères scannées par patient était de 2,1 
± 0,5 avec ≥ 50 mm de vaisseau éligible dans 89,5 % des vaisseaux. Dans l'ensemble, 
la longueur totale de l'artère scannée était de 139 ± 45,2 mm et le total des données 
NIRS analysables dans les vaisseaux sans endoprothèse était de 97,8 ± 43,4 mm 
(Tableau 18-6).  La valeur maxLCBI4mm moyenne de ces vaisseaux scannés était de 
359,2 ± 175,1, et 38,8 % des artères scannées avaient une valeur maxLCBI4mm 
supérieure à 400.  Dans la population enrôlée (1 552), la valeur maxLCBI4mm moyenne 
de ces vaisseaux scannés était de 318,7 ± 184,4 et 31,9 % des artères scannées 
avaient une valeur maxLCBI4mm > 400. 
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La longueur moyenne du segment de Ware était de 21,2 ± 9,1 mm, la plupart des 
segments de Ware analysés se trouvant dans l'artère descendante antérieure gauche. 
La valeur maxLCBI4mm moyenne de Ware était de 165 ± 177,1 et chez 11,5 % des 
patients, la valeur maxLCBI4mm était supérieure à 400.  Dans la population inscrite de 
segments de Ware (6 884), la valeur maxLCBI4mm moyenne du segment de Ware était 
de 147,5 ± 169,7. 

 
Tableau 18-6 : Données laboratoires de base, patient 

 
Niveau du patient 

Variable Valeur n ou % 

Valeur maxLCBI4mm au niveau 
du patient dans un scan sélectif 
des artères 

738/1271 58,1% 

Valeur maxLCBI4mm au niveau 
du patient dans un scan non 
sélectif des artères 

533/1271 41,9% 

Artères scannées    

TC  5/1271 0,4%  

IVA  1148/1271  90,3%  

CD  546/1271 43,0%  

CXG  967/1271 76,1%  

≥ 50 mm de vaisseau éligible  1137/1271  89,5%  

Nombre de vaisseaux scannés  2,1 ± 0,5 1271 

Longueur totale des artères 
scannées, mm  

139 ± 45,2 1271 

Longueur total de vaisseau 
éligible, mm*  

97,8 ± 43,4 1271 

maxLCBI4mm au niveau du 
patient  

359,2 ± 175,1  1271 

Médiane  353  

Écart interquartile 257-476  

maxLCBI4mm au niveau du 
patient > 400  

493/1271  38,8%  

Nombre de segments de Ware 5,2 ± 1,8 1271 
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Tableau 18-7 : Données laboratoires de base, segments de vaisseaux 

 
Niveau de segment de Wareǂ 

Variable Valeur n ou % 

Artère scannée   

TC 6/5755 0,1%  

IVA  2656/5755  46,2%  

CD  1277/5755  22,2%  

CXG  1807/5755  31,4%  

Emplacement du segment   

Proximal 2248/5755 39,1% 

Milieu 1927/5755 33,5% 

Distal 1246/5755 21,7% 

Distal éloigné 334/5755 5,8% 

Longueur du segment de Ware    

= 30 mm  2159/5755 37,5% 

< 30 mm  3482/5755 60,5% 

> 30 mm  114/5755 2% 

Longueur du segment de 
Ware (mm)  

21,2 ± 9,1 5755 

maxLCBI4mm au niveau des 
plaques  

165 ± 177,1 5755 

Médiane 113  

Écart interquartile 0-283  

maxLCBI4mm au niveau des 
plaques > 400  

664/5755 11,5% 
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Événements cardiaques indésirables majeurs 
Au cours du suivi de 24 mois, 3 types d'événements ont été suivis. La fonction 
d'incidence cumulée pour les événements cardiaques indésirables majeurs sans indice 
de culpabilité était de 8,8 % (n = 103), les événements cardiaques indésirables majeurs 
avec indice de culpabilité ou avec pose préalable d'une endoprothèse était de 8,7 % (n 
= 104) et les événements avec emplacement coronaire indéterminé étaient de 2,3 % (n 
= 28), Figure 18-4. 
 

 
Figure 18-4 : Fonction d'incidence cumulée par type d’événement cardiaque indésirable majeur.  Événement cardiaque 
indésirable majeur sans indice de culpabilité – 8,8 % ; événement cardiaque indésirable majeur avec indice de culpabilité 
ou pose antérieure d'une endoprothèse – 8,7 % ; événement cardiaque indésirable majeur avec emplacement coronaire 
indéterminé – 2,3 %. 
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Indicateurs de résultat au niveau du patient vulnérable et des plaques vulnérables 
Les corrélations indépendantes d’événement cardiaque indésirable majeur sans indice 
de culpabilité pendant le suivi sont présentées dans le Tableau 3.  Pour la variable 
continue maxLCBI4mm, le rapport de risque ajusté était de 1,17 (IC 95 % [1,04-1,31], 
p=0,005) pour l'apparition d'un NC-MACE dans les 24 mois pour chaque augmentation 
de 100 unités de la valeur maxLCBI4mm.  Les patients dont la valeur maxLCBI4mm était 
supérieure à 400 avaient un rapport de risque ajusté de 1,84 (95 % [1,22-2,77], 
p=0,003) de subir un événement NC-MACE par rapport aux patients dont la valeur était 
inférieure ou égale à 400. 
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Tableau 18-8 : Modèles des hasards proportionnels pour l’indicateur de résultat coprimaire 

 

Niveau du patient vulnérable - modèle des hasards proportionnels de Cox non 
ajusté et ajusté 

Variable Rapport de risque [IC 95 %] 

 maxLCBI4mm continu maxLCBI4mm > 400 

LCBI non ajusté seul 

maxLCBI4mm  1,21 [1,09-1,35] 2,18 [1,48-3,23] 

Modèle ajusté à plusieurs variables 

maxLCBI4mm 1,17 [1,04-1,31] 1,84 [1,22-2,77] 

Âge  0,99 [0,97-1,01] 0,99 [0,97-1,01] 

Hommes  0,81 [0,53-1,23] 0,83 [0,54-1,26] 

Diabète  1,29 [0,85-1,97] 1,29 [0,85-1,97] 

Hypertension  2,13 [1,04-4,34] 2,11 [1,04-4,31] 

Insuffisance rénale 
chronique  

2,00 [1,15-3,49] 2,00 [1,15-3,49] 

Passé de fumeur  1,44 [0,95-2,18] 1,45 [0,96-2,19] 

Précédent d’ICP  1,45 [0,97-2,18] 1,43 [0,96-2,15] 

Présentation avec SCA  1,22 [0,72-2,06] 1,23 [0,73-2,08] 

Niveau des plaques vulnérables - modèles des hasards proportionnels de Cox 
non ajustés et ajustés* 

Variable Rapport de risque [IC 95 %] 

LCBI non ajusté seul 

maxLCBI4mm - continu 1,45 [1,28-1,64] 

maxLCBI4mm > 400 4,12 [2,32-7,32] 

Modèle ajusté à plusieurs variables 

maxLCBI4mm > 400 4,31 [2,37-7,83] 

*Le groupe de patients a été ajusté par la méthode de Wei Lin Weissfeld 
 
Les fonctions d'incidence cumulée estimée pour les patients au-dessus et en dessous 
du seuil maxLCBI4mm pré-spécifié de 400 sont présentées dans le Figure 18-5. 
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Figure 18-5 : Incidence cumulée de NC-MACE au niveau du patient ; inférieur ou égal à 400 - 5,8 % ; supérieur à 400 - 
12,6 %, P<0,001. 

 
Le  

Tableau 18-9 montre l'incidence cumulée de NC-MACE aux points de suivi des patients 
à 2, 6, 12 et 24 mois.  
 

Tableau 18-9 : Incidence cumulée de NC-MACE au niveau du patient (%) 

 

 2 mois 6 mois 12 mois 24 mois 

Patients avec beaucoup de 
plaques riches en lipides 
(maxLCBI4mm >= 400) 
(patients vulnérables) 

1,3 2,5 3,7 5,8 

Patients avec peu ou pas 
de plaques riches en 
lipides (maxLCBI4mm < 400) 

1,6 3,7 6,9 12,6 

 
Au niveau des plaques, le rapport de risque non ajusté de subir un événement ultérieur 
dans un segment coronaire dans les 24 mois était de 1,45 (IC 95 % [1,28-1,64], P 
<0,001) pour chaque augmentation de 100 unités de maxLCBI4mm. Un segment 
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coronaire avec une valeur maxLCBI4mm supérieure à 400 présentait un rapport de 
risque non ajusté de 4,12 (IC 95 % [2,32-7,32], P<0,001). Les fonctions d'incidence 
cumulée pour les segments coronaires supérieurs et inférieurs au seuil maxLCBI4mmpré-
spécifié de 400 sont présentées dans le Figure 18-6.  
 

 
Figure 18-6: Incidence cumulée de NC-MACE au niveau des plaques ; inférieur ou égal à 400 - 0,7 % ; supérieur à 400 - 
3,2 %, P<0,001. 

 
Sécurité 
Au cours de l'étude des plaques riches en lipides, une imagerie NIRS-IVUS a été 
réalisée chez 1 563 patients.  Six patients (0,3 %) ont été jugés par un comité des 
événements cliniques comme étant liés au dispositif. 
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18.4  Annexe D : conformité de sortie acoustique (I) selon la 
norme IEC 60601-2-37:2007 

 
Modèle du système : Makoto® Système d’imagerie intravasculaire  (TVC-MC10) 
Transducteur : Cathéter d’imagerie Dualpro® IVUS+NIRS (TVC-C195-42), cathéter 
d’imagerie DualproNIRS™ (TVC-C195-42J), cathéter d’imagerie DualproPlus® 
IVUS+NIRS (TVC-C195-52 et TVC-C195-52J), ou cathéter d’imagerie Infraredx 
Clarispro® HD-IVUS (TVC-E195-42), 50 MHz  
 
Mode de fonctionnement : mode B  
Cas d’utilisation : vasculaire 
 
Tableau 18-11 : Conformité de sortie acoustique (I) selon la norme IEC 60601-2-37:2007 

 
Modèle des sondes  Type TI  Valeur TI  

(pas d’unité)  
IM  
(pas d’unité)  

TVC-C195-42  TIS  0,43  0,36  

TVC-C195-42J TIS  0.43  0.36  

TVC-E195-42  TIS  0,43  0,36  

TVC-C195-52 TIS  0.43  0.36  

TVC-C195-52J TIS  0.43  0.36  

 
Ces données concernent le cas le plus pessimiste. Étant donné que les valeurs MI et TI 
sont inférieures à 1,0, il n’est pas nécessaire de remplir des tableaux supplémentaires. 
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18.5  Annexe E : tableau de rapport de sortie acoustique (II) pour la 
plage 1 

 

Modèle du système : Makoto® Système d’imagerie intravasculaire  (TVC-MC10) 

Modèle du transducteur :  Cathéter d’imagerie Dualpro® IVUS+NIRS (TVC-C195-42), 
cathéter d’imagerie DualproNIRS™ (TVC-C195-42J), 
cathéter d’imagerie DualproPlus® IVUS+NIRS (TVC-C195-
52 and TVC-C195-52J), ou cathéter d’imagerie Infraredx 
Clarispro® HD-IVUS (TVC-E195-42), 50 MHz   

Mode de fonctionnement :  Mode B 

Application : Intravasculaire 

 
Tablaue 18-12 : Tableau de rapport de sortie acoustique (II) pour la plage 1  

 

Sortie acoustique IM 
Ispta.3

 

(mW/cm2) 

Isppa.3 

(W/cm2) 

Valeur maximale globale 0,36 98 257 

Paramètre 
acoustique associé 

Pr,a  (Mpa) 2.6   

W  (mW)  1,73 1,73 

fc (MHz) 51,97 51,97 51,97 

zsp (cm) 0,1  0,1 

Dimensions de 
faisceau 

x-6 (cm)   0,0123 

y-6 (cm)   0,0317 

PD usec 0,1356  0,1356 

PRF Hz 61 440  61 440 

EDS 
Az. (cm)  0,31  

Elev. (cm)  0,05  

Conditions de 
commande du 
fonctionnement 

Aucun paramètre fonctionnel 
n’affecte la sortie acoustique 
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18.6  Annexe F : tableau d’indications relatives aux ultrasons pour 
l’utilisation de l’appareil 

Modèle du système : Makoto® Système d’imagerie intravasculaire  (TVC-MC10) 
Modèle du transducteur :  Cathéter d’imagerie Dualpro® IVUS+NIRS (TVC-C195-42), 

cathéter d’imagerie DualproNIRS™ (TVC-C195-42J), 
cathéter d’imagerie DualproPlus® IVUS+NIRS (TVC-C195-
52 et TVC-C195-52J), ou cathéter d’imagerie Infraredx 
Clarispro® HD-IVUS (TVC-E195-42), 50 MHz   

 
Tableau 18-13 : Tableau d’indications relatives aux ultrasons pour l’utilisation de l’appareil 

 
Cas d’utilisation clinique Mode de fonctionnement 

Généralités Spécifique B M PWD CWD Couleurs par 
Doppler 

Combiné 
(spécifier) 

Autre* 
(spécifier) 

Ophtalmique Ophtalmique        

Imagerie 
fœtale et 
autres 

Fœtal        

Abdominal        

Intra-opératif 
(spécifier) 

       

Intra-opératif 
(neuro) 

       

Laparoscopique        

Pédiatrique        

Petit organe 
(spécifier) 

       

Néonatal 

Céphalique 

       

Céphalique adulte        

Transrectal        

Transvaginal        

Transurétral        

Transœsophagien 
(non card.) 

       

Musculo-
squelettique 
(conventionnel) 
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Musculo-
squelettique 
(superficiel) 

       

Intravasculaire        

Autre        

Dysfonction 
cardiaque 

Cardiaque adulte X       

Cardiaque 
pédiatrique 

       

Intravasculaire 
(cardiaque) 

X       

Transœsophagien 
(Cardiaque) 

       

Intracardiaque        

Autre (veuillez 
préciser) 

       

Vaisseau 
périphérique 

Vaisseau 
périphérique 

X       

Autre (veuillez 
préciser) 
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18.7  Annexe G : exactitude et précision des mesures 
 
Tableau 18-14 : Exactitude et précision des mesures 

* Moyenne du résultat à des vitesses d’acquisition de retrait automatique minimales 
(0,5 mm/s) et maximales (2,0 mm/s). 

  

Mesure IVUS Critères de specification/acceptation Résultat du test* 

Précision du 
coenregistrem

ent IVUS / 
NIR 

L’écart type des décalages angulaires entre les canaux PIR 
et IVUS est inférieur ou égal à 25 degrés. 

6 degrés 

L’écart type des décalages longitudinaux entre les canaux PIR 
et IVUS est inférieur à 0,5 mm. 

0,17 mm 

Précision des 
mesures IVUS  

Pour les diamètres intérieurs d’artères inférieurs à 5 mm, l’écart 
type du diamètre intérieur mesuré est inférieur ou égal à 

0,125 mm. 

0,10 mm 

Pour les diamètres intérieurs inférieurs ou égaux à 4 mm dans 
le cas de diamètres de vaisseaux inférieurs ou égaux à 7,5 mm, 

l’écart type de l’aire de la section droite mesurée des plaques 
(CSA) doit être inférieur ou égal à 2,79 mm2 en raison des 

incertitudes dans les limites du vaisseau (EEM), des limitations 
de diamètre intérieur et des effets du NURD. 

1,56 mm2 

Exactitude 
des 

mesures IVUS 

Pour les diamètres intérieurs inférieurs ou égaux à 4 mm dans 
le cas de diamètres de vaisseaux inférieurs ou égaux à 7,5 mm, 
la marge d’erreur dans l’exactitude de l’aire de la section droite 
mesurée des plaques (CSA) doit être inférieur ou égal à -9 %, 

+14 % de la valeur mesurée ±0,10 mm2 en raison des 
incertitudes dans les limites du vaisseau (EEM), des limitations 

de diamètre intérieur et des effets du NURD. 

1,74 % 

Pour les diamètres intérieurs compris entre 1,8 mm et 5 mm 
inclus, la marge d’erreur dans l’exactitude de la surface 

intérieure mesurée due à des incertitudes dans les limites de la 
paroi intérieure où l’ultrason ne traverse que le sang doit être 

inférieure ou égale à ±5 % de la mesure ±0,10 mm2. 

1,89 % 

Profondeur 
d’action du 
système 

d’imagerie 

La conception du système doit être compatible avec les 
mesures de structures à des profondeurs pouvant atteindre 

8 mm en termes de longueur, et en termes de surface 200 mm2. 

Succès 
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18.8  Annexe H : conformité électromagnétique 
 

Tableau 18-15 : Conformité électromagnétique 

 

Lignes directrices et déclaration du fabricant – émissions électromagnétiques 

Le modèle TVC-MC10 du Makoto® Système d’imagerie intravasculaire est destiné à être utilisé dans 
l’environnement électromagnétique mentionné ci-dessous. Le client ou l’utilisateur du TVC-MC10 doit 
garantir que l’appareil sera utilisé dans cet environnement. 

Essai 
d’émissions 

Niveau de test Conformité Environnement électromagnétique – 
directives 

Émissions par 
conduction 

CEI/EN 61000-4-6 

150KHz à 
30MHz, 

Classe A 

150KHz à 
30MHz, 

Classe A 

Le Makoto® Système d’imagerie 
intravasculaire TVC-MC10 utilise l’énergie 
des fréquences radio uniquement pour son 
fonctionnement interne. Par conséquent, 
ses émissions RF sont très faibles et ne 
peuvent pas causer d’interférences près 
d’un équipement électronique. 

Émissions 
rayonnées 

CEI/EN 61000-4-3 

30MHz à 
1,8GHz, 

Classe A 

30MHz à 
1,8GHz, 

Classe A 

 

Harmoniques 

CEI/EN 61000-3-
2:2001/A2:2014 

Appareil de 
Classe A 

En vertu de la 
Clause 5 de la 

norme 

Le Makoto® Système d’imagerie 
intravasculaire modèle TVC-MC10 peut 
être utilisé dans tous les établissements 
autres que les établissements 
domestiques ou que les établissements 
directement branchés au réseau de 
distribution public de l’alimentation basse 
tension alimentant en énergie les 
bâtiments utilisés à des fins domestiques. 

Scintillement 

CEI/EN 61000-3-
3:2013 

En vertu de la 
Clause 5 de la 

norme 

En vertu de la 
Clause 5 de la 

norme 

 

Spécifications RFID (transmission / réception) : 

• Fréquence : 902,8 MHz à 927,2 MHz 

• Puissance apparente rayonnée : ≤0,2 W 
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Tableau 18-16 : Lignes directrices et déclaration du fabricant – immunité électromagnétique 

 

Lignes directrices et déclaration du fabricant – immunité électromagnétique 

Le modèle TVC-MC10 du Makoto® Système d’imagerie intravasculaire est destiné à être utilisé dans 
l’environnement électromagnétique mentionné ci-dessous. Le client ou l’utilisateur du TVC-MC10 doit 
garantir que l’appareil sera utilisé dans cet environnement. 

Essai 
d’immunité 

Niveau de 
test 

Niveau de 
conformité 

Environnement électromagnétique – 
directives 

Décharge 
électrostatique 
(ESD) 

CEI 61000-4-2 

±8 kV contact  

±2, 4, 8 et 15kV 
air 

±8 kV contact 

±2, 4, 8 et 15kV 
air 

Les sols doivent être en bois, en béton ou en 
carreaux de céramique. Si les sols sont 
recouverts d’un matériau synthétique, 
l’environnement doit présenter une humidité 
relative de 30 %. 

Coupure / 
sursaut 
électrique 
rapide 

CEI 61000-4-4 

±2 kV pour les 
lignes 
d’alimentation 

±1 kV pour les 
lignes d’entrée 
et de sortie 

5/50  

5KHz et 
100KHz 

±2 kV pour les 
lignes 
d’alimentation 

±1 kV pour les 
lignes d’entrée 
et de sortie 

5/50  

5KHz et 
100KHz 

La qualité du réseau d’alimentation doit être celle 
d’un environnement commercial ou hospitalier 
type. 

Surtension 
(Alimentation 
AC) 

CEI 61000-4-5 

±.5 kV ligne-
ligne 

±2 kV ligne-
terre 

±.5 kV ligne-
ligne 

±2 kV ligne-
terre 

La qualité du réseau d’alimentation doit être celle 
d’un environnement commercial ou hospitalier 
type. 

Creux de 
tension et 
interruptions  

CEI 61000-4-11 

0 % UT pour 0,5 
cycle 

0 % UT pour 1 
cycle  

70 % UT pour 25 
cycles 

0 % UT pour 5 s 

0 % UT pour 0,5 
cycle 

0 % UT pour 1 
cycle  

70 % UT pour 25 
cycles 

0 % UT pour 5 s 

Si l’utilisateur souhaite utiliser le 
Makoto® Système d’imagerie 
intravasculaire TVC-MC10 en continu pendant 
les coupures de courant, il est recommandé que 
le Makoto® Système d’imagerie 
intravasculaire TVC-MC10 soit alimenté par une 
alimentation sans interruption ou par une 
batterie. 

Immunité 
magnétique 

CEI/EN 61000-
4-8 

30 A/m 30 A/m 

Les champs magnétiques de fréquence de 
puissance doivent être aux niveaux 
caractéristiques d’un emplacement typique dans 
un environnement commercial ou hospitalier 
typique. 

Remarque : UT représente la tension secteur en c.a. avant l’application au niveau de test. 
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Tableau 18-17 : Lignes directrices et déclaration du fabricant – immunité électromagnétique 

 

Lignes directrices et déclaration du fabricant – immunité électromagnétique 

Le modèle TVC-MC10 du Makoto® Système d’imagerie intravasculaire est destiné à être utilisé dans 
l’environnement électromagnétique mentionné ci-dessous. Le client ou l’utilisateur du TVC-MC10 doit 
garantir que l’appareil sera utilisé dans cet environnement. 

Essai 
d’immunité 

Niveau de test 
Niveau de 
conformité 

Environnement 
électromagnétique – directives 

Immunité rayonnée 

CEI/EN 61000-4-3 

 

 

 

 

 

Proximité avec 
l’équipement de 
communication RF 
sans fil 

CEI/EN 61000-4-3 

80 MHz à 2,7 
GHz, 3 V/m 

Fréquences 
caractéristiques 
385MHz – 
5,75GHz, 
Modulation par 
impulsions 

 

 

Voir Section 5.3.7 
ou Tableau 9 de 
la norme dont un 
extrait apparaît 
ci-dessous. 

80 MHz to 2.7 
GHz, 3 V/m 

Fréquences 
caractéristiques 
385MHz – 
5.75GHz, 
Modulation par 
impulsions 

 

 

Voir Section 5.3.7 
ou Tableau 9 de 
la norme dont un 
extrait apparaît 
ci-dessous. 

Il est recommandé de respecter, entre 
les équipements de communication RF 
portables et mobiles et le Makoto® 
Système d’imagerie intravasculaire 
modèle TVC-MC10, y compris les 
câbles, la distance de séparation 
recommandée calculée selon l’équation 
applicable à la fréquence de l’émetteur. 

Distance de séparation 
recommandée 

Les distances de séparation minimales 
pour les niveaux de test d’immunité 
supérieurs doivent être calculés à l’aide 
de l’équation suivante : 

𝐸 = (
6

𝑑
)√𝑃 

où P représente la puissance de sortie 
maximale de l’émetteur en watts (W), d 
la distance en m, et E le niveau de test 
d’immunité en V/m. 

Immunité aux 
perturbations 
conduites 

(lignes 
d’alimentation) 

(lignes d’entrée et 
de sortie)  

CEI/EN 61000-4-6 

0,015 - 80 MHz 3 
VRMS et 6 VRMS en 
bande ISM, 
1KHz,  

alimentation AC 

0,015 - 80 MHz 3 
VRMS et 6 VRMS en 
bande ISM, 
1KHz,  

alimentation AC 

Au-delà de la plage de fréquences 150 
kHz-80 MHz, l’intensité du champ doit 
être inférieure à 3 V/m. 

 
 
Tableau 18-18 : Distances de séparation recommandées entre l’équipement de communication portable et mobile à RF 

 

Distances de séparation recommandées entre l’équipement de communication 
portable et mobile à fréquences radio et le Makoto® Système d’imagerie 

intravasculaire TVC-MC10 

Le Makoto® Système d’imagerie intravasculaire TVC-MC10 est destiné à être utilisé dans un 
environnement électromagnétique dans lequel les perturbations dues au rayonnement de fréquences radio 
sont contrôlées. Le client ou l’utilisateur du TVC-MC10 peut protéger l’appareil des interférences 
électromagnétiques en conservant une distance minimale entre l’équipement de communication portable 
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et mobile à fréquences radio (émetteurs) et le Makoto® Système d’imagerie intravasculaire TVC-MC10, tel 
que recommandé ci-dessous, en fonction de la puissance de sortie maximale de l’équipement de 
communication. Ce tableau est tiré de la norme CEI/EN 61000-4-3. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  



Makoto® Système d’imagerie intravasculaire 
Guide d’utilisation 

   
IFU0163rS.fr (2025-06-27)  18-37 

Tableau 18-19 : Spécifications d’essai pour l’immunité des accès par l’enveloppe aux appareils de communication sans fil 
RF 

 

Spécifications d’essai pour l’immunité des accès par l’enveloppe aux appareils 
de communication sans fil RF 

Fréquence du 
test 

Bandea) Servicea) Modulationb) 
Puissance 
maximale 

Distance 
Niveau du test 

d’immunité 
(MHz)    (W) (m) (V/m) 

385 380-390 TETRA 400 
Modulation par 

pulsationsb) 

18 MHz 
1,8 0,3 27 

450 430-470 
GMRS 460, FRS 

460 

FMc) 

± 5 kHz déviation 
1 kHz sinus 

2 0,3 28 

710 

704-787 LTE Band 13, 17 
Modulation par 

pulsationsb) 

217 MHz 
0,2 0,3 9 745 

780 

810 

800-960 

GSM 800/900. 
TETRA 800, IDEN 
820, CDMA 850, 

LTE Band 5 

Modulation par 
pulsationsb) 

18 MHz 
2 0,3 28 

870 

930 

1720 

1700-
1990 

GSM 1800; CDMA 
1900; GSM 1900; 
DECT; LTE Band 
1, 3, 4, 25; UMTS 

Modulation par 
pulsationsb) 

217 MHz 
2 0,3 28 

1845 

1970 

2450 
2400-
2570 

Bluetooth, WLAN, 
802,11 b/g/n, 

RFID 2450, LTE 
Band 7 

Modulation par 
pulsationsb) 

217 MHz 
2 0,3 28 

5240 
5100-
5800 

WLAN, 802,11 a/n 
Modulation par 

pulsationsb) 

217 MHz 
0.2 0,3 9 5500 

5785 

REMARQUE : Si cela s’avère nécessaire pour atteindre le niveau d’essai pour l’immunité, la distance 
entre l’antenne de transmission et l’équipement EM ou le système EM peut être réduit à 1 m. La distance 
d’essai de 1 m est autorisée par la norme CEI 61000-4-3. 

a) Pour certains services, seules les fréquences montantes sont incluses. 
b) L’onde porteuse doit être modulée à l’aide d’un signal carré à rapport cyclique de 50 %. 
c) À la place de la modulation FM, une modulation par pulsations de 50 % à 18 Hz peut être utilisée car 

s’il ne s’agit pas réellement de modulation, il s’agirait du pire des cas. 
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18.9 Annexe I : Résumé de l’évaluation des performances des 

algorithmes ABC et de détection du cathéter guide (GCD)  

 
Les tableaux suivants présentent l’évaluation des performances des algorithmes ABC 
et GCD sur des données de test en aveugle. 
 
Les critères d’acceptation de l’ABC ont été établis sur la base d’un protocole et d’un 
rapport approuvés, ayant permis de réaliser une étude de variabilité inter- et intra-
lecteurs avec trois lecteurs experts, 30 échantillons et deux essais. Cette étude a 
fourni une référence pour la variabilité attendue dans le contour manuel, garantissant 
que les performances de l’algorithme sont conformes aux normes de la pratique 
clinique. 
 
Les performances ont été évaluées à l’aide de mesures d’erreur, notamment la 
différence de diamètre, la différence de surface et la distance de Hausdorff (HD) pour 
les contours de la lumière et de l’EEM. Pour la détection du cathéter guide, les 
performances ont été évaluées en fonction de la précision de détection, de la 
sensibilité et de la spécificité. 

 
Tableau 18-20 : Résultats de performance de l’ABC 

 
Résultats de l’évaluation des performances de l’ABC sur les données de test 

  
Indicateur de 

performance  

  
Contour  

  
Critères 

d’acceptation 

Évaluation des 
performances 

de l’ABC sur les 
données de test 

  
Résultat  

Graphique de 
Bland-Altman – 
Limites d’accord 
pour la différence 
de diamètre (IC 95 

%) (mm) 

  
  

Lumière  

  
  

+/- 0,59  

  
  

[-0,37, 0,41]  

  
  

CONFORME 

Graphique de 
Bland-Altman – 
Limites d’accord 
pour la différence 
de diamètre (IC 95 

%) (mm) 

  
  

EEM  

  
  

+/- 0,74  

  
  

[-0,54, 0,52]  

  
  

CONFORME 

Graphique de 
Bland-Altman – 
Limites d’accord 
pour la différence 
de surface (IC 95 

%) (mm²) 

  
  

Lumière  

  
  

+/- 3,46  

  
  

[-2.3, 2,48]  

  
  

CONFORME 

Graphique de 
Bland-Altman – 
Limites d’accord 
pour la différence 
de surface (IC 95 

%) (mm²) 

  
  

EEM  

  
  

+/- 6,18  

  
  

[-4,5, 4,0]  

  
  

CONFORME 
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Distance de 
Hausdorff directe 
– IC 95 % (mm) 

  
Lumière  

  
< 0,63  

  
[0,27, 0,29]  

  
CONFORME 

Distance de 
Hausdorff directe 
– IC 95 % (mm) 

  
EEM  

  
< 0,66  

  
[0,31, 0,35]  

  
CONFORME 

Distance de 
Hausdorff inverse 
– IC 95 % (mm) 

  
Lumière  

  
< 0,63  

  
[0,26, 0,28]  

  
CONFORME 

Distance de 
Hausdorff inverse 
– IC 95 % (mm) 

  
EEM  

  
< 0,66  

  
[0,29, 0,32]  

  
CONFORME 

 
Tableau 18-21 : Résultats GCD au niveau de l’image (frame) 

Résultats GCD au niveau de l’image (frame)  

Indicateur Valeur  Critères d’acceptation Résultat  

AUC  0,98  0,9  CONFORME 

Sensibilité 0,86      

Spécificité 1,00      

 
Tableau 18-22 : Résultats GCD au niveau du scan 

Résultats GCD au niveau du scan 

Indicateur Valeur  Critères d’acceptation Résultat 

Total des échecs GCD 
au niveau individuel 

du scan* 

2      

Sensibilité 0,93  0,9  CONFORME 

Spécificité 0,93  0,9  CONFORME 

* Faux négatifs et faux positifs 
 
Ces résultats démontrent que le dispositif testé fonctionne dans des limites 
cliniquement acceptables, telles que déterminées par la variabilité inter-lecteurs dans le 
contour manuel et les seuils d’acceptation prédéfinis. 
 
Pour évaluer la précision au niveau du scan, les vrais positifs correspondent aux 
résultats où un cathéter guide (GC) a été correctement prédit dans une marge de 
+/- 2 mm par rapport à l’emplacement réel. Les vrais négatifs sont les cas où aucun GC 
n’a été prédit alors qu’aucun GC n’était présent selon la vérité terrain. Les faux positifs 
désignent les scans pour lesquels la localisation prédite du GC se situe en dehors de la 
fenêtre +/- 2 mm autour de l’emplacement réel, ou lorsque aucun GC n’était présent 
selon la vérité terrain. Les faux négatifs correspondent aux scans où aucune 
localisation de GC n’a été prédite alors que la vérité terrain indiquait la présence d’un 
GC. Les scans contenant moins de 2 mm de longueur totale de GC sont considérés 
comme négatifs selon la vérité terrain. 
 
Le tableau suivant présente une répartition détaillée de l’ensemble de données de test, 
y compris le nombre de patients uniques, d’images et de scans. L’ensemble de 
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données de test comprend 18 patients uniques, ce qui garantit que l’algorithme est 
évalué sur un ensemble de données indépendant, sans chevauchement avec 
l’ensemble de données d’étalonnage. Parmi les 18 patients, 29 scans au total ont été 
utilisés pour les tests, dont 12 provenant d’hôpitaux japonais (5 patients répartis sur 3 
sites) et 17 provenant d’hôpitaux américains (13 patients répartis sur 3 sites). Au niveau 
des images, 381 images provenant d’hôpitaux japonais et 609 images provenant 
d’hôpitaux américains ont été incluses. 
 
Afin de garantir que l’ensemble de données de test couvre des états pathologiques 
cliniquement pertinents, les patients sont caractérisés selon la présence de calcium et 
de struts de stent, deux indicateurs clés de la gravité de la maladie. La présence de 
calcium impacte la précision du contour de l’EEM en raison d’artefacts d’ombrage, 
tandis que la présence de struts de stent engendre des défis supplémentaires pour la 
segmentation. L’ensemble de données de test inclut également des cas de patients 
avec fil-guide et branches latérales, assurant ainsi une meilleure représentation des 
complexités rencontrées en imagerie réelle. 
 
Tableau 18-23 : Résumé et caractéristiques des données de test  

Résumé et caractéristiques des données de test 

Groupe 
de 
données 

Images 
(Frames)  

Patients  Scans  % de 
présence 
de 
calcium* 

% de 
présence 
de fil-
guide* 

% de 
présence de 

branche 
latérale* 

% de 
présence 
de struts 
de stent* 

Test  981  18  29  38,9 %  96,6 %  9,2 %  20,7 %  

*Ces pourcentages correspondent au % d’images (frames). 

 
Les paramètres d'acquisition fixes du système d'imagerie intravasculaire Makoto™ 
sont intrinsèques au transducteur IVUS Dualpro/Clarispro 014 et au système 
d'imagerie TVC-M10/MC10i, et ne peuvent pas être modifiés par l'utilisateur.  

• Profondeur de pénétration : le système offre une profondeur de 
pénétration d'environ 8 mm, correspondant à un champ de vision 
maximal de 16 mm. Cette profondeur est préréglée afin de garantir une 
visualisation optimale des structures vasculaires. Il convient de noter que 
la profondeur de pénétration est inversement proportionnelle à la 
fréquence ultrasonore.  

• Focalisation : les caractéristiques de focalisation du faisceau ultrasonore 
sont déterminées par les propriétés intrinsèques du transducteur. Les 
paramètres clés sont les suivants :  

o Longueur focale : distance entre le transducteur et le point 
où le faisceau ultrasonore est le plus étroitement focalisé, ce qui 
optimise la résolution latérale. La longueur focale est influencée 
par le diamètre du transducteur et la fréquence ultrasonore.  
o Diamètre du point focal : largeur du faisceau à son point le 
plus étroit. Plus le diamètre du transducteur est grand et plus la 
fréquence est élevée, plus le diamètre du point focal est réduit.  

• Fréquence : le transducteur fonctionne à une fréquence nominale de 50 
MHz, avec une plage de variation comprise entre 48 MHz et 53 MHz. 
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• Mode de fonctionnement : le système d'imagerie Makoto (TVC-
MC10/MC10i) fonctionne en mode B, présentant les images dans un 
système de coordonnées cartésiennes avec un nombre fixe de pixels le 
long des axes X et Y. Ces paramètres sont préconfigurés et ne peuvent 
pas être modifiés par l'utilisateur.  

La norme de référence pour l’ensemble de données de test a été établie à l’aide de 
six experts IVUS qui ont servi d’annotateurs de référence. Le processus d’annotation 
a été normalisé grâce à l’utilisation des directives de traçage IVUS et d’un logiciel 
propriétaire développé en interne, garantissant cohérence et reproductibilité. Les 
annotateurs ont suivi des instructions spécifiques pour l’identification des contours et 
des structures, notamment :  

• Régions du cathéter guide et du stent : identification des structures 
pertinentes. 
• Marquage du fil-guide : placement des points de marquage au point le 
plus lumineux ou à la position la plus proche du fil-guide.  
• Contours de la lumière et de l’EEM : points de marquage utilisés pour 
délimiter les contours de la lumière et de l’EEM. 
• Arcs calciques : placement des marques sur le bord luminal de chaque 
structure calcifiée.  
• Struts du stent : marquage du centre de chaque strut identifiable du stent. 

  
  
L'ensemble de données de test a été annoté par six lecteurs experts, dont deux n'ont 
pas participé à l'annotation de l'ensemble de données d'étalonnage. Bien que quatre 
annotateurs aient travaillé à la fois sur l'ensemble de données d'étalonnage et sur 
l'ensemble de données de test, l'impact de ce chevauchement a été atténué grâce à 
une allocation aléatoire des sites et à la diversité des styles d'annotation, afin de 
garantir que le modèle n'apprenne pas les tendances spécifiques des annotateurs. 
  
Les différences entre le processus de vérification des ensembles de données 
d’étalonnage et de test ont été conçues pour réduire les biais potentiels et garantir 
une évaluation indépendante des performances. Bien que certains annotateurs et 
sites se recoupent, il n’y a pas eu de chevauchement entre les patients, et la 
diversité des lecteurs a permis de varier les styles d’annotation, empêchant ainsi le 
modèle de s’adapter de manière excessive à une seule méthodologie d’annotation. 

  
Several steps were taken to ensure that the test dataset remained independent from 
the training dataset, preventing data leakage and enabling an unbiased evaluation of 
model performance.  

  
Tout d’abord, il n’y avait aucun chevauchement entre les patients des ensembles de 
données d’étalonnage et de test, garantissant que le modèle était évalué sur des cas 
de patients jamais vus auparavant. Cela a empêché l’algorithme de mémoriser des 
caractéristiques anatomiques ou des schémas d’imagerie spécifiques aux patients 
d’entraînement, renforçant ainsi sa capacité de généralisation.  
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Deuxièmement, l’ensemble de données de test a été collecté auprès de 6 sites 
cliniques. Si trois de ces sites de test coïncidaient avec des sites d’étalonnage, la 
moitié des sites de test étaient entièrement nouveaux, assurant que le modèle 
rencontre des conditions d’imagerie inédites lors de l’entraînement. Cette approche a 
contribué à valider la capacité du modèle à généraliser dans divers environnements 
d’imagerie.  

  
Troisièmement, un groupe diversifié d’annotateurs a été utilisé dans les ensembles 
de données d’étalonnage et de test afin d’introduire une variabilité dans les 
comportements d’annotation. L’ensemble de données de test a été annoté par six 
lecteurs, dont deux n’avaient pas participé à l’ensemble de données d’étalonnage. 
Cette diversité a permis de s’assurer que le modèle ne soit pas exposé à un seul 
style d’annotation, favorisant ainsi sa capacité à généraliser face aux différents 
comportements d’annotation couramment observés en pratique clinique.  

  
De plus, les annotateurs se sont vu attribuer aléatoirement des données provenant 
de différents sites, ce qui a permis d’éviter les biais systématiques liés aux 
tendances d’annotation propres à chaque site. L’inclusion de plusieurs annotateurs 
aux styles d’annotation variés a en outre garanti que le processus de validation 
(« truthing ») de l’ensemble de données de test reste indépendant du 
développement du modèle, empêchant ainsi que des biais d’annotation n’influencent 
les résultats des tests.  

  
Enfin, l’ensemble de données de test était en aveugle (« blinded »), ce qui signifie 
que les développeurs de l’algorithme n’avaient eu aucun accès aux cas patients de 
test durant l’entraînement ou les phases d’ajustement (et que les annotateurs 
n’avaient eu aucun accès à l’algorithme). Cela a permis de garantir que l’évaluation 
du modèle reflète les performances cliniques réelles, plutôt que des biais appris lors 
d’expositions antérieures. L’ensemble de ces mesures a permis de s’assurer que 
l’ensemble de données de test fournit une évaluation indépendante et impartiale des 
performances du modèle, conformément aux exigences réglementaires relatives à 
l’équivalence substantielle. 
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